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1.1. Görsel Efekt Program Kurulumu 

Görsel efekt programları; grafik, efekt, animasyon ve video oluşturma gibi birçok amaçla 
kullanılmaktadır. Kullanılacak görsel efekt programının seçiminde programın kolaylığı, öncelik olarak 
belirlenebilir. 

Bu programlar 3D ve 4D programlarla da uyumlu olarak çalışır. Pluginlerle [plagin (eklenti)] 
birlikte tasarım seçeneklerinde çeşitlilik sağlanır.  

Tercih edilen görsel efekt yazılımının deneme sürümü veya tam sürümü kullanılabilir. Programı 
kurarken, yazılı kurulum anlatımlarından yararlanılmalıdır. Kurulacak programın amacının yanında; 
kullanılan bilgisayarın, programın sistem gereksinimlerini karşılayıp karşılamadığına da dikkat edilmelidir. 

Kullanılacak görsel efekt programı indirildiğinde masaüstünde klasöre çıkarma işlemi yapılır. 
Dosyanın içindeki setup [setap (kurulum)] dosyası ile program, deneme sürümü veya tam sürüm olarak 
kurulabilir. Güncelleme klasöründe bulunan setup dosyası çalıştırılır. Güncellenmenin yüklenmesi 
beklenir. 

Güncelleme yüklendiğinde klasöre gidilerek program çalıştırılabilir.Program karşılama ekranıyla 
başlar (Görsel 1.1). 

 

 

 

ÖĞRENME BİRİMİ 
GÖRSEL EFEKT YAZILIMINDA TEMEL 

DÜZENLEMELER 
BİLGİ YAPRAĞI 

KONU 1. PROGRAM KURULUMU 

Görsel 1.1: Program karşılama ekranı 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 Ücretli veya ücretsiz, farklı özelliklere sahip birçok görsel efekt programı bulunmaktadır. 
Bu programlardan bir tanesini lisans ve telif haklarına dikkat ederek temin ediniz. 

 

İşlem Basamakları 

1. İndirilen görsel efekt programını masaüstü klasörüne çıkarınız. 

2. Klasördeki “setup” dosyası ile deneme sürümü veya tam sürüm kurulumunu yapınız. 

3. Gerekli üyelik işlemlerini yapınız. 

4. Kurulum bitikten sonra masaüstünde beliren kısayolu siliniz. 

5. Güncelleme klasöründe bulunan “setup” dosyasını çalıştırınız. 

6. Güncellemenin yüklenmesini bekleyiniz. 

7. Program klasörüne giderek programın kısayolunu çalıştırınız. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

İndirilen görsel efekt programı, masaüstü klasörüne çıkarıldı.   

Klasördeki setup dosyası ile deneme veya tam sürüm kurulumu 
yapıldı. 

  

Kurulum bittikten sonra masaüstünde beliren kısayol silindi.   

Güncelleme klasöründe bulunan setup dosyası çalıştırıldı.   

Program klasörüne gidilerek program kısayolu çalıştırıldı.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ÖĞRENME BİRİMİ 
GÖRSEL EFEKT YAZILIMINDA TEMEL  

DÜZENLEMELER UYGULAMA 
YAPRAĞI 1 

KONU PROGRAM KURULUMU 
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ÖĞRENME BİRİMİ 
GÖRSEL EFEKT YAZILIMINDA TEMEL  

DÜZENLEMELER 
BİLGİ YAPRAĞI 

KONU 2. ÇALIŞMA SAHNESİ AYARLARI 

2.1. Görsel Efekt Programında Açılış Ayarları 

Görsel efekt programında açılış ayarları, programın yapılacak işleme uygun olmasını sağlar. 

2.1.1. Çalışma Sahnesi 

Görsel efekt programı kurulup ilk açıldığında klasik bir arayüzle [interface (intırfeys)] karşılaşılır. 
Arayüz üzerinde açılan New Composition [niuv kompızişın (yeni kompozisyon)] seçeneği, yeni bir proje 
oluşturmak için kullanılan pratik bir seçenektir. 

 

 

Programın arayüzünde menüler, paneller ve araçlar yer almaktadır (Görsel 2.1). Kullanılmak 
istenen komutlara arayüz üzerinden ulaşılabileceği gibi komutların kısayollarının kullanımı da tercih 
edilebilir.  

Çalışma Sahnesi’nin üst menü bileşenleri; File [fayl (dosya)], Edit (düzenleme), Composition 
[kompızişın (kompozisyon)], Layer [leyır (katman)], Effect, Animation (enimeyşın), View [viyuv 
(görünüm)], Window, Help olarak sıralanmaktadır.  

Görsel efekt programları kullanılırken gözlerin yorulmaması için arayüzde genellikle siyah ve 
yakın tonlar tercih edilir.  Program arayüz ekranının parlaklığı, Edit > Preferences [prifırınsıs (tercihler)] > 
Appearance [ıpîrıns (görünüm)] yolu izlenerek açılan pencereden düzenlenebilir. 

File üst menüsünden New seçeneğiyle yeni bir proje oluşturabildiği gibi Open Project [opın 
procekt (proje aç)] seçeneğiyle; var olan projelere de yeniden dönülebilir (Görsel 2.2). 

 

 

 

Görsel 2.1: Program arayüzü 
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2.1.2. Paneller 

Program kurulduğunda açılan Standard adı altındaki klasik arayüzde Project (proje), 
Composition, Effects & Presets (efektler ve ön ayarlar), Preview (ön izleme), Layer/Timeline 
(katman/zaman çizelgesi) ve Info (bilgi) panelleri yer almaktadır (Görsel 2.3). 

 

 

Seçilen panelin etrafında oluşan mavi çerçeve, panelin aktif olduğunu gösterir. Panelin adının 
yazılı olduğu yerden “imleç aracıyla tutup sürükleyerek taşıma” yoluyla panelin yeri değiştirilebilir. İmleci 
panel çerçevesine yaklaştırdığımızda imlecin şeklinin Ok işaretine dönüşmesiyle, sürükle-bırak yöntemi 
kullanılarak panel çerçevesinin boyutları yeniden ayarlanabilir. Panel üzerindeki X işareti tıklanarak veya 
Close Panel [kloz penıl (paneli kapat)] seçeneğiyle paneli kapatma işlemi gerçekleştirilebilir. 

 

Görsel 2.2: Dosya penceresi  

Görsel 2.3: Klasik arayüzde paneller 
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Çalışma sırasında kaybedilen veya eklenmek istenen panellere Window üst menüsünden 
ulaşılabilir. 

 Project Paneli: Dosya çağırma, seçme işlemleri bu panelden yapılır. Panel genişletilerek 
dosyanın özellikleri görüntülenebilir (Görsel 2.4). 

 

 

 Composition Paneli: Arayüzün ortasında bulunan ve görsellerin izlendiği Sahne veya 
sayfadır. 

 Info Paneli: Yapılan çalışmanın bilgileri görünür. 

 Preview Paneli: Çalışmanın herhangi bir aşamasındayken ön izleme yapılarak çalışmanın 
son hâlinin görüntülenmesi sağlanır.  

 Effects & Presets Paneli: Genel standart efektlerle birlikte sonradan eklenen efektler 
bulunur. 

 Layer/Timeline Paneli: Tek bir panel içinde yer alan iki farklı panelden; layer ve timeline 
panellerinden oluşur.  

 

 

Panellerin yerleri değiştirildikten sonra düzeltme veya geriye dönüş yapılmak istenirse Standard 
> Reset to Saved Layout [riset tu seyvıd leyaut (kaydedilmiş düzene sıfırla)] seçeneği, başlangıç panel 
yerleşimine dönmenin hızlı bir yoludur (Görsel 2.5).  

Klasik arayüz; Effects, Minimal, Paint [peynt (boyama)], Text [tekst (yazı)], Motion Tracking 
[movşın treking (hareket izleme)] gibi hazır çalışma alanı seçenekleriyle değiştirilebilir. Bu hazır çalışma 
alanlarına Window > Workspace [vörk speys (çalışma alanı)] > Edit Workspace sekmesinden de 
ulaşılabilir. 

 All Panels: Tüm paneller bir arada yer alır. Bu çalışma alanı tercih edildiğinde; gereksiz 
görülen paneller, Close Panel seçeneğiyle veya X işaretine tıklanarak kapatılır. 

 Animation: Bu panel seçildiğinde, animasyon çalışması yapmak için gerekli olan paneller 
aktif hâle gelir. Bu çalışma alanının altında Effects & Presets, Info, Preview, Wiggler 
(viglır) ve Motion Sketch [movşın skeç (hareket çizimi)] panelleri bulunur. 

 Effects: Efekt kullanımı için sadeleştirilmiş; Preview ve Effects panellerini içeren bir 
çalışma alanıdır.  

 Minimal: Bu çalışma alanında tasarım için sadece Composition ve Timeline panelleri 
bulunmaktadır.  

Görsel 2.4: Project panelinin genişletilmesi 

Görsel 2.5: Standard penceresi  
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 Motion Tracker: Hareket algılamayla ilgili paneldir. 

 Paint: Çizim, boyama gibi işlemlerin yapıldığı, Brushes [braşıs (fırçalar)] ve Paint 
panellerinin aktif olduğu çalışma alanıdır. 

 Text: Yazı ayarlamalarının efektlerle birlikte öncelik aldığı bir çalışma alanıdır.  

2.1.3. Çalışma Alanını Kişiselleştirme 

Window > Workspace > Save as New Workspace komutu aracılığıyla yeni bir çalışma alanı 
oluşturulabilir. Bu çalışma alanında paneller, kullanım amacına uygun olarak düzenlenebilir (Görsel 2.6). 

 

 

Save Changes to This Workspace [seyv çencıs to dis vörkspeys (değişiklikleri bu çalışma alanına 
kaydet)] seçeneği kullanılarak, hazırlanmış ve kaydedilmiş bir çalışma alanı üzerinde panel değiştirme 
yapılabilir. 

2.1.4. Klavye Kısayolları 

Görsel efekt programında çalışmaların daha hızlı ve kolay sürdürülebilmesi için “klavyede yer 
alan tuşların kısayolları” kullanılabilir. 

Edit > Keyboard Shortcuts seçeneğiyle klavye kısayolları ekranına ulaşılır (Görsel 2.7). 

 

 

Kısayolların toplu olarak görüntülendiği klavye üzerinde Command (komend) ve Shortcut 
(şortkat) başlıkları altında komutlar ve kısayollar listelenmektedir. 

Var olan kısayollar, Ctrl ve Alt gibi farklı tuşlar kullanılarak da görüntülenebilir. 

Adına tıklandığında aktifleşen kısayol üzerinde değişiklik yapılarak Save As [seyv ez (farklı 
kaydet)] komutuyla “farklı ad vererek kısayolu kaydetme” işlemi gerçekleştirilir. 

 

Görsel 2.6: Panellerde kişiselleştirme 

Görsel 2.7: Klavye kısayolları  
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 

İşlem Basamakları 

1. Program arayüzündeki panelleri aktifleştiriniz. 

2. Panelleri, imleci kullanarak çerçeve kenarından yeniden boyutlandırınız. 

3. Panellerin yerlerini imleç aracılığıyla taşıyarak değiştiriniz. 

4. Window üst menüsünden farklı paneller açınız. 

5. Standard > Reset to Saved Layout sekmesiyle klasik arayüze dönünüz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Program arayüzündeki paneller aktifleştirildi.   

Paneller, imleç kullanılarak çerçeve kenarından yeniden 
boyutlandırıldı. 

  

Panellerin yerleri, imleç aracılığıyla taşınarak değiştirildi.   

Window üst menüsünden farklı paneller açıldı.   

Standard > Reset to Saved Layout sekmesiyle klasik arayüze 
dönüldü. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ÖĞRENME BİRİMİ 
GÖRSEL EFEKT YAZILIMINDA TEMEL 

DÜZENLEMELER UYGULAMA 
YAPRAĞI 1 

KONU ÇALIŞMA ALANINI DÜZENLEME 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 

İşlem Basamakları 

1. Standard > Edit Workspace (çalışma alanını düzenle) sekmesinden hazır çalışma 
alanlarına ulaşınız. 

2. Window üst menüsünden eklemek istediğiniz panelleri seçiniz. 

3. Save as New Workspace (yeni çalışma alanı olarak kaydet) seçeneğiyle, yeni 
oluşturduğunuz panele isim veriniz.  

4. Yeni verilen ismi OK düğmesine tıklayarak kaydediniz. 

5. Kaydettiğiniz panelde, Save Changes to this Workspace seçeneğini kullanarak değişiklik 
yapınız. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Standard > Edit Workspace sekmesinden hazır çalışma 
alanlarına ulaşıldı. 

  

Window üst menüsünden eklenmek istenen paneller seçildi.   

Save as New Workspace seçeneğinden yeni oluşturulan panele 
isim verildi. 

  

Yeni verilen isim OK düğmesine tıklanarak kaydedildi.   

Kaydedilen panelde Save Changes to this Workspace seçeneği 
kullanılarak değişiklik yapıldı. 
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KONU ÇALIŞMA ALANINI KİŞİSELLEŞTİRME 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 

İşlem Basamakları 

1. Edit > Keyboard Shortcuts seçeneğiyle, kısayolların görüntülendiği klavyeye ulaşınız. 

2. Cut (Ctrl+X) ve Copy (Ctrl+C) kısayollarını kişisel tercihinize göre değiştiriniz. 

3. Hand (H) ve Zoom (Z) kısayolları üzerine farklı atamalar yapınız. 

4. Değiştirilen kısayolları, var olan kısayollarla karşılaştırınız. 

5. Save As seçeneğiyle kaydetme işlemini gerçekleştiriniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Edit > Keyboard Shortcuts seçeneğiyle, kısayolların 
görüntülendiği klavyeye ulaşıldı. 

  

Cut (Ctrl+X) ve Copy (Ctrl+C) kısayolları, kişisel tercihe göre 
değiştirildi. 

  

Hand (H) ve Zoom (Z) kısayolları üzerine farklı atamalar yapıldı.   

Değiştirilen kısayollar, var olan kısayollarla karşılaştırıldı.   

Kaydetme işlemi gerçekleştirildi.   
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ÖĞRENME BİRİMİ 
GÖRSEL EFEKT YAZILIMINDA TEMEL  

DÜZENLEMELER 
BİLGİ YAPRAĞI 

KONU 3. MATERYAL EKLEME 

3.1. Materyal Ekleme 

Görsel efekt programına materyal eklerken yapılan işlemler kullanılacak materyallerin 
özelliklerine göre değişmektedir. 

3.1.1. Dosya Aktarma (Import) 

Görsel efekt programında kullanılacak materyallerin öncelikle Project paneline aktarılması 
gerekir. Materyallerin dosya adı (name), materyalin tipi (type), boyutu (size) ve kare sayısı (frame rate) 
gibi özellikleri, bu panelde görüntülenmektedir. 

Project panelinin üst kısmındaki pencerede, aktarılan dosyaların ön izlemesi yapılabilir. Panelin 
alt kısımdaki bölümü ise arama kutusu olarak kullanılmaktadır. 

Dosyaları Project paneline aktarma işlemi için import seçeneği kullanılır. Programa video, resim 
ve ses dosyalarının çağrılması işlemi, birden fazla yöntemle gerçekleştirilebilir. Kişi, bu yöntemlerden 
kendisine göre pratik olanı tercih etmelidir. 

İlk olarak üst menüden File > Import > File yöntemiyle dosya çağrılabilir (Görsel 3.1). Kısayol 
olarak Ctrl+I kullanılır. 

 

 

Materyaller çağrılırken Footage veya Composition şeklinde seçilebilir. Footage seçeneği 
katmanlı dosyaların katmanlarını birleştirerek programa aktarır. Videoları aktarmada kullanılır. 
Composition seçeneği ise çoklu katmanlı dosyayı katmanlarıyla birlikte programa aktarır. 

Dosya aktarma için bir başka yöntem de Project paneline sağ tıklandığında açılan pencereden 
import seçeneğinin kullanılmasıdır. 

Görsel 3.1: Dosya aktarma penceresi 
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Project paneli üzerinde farenin sol tuşuna çift tıklama ve sürükle-bırak gibi yöntemler de dosya 
aktarmak için kullanılabilir. Aktarma işleminin tamamlanması için dokümanların dosya uzantıları, 
programın desteklediği formatlarla uyumlu olmalıdır. 

Import Recent Footage seçeneğiyle, programa en son eklenen dosya görüntülenmektedir. 

3.1.2. Toplu Doküman Aktarma 

Import > Multiple Files… (toplu doküman aktarma) (Ctrl+Alt+I) seçeneğiyle, dosya aktarma 
penceresi açılır. Programda dosya seçim işleminden sonra açılan pencerede, Import seçeneğiyle dosya 
eklenmesinin devamlılığı sağlanır. Done seçeneği kullanılarak dosya seçme işlemi bitirilir.  

Project paneline klasör içindeki dosyaların tümü aktarılmak istenirse Import Folder düğmesi 
kullanılmalıdır (Görsel 3.2). 

 

3.1.3. Klasör (Bin) Düzenleme 

Görsel efekt programlarıyla çalışılırken “klasör düzenleme” mantığına dikkat edilmesi gerekir. 
Yapılan çalışmalarda dosyalar, çalışmanın en başından itibaren düzenli bir şekilde tutulmalıdır. 
Çalışmaların daha sağlıklı ilerlemesi ve dosya karışıklıklarının engellenmesi için bu konuya dikkat 
edilmelidir. 

File > New Folder seçeneğiyle yeni bir klasör oluşturulabileceği gibi Project panelinin altında yer 
alan Create a new Folder şekli seçilerek de klasör oluşturulabilir. Project panelinde, farenin sağ 
düğmesiyle boşluğa tıklandığında açılan pencereden seçilen New Folder seçeneği ise yeni bir klasör 
oluşturmanın başka bir yöntemidir.  

Proje paneline aktarılan dosyalar üzerinde farenin sol tuşu basılı tutulup imleç sürüklenerek 
birden fazla dosya seçimi yapılabilir. Panel içinde farklı yerlerde yer alan dosyaları seçmek için ise imleç 
ile birlikte Ctrl tuşu kullanılmalıdır. Shift tuşu yardımıyla panelde başlangıç ve bitiş klasörleri seçilirse ara 
klasörler otomatik olarak seçilir. 

Proje panelinde seçili olan bir klasör varken yeni klasör oluşturulursa yeni oluşturulan klasör, bir 
önceki adımda seçili olan klasörün içinde “alt klasör” olarak yer alır. Klasörler düzenlenirken kişinin kendi 
kullanım alışkanlıklarına uygun bir düzenleme yapması, çalışmayı daha sistemli bir hâle getirir. 

Project paneline aktarılan dosyanın üzerine imleç aracıyla iki kere tıklanırsa dosya Footage 
panelinde görüntülenir. 

 

Görsel 3.2: Dosya aktarma 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Çalışmada kullanılacak video dosyalarını telif haklarına dikkat ederek temin ediniz. 

 Programın desteklemediği uzantılar için videoyu uygun formata dönüştürünüz. 

 

İşlem Basamakları 

1. Video dosyasını, Import > File seçeneğiyle açılan pencereden import ediniz. 

2. Video dosyasını footage olarak aktarmayı seçiniz. 

3. Import düğmesine basınız. 

4. Project paneline aktarılan dosyanın özelliklerini inceleyiniz. 

5. Project panelinde yer alan dosyaya imleç aracıyla iki kez tıklayarak Footage panelinde 
açınız. 

6. Preview paneli aracılığıyla videonun ön izlemesini yapınız. 

7. Dosya aktarmanın farklı yöntemlerini uygulanarak işlemi tekrarlayınız. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

File > Import > File seçeneğinden projede kullanılacak video 
seçildi. 

  

Aktarma seçeneklerinden footage seçildi.   

Aktarılan dosyanın Project panelinde özellikleri incelendi.   

Project panelinde yer alan dosyaya imleç aracıyla iki kez 
tıklanarak Footage panelinde açıldı. 

  

Preview paneli aracılığıyla videonun ön izlemesi yapıldı.   
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Çalışmada kullanacağınız resim, video ve ses dosyalarını telif haklarına dikkat ederek 
temin ediniz. 

 Programın desteklemediği uzantılar için materyalleri uygun formata dönüştürünüz. 

 

İşlem Basamakları 

1. Import > Multiple Files seçeneğiyle açılan pencereden video dosyasını seçiniz. 

2. Video dosyasını footage olarak aktarmayı seçiniz. 

3. Import düğmesine basınız. 

4. Dosya aktarma işlemi gerçekleştikten sonra toplu dosya çağırma penceresini yeniden 
açarak resim dosyasını seçiniz. 

5. Seçtiğiniz resim dosyasını composition olarak import ediniz. 

6. Yeniden açılan toplu dosya çağırma panelinden ses dosyasını seçiniz. 

7. Seçilen ses dosyasını footage olarak import ediniz. 

8. Done seçeneğine basarak toplu dosya çağırma işlemini sonlandırınız. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Import > Multiple Files seçeneğiyle açılan pencereden video 
dosyası seçildi. 

  

Video dosyasını footage olarak aktarma seçildi.   

Import edildi.   

Dosya aktarma işlemi gerçekleştikten sonra toplu dosya 
çağırma penceresi yeniden açılarak resim dosyası seçildi. 

  

Seçilen resim dosyası, composition olarak import edildi.   

Yeniden açılan toplu dosya çağırma panelinden ses dosyası 
seçildi. 

  

Seçilen ses dosyası, footage olarak import edildi.   

Done seçeneğine basılarak toplu dosya çağırma işlemi 
sonlandırıldı. 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Çalışmada kullanacağınız resim, video, ses ve çoklu katmanlı içerik taşıyan dosyaları telif 
haklarına dikkat ederek temin ediniz.  

 Programın desteklemediği uzantılar için materyalleri uygun formata dönüştürünüz. 

 

İşlem Basamakları 

1. Ctrl+I kısayoluyla dosya aktarma penceresine ulaşınız. 

2. Programa aktarılacak klasörü seçerek sırasıyla Import/Import Folder düğmelerine 
tıklayınız. 

3. Import Folder düğmeleriyle aktarılan klasör içindeki dosyaları belirlenen başlıklarla alt 
klasörlerde düzenleyiniz. 

4. Katmanlı içerik taşıyan bir dosya seçiniz ve Composition/Editable Layer Styles 
seçeneğini işaretleyerek katmanlı olarak aktarınız. 

5. Proje paneline aktarılan klasördeki dosyaları, belirlenen başlıklarla ve kısayollar 
kullanarak farklı klasörler şeklinde düzenleyiniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Ctrl+I kısayoluyla dosya aktarma penceresine ulaşıldı.   

Programa aktarılacak klasör seçilerek Import/ Import Folder 
düğmelerine tıklandı. 

  

Import ve Import Folder düğmeleriyle aktarılan klasör içindeki 
dosyalar, belirlenen başlıklarla alt klasörlerde düzenlendi. 

  

Katmanlı içerik taşıyan bir dosya seçildi ve Editable Layer Styles 
seçeneği işaretlenerek katmanlı olarak aktarıldı. 

  

Proje paneline aktarılan klasördeki dosyalar, belirlenen 
başlıklarla ve kısayollar kullanılarak farklı klasörler şeklinde 
düzenlendi. 
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3.1.4. Kompozisyon Oluşturmak 

Görsel efekt programlarında proje üzerinde çalışabilmek için bir sayfa ya da Sahne oluşturur gibi 
bir kompozisyon oluşturulmalıdır. Açılan arayüz üzerindeki New Composition seçeneği, yeni bir 
kompozisyon oluşturmak için kullanılabilir (Görsel 3.3). New Composition seçeneğiyle Composition 
Settings ayarlarına girilerek, belirlenen özelliklerle yeni bir kompozisyon oluşturulur. Arayüz üzerinde bir 
diğer seçenek olan New Composition From Footage seçilerek, belirlenen özelliklere veya kullanılacak 
materyalin özelliklerine göre bir kompozisyon oluşturulur. Bu işlemler, program açıldığında pratik 
yöntemlerdir. 

 

 

Yeni kompozisyon oluşturmak için diğer yöntemlere; üst menüde Composition > New 
Composition (Crtl+N) seçeneğiyle veya Project panelinin boş bir yerine farenin sağ tuşuyla tıklandığında 
açılan pencerede New Composition seçeneğiyle ulaşılabilir.  Project paneli üzerindeki Create a New 
Composition seçeneği üzerinden Composition Settings’e (kompozisyon ayarları) ulaşmak, yeni bir 
kompozisyon oluşturmak için pratik bir yoldur (Görsel 3.4). 

 

3.1.5. Kompozisyonun Özellikleri 

Yeni bir kompozisyon oluşturulurken özellik ayarları, Composition Settings penceresinden 
gerçekleştirilir. Çalışmanın sonunda alınmak istenen render’ın özelliklerine uygun bir kompozisyonda 
çalışılması, hız açısından daha geçerlidir. Materyallerin aktarma işlemi gerçekleştirildikten sonra; Proje 
paneli üzerinde seçili olan dosyanın Composition > Composition Settings bölümüne gelinerek 
materyalin kompozisyon özellikleri, çalışmanın render amacına bağlı olarak düzenlenebilir (Görsel 3.5). 

Görsel 3.4: Yeni kompozisyon oluşturma 

Görsel 3.5: Kompozisyon ayarları 

Görsel 3.3: Arayüzü kullanarak kompozisyon oluşturma 
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Açılan Composition Settings penceresinde Preset (ön ayar) seçeneği, hazır kompozisyon uzantı 
ayarlarıdır. Çalışmaya uygun, hazır video formatları seçilebileceği gibi Custom seçeneğiyle, manuel 
kompozisyon değerleri de girilebilir. Lock Aspect Ratio… seçeneği işaretli ise çalışmanın Width (genişlik) 
ve Height (yükseklik) değerleri, aynı oranda değişir. 

Frame Rate (fps) seçeneği, bir saniyede geçen kare sayısını belirler. Verilen değere göre 
görüntünün akışkanlığı değişir. “25” değeri girildiğinde bir saniye boyunca 25 kare, “30” değeri 
girildiğinde ise bir saniye boyunca 30 kare, görüntüden geçecektir. İnsan gözü, 24 kareyi kusursuz 
akışkanlıkta algılamaktadır. İnternet yayıncılığında fps değeri, 25-30 kare arasında değişmektedir. Kare 
sayısı 30’un üzerinde olan değerler, çok tercih edilen değerler değildir. Kare sayısının çok olması, görüntü 
kalitesinin yüksek olması anlamına gelmez. Kare sayısının yüksek olması, dosya boyutunu da yükseltir ve 
bilgisayarda oluşacak yükü de artırır. Ayrıca görüntüde slow motion oluşur. Bu yüzden fps değeri, 
ihtiyaca göre belirlenmelidir. 

Resolution seçeneği, çözünürlük (en-boy oranına düşen piksel sayısı) belirlemek için kullanılır. 
Seçeneklerde full (tam), half (yarım), third (üçte bir) ve quarter (çeyrek ya da dörtte bir) çözünürlük 
değerleri bulunur. Custom seçildiğinde, çözünürlük değeri manuel olarak girilebilir. 

Start Timecode, zaman kodunu ifade eder ve başlangıç süresidir.  

Duration, çalışma için oluşturulacak kompozisyon süresinin belirlenmesini sağlar. Değerler; saat, 
dakika, saniye, kare (0;00;00;00) olarak girilir. Kompozisyon kare türünde oluşturulduysa Duration 
seçeneğine kare değeri de girilebilir. 

 Background Color, kompozisyonun arka plan rengidir. Transparan görüntülerde çalışmak için 
kullanılır. Render alındığında bu rengin bir geçerliliği yoktur. 

Oluşturulan kompozisyonun özellikleri belirlendikten sonra Composition Settings penceresinde 
OK düğmesine basılır. Kompozisyon ayarlarında tekrar düzeltme yapılmak istendiğinde bu pencereye 
yeniden gelinerek düzeltme yapılabilir. 

Materyal dosyası, kompozisyon paneline sürükle-bırak yöntemiyle atılır. Kompozisyon 
Sahnesi’nde görselleri seçme işlemi, Sahne üzerinde manuel olarak veya Katmanlar panelinden dosya 
seçimi yapılarak gerçekleştirilebilir. Composition paneli üzerindeki Magnification Ratio Popup 
[megnifikeyşın reyşiyo popap (büyütme oranı açılır penceresi)] seçeneğiyle görsel, farklı oranlarla 
görüntülenebilir. Bu görüntüleme, render işlemini etkilemez. 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 

İşlem Basamakları 

1. Composition > New Composition (Crtl+N) seçeneğiyle Composition Settings penceresini 
açınız. 

2. Projede kullanılmak istenen formatı, Preset seçeneğiyle belirleyiniz. 

3. Frame Rate seçeneğine projenin “saniyedeki kare sayısı” bilgisini giriniz. 

4. Resolution seçeneğiyle çözünürlük değerini belirleyiniz. 

5. Duration seçeneğiyle kompozisyonun süresini ayarlayınız. 

6. Background Color seçeneğiyle arka plan rengini seçiniz. 

7. OK düğmesine tıklayınız. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition (Crtl+N) seçeneğiyle 
Composition Settings penceresi açıldı. 

  

Projede kullanılmak istenen format, Preset seçeneğiyle 
belirlendi. 

  

Frame Rate seçeneğine, projenin “saniyedeki kare sayısı” bilgisi 
girildi. 

  

Resolution seçeneğiyle çözünürlük değeri belirlendi.   

Duration seçeneğiyle kompozisyonun süresi ayarlandı.   

Background Color seçeneğiyle arka plan rengi seçildi.   

OK düğmesine tıklandı.   

 

 

 

 

 

 

 

 

 

 

 

ÖĞRENME BİRİMİ 
GÖRSEL EFEKT YAZILIMINDA TEMEL  

DÜZENLEMELER UYGULAMA 
YAPRAĞI 4 

KONU KOMPOZİSYON OLUŞTURMA 
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3.2. Araç Çubuğu (Toolbar)  

Arayüzde üst menünün hemen altında yer alan Toolbar (araç çubuğu), görsel efekt programı 
üzerinde yapılan işlemleri hızlandırmak için kullanılmaktadır. 

 

 

 A) Selection Tool (V): Seçim ve taşıma işlemlerini gerçekleştiren araçtır. Kompozisyon 
monitöründe görseli büyütüp küçültmek için de kullanılmaktadır. Shift tuşuyla birlikte 
kullanıldığında, seçilen nesne üzerinde orantılı büyütüp küçültme yapılabilir. 

 B) Hand Tool (H): Kompozisyon panelinde konumlandırma için kullanılan araçtır. 
Selection Tool’dan farklı olarak görüntüde herhangi bir kayma olmadan monitörü taşıma 
işlemi yapar. Farenin tekerleği basılı tutularak aynı işlem gerçekleştirilebilir. 

 C) Zoom Tool (Z): Yakınlaştırma ve uzaklaştırma işlemlerini gerçekleştirir. Sadece 
kompozisyon alanında işe yarayan bir araçtır. Uzaklaştırma işlemi için alt tuşunu basılı 
tutmak gereklidir. Farenin tekerleğiyle de yakınlaştırma ve uzaklaştırma yapılabilir. 
İmleç, görselin üzerinde nereye tıklanırsa oraya yakınlaştırma ve uzaklaştırma yapılır. 

 D) Rotation Tool (W): Kompozisyon alanındaki görseli çevirme işlemi için kullanılır. 

 E) Camera Tool (C): Animasyon ve videoları üç boyutlu Sahne oluşturarak farklı açılardan 
gösteren kamera aracıdır. 

 F) Pan Behind (Anchor Point) Tool (Y): Merkez noktası belirlemeye yarar. Animasyonlar 
da belirlenen bu merkez noktadan hareketlendirilir. 

 G) Shape Tool (Q): Hazır şekil (dikdörtgen, elips, yıldız, kare vb.) çizme aracıdır. Ayrıca 
maskeleme işlemi de gerçekleştirilir. Görsel seçili olmazsa araç, şekil çizmede kullanılır. 

 H) Pen Tool (G): Yol çizme aracıdır. Şekil oluşturma veya maskeleme yapma amacıyla 
kullanılır. 

 I) Text Tool (Ctrl+T): Çalışmalarda yazının kullanılmasını sağlar. 

 J) Brush Tool (Ctrl+B): Fırça aracıdır. Görsel üzerinde boyama yapılmasını sağlar. 

 K) Clone Stamp Tool (Ctrl+B): Görsellerde klonlama, kopyalama ve doku taşıma 
görevlerini yapar. 

 L) Eraser Tool (Ctrl+B): Silgi aracıdır. 

 M) Roto Brush Tool (Alt+W): Sahne’de nesnenin arka plandan ayrılmasını, seçili 
bölgenin maskelenmesini sağlar. 

 N) Puppet Pin Tool (Ctrl+P): Kukla aracıdır. Pinler ile birlikte çizimlere hareket 
sağlayabilir. 

 

! Araçlar kullanıldıktan sonra V tuşuna basılarak Selection Tool’a geri dönülmelidir. 

 

 

 

 

 

Görsel 3.6: Araç çubuğu 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 http://kitap.eba.gov.tr/KodSor.php?KOD=21722 adresinde bulunan 
“GORSELEFEKTDERSI” klasörünü bilgisayara indiriniz. 

 Programın desteklemediği uzantılar için dosyaları uygun formata dönüştürünüz. 

 

 

İşlem Basamakları 

1. “GORSELEFEKTDERSI/135” numaralı klasörde bulunan ve Alpha (transparan) bilgisi 
içeren resim dosyalarını Project paneline aktarınız. 

2. Project paneline aktarılan dosyaları klasör olarak düzenleyiniz. 

3. Composition Settings ayarlarına giderek yeni bir kompozisyon oluşturunuz. 

4. Kullanılacak görseli Composition paneline alınız. 

5. Alpha bilgisini, Composition panelinde Toggle Transparency Grid seçeneğiyle kontrol 
ediniz. 

6. Kullanılan görseli, Composition panelinde yer alan Magnification ratio popup 
seçeneğiyle Fit olarak ayarlayınız. 

7. Selection Tool ile görseli taşıma, büyütme ve küçültme işlemlerini gerçekleştiriniz. 

8. Hand Tool ile kompozisyon monitörünü konumlandırınız. 

9. Zoom Tool ile görüntüyü yaklaştırıp uzaklaştırınız. 

10. Farklı görsellerle işlemleri tekrarlayınız (Görsel 3.7). 

ÖĞRENME BİRİMİ 
GÖRSEL EFEKT YAZILIMINDA TEMEL  

DÜZENLEMELER UYGULAMA 
YAPRAĞI 5 

KONU ARAÇ ÇUBUĞU SEÇENEKLERİ KULLANIMLARI 

! Caps Lock tuşu açık ise Composition panelinde işlem yapılamaz. 

Görsel 3.7: Araç çubuğu seçenekleriyle kompozisyon düzenleme 
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Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Alpha bilgisi içeren resim dosyaları, Project paneline aktarıldı.   

Project paneline aktarılan dosyalar, klasör olarak düzenlendi.   

Composition Settings ayarlarına gidilerek yeni bir kompozisyon 
oluşturuldu. 

  

Alpha bilgisi, Composition panelinde Toggle Transparency Grid 
seçeneğiyle kontrol edildi. 

  

Kullanılan görsel, Composition panelinde yer alan 
Magnification ratio popup seçeneğiyle Fit olarak ayarlandı.. 

  

Selection Tool ile görseli taşıma, büyütme ve küçültme işlemleri 
gerçekleştirildi. 

  

Hand Tool ile kompozisyon monitörü konumlandırıldı.   

Zoom Tool ile görüntü yaklaştırılıp uzaklaştırıldı.   

Farklı görsellerle işlemler tekrarlandı.   
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İşlem Basamakları 

1. Composition > New Composition seçeneğiyle yeni bir kompozisyon oluşturunuz. 

2. Araç çubuğundan Rectangle Tool’u seçiniz. 

3. Shift tuşunu kullanarak  “iç dolgu” ve “kenar çizgi” renklerine karar veriniz ve “kare” 
şekli çiziniz (Görsel 3.8). 

4. Pan Behind aracını seçerek merkez noktasını köşelerden birine taşıyınız. 

5. Rotation Tool’u seçerek şekil üzerinde döndürme işlemi yapınız. 

6. Merkez noktasını farklı noktalara taşıyarak döndürme işlemini tekrarlayınız. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneğinden yeni bir 
kompozisyon oluşturuldu. 

  

Araç çubuğundan Rectangle Tool seçildi.   

Shift tuşu kullanılarak “iç dolgu” ve “kenar çizgi” renklerine 
karar verildi ve kare şekli çizildi. 

  

Pan Behind aracı seçilerek merkez noktası, köşelerden birine 
taşındı. 

  

Rotation Tool seçilerek şekil üzerinde döndürme işlemi yapıldı.   

Merkez noktası, farklı noktalara taşınarak döndürme işlemi 
tekrarlandı. 

  

 

 

ÖĞRENME BİRİMİ 
GÖRSEL EFEKT YAZILIMINDA TEMEL  

DÜZENLEMELER UYGULAMA 
YAPRAĞI 6 

KONU HAZIR ŞEKİL ARAÇLARININ KULLANIMLARI 

Görsel 3.8: Hazır şekil araçlarının kullanımı 
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ÖĞRENME BİRİMİ 
GÖRSEL EFEKT YAZILIMINDA TEMEL  

DÜZENLEMELER 
BİLGİ YAPRAĞI 

KONU 4. DÖNÜŞTÜRME İŞLEMLERİ 

4.1. Materyallerin Dönüştürülmesi 

Project paneline aktarılan dosyanın üzerine imleç aracıyla tıklandığında, panelin ön izleme 
penceresinden dosyanın özellikleri görünür. Bu pencereden yararlanılarak dosyanın boyutlarına göre 
yeni bir kompozisyon oluşturulabilir.  

Yeni bir kompozisyon oluşturulduktan sonra materyalleri kompozisyonun içine alma işlemi, 
sürükle-bırak yöntemiyle gerçekleştirilir. 

Kompozisyona yerleştirilen materyal, kompozisyonda oluşturulan Sahne’ye boyutları sebebiyle 
sığmayabilir. Görseli Sahne’ye göre ölçeklendirmenin birinci yöntemi (Selection Tool konusunda 
açıklanan yöntem); Sahne’deki görselin kenar çizgilerinden imleç aracı ve Shift tuşuyla birlikte tutularak 
büyütülüp küçültülmesidir. 

 

 

İkinci bir yöntem ise görselin boyutlarının, Sahne’ye göre Dönüştürme (Transform) penceresi 
yardımıyla düzenlenmesidir (Görsel 4.1). Kompozisyon Sahnesi’ndeki görselin üzerine farenin sağ 
tuşuyla tıklanır. Açılan penceredeki Transform seçeneği; görselin boyutlarını değiştirme, 
konumlandırma, döndürme, ve şeffaflık ayarlarını yapma gibi birçok işlem için kullanılmaktadır. 

Görselleri Sahne’ye sığdırmak için Fit to Comp, Fit to Comp Width ya da Fit to Comp Height 
seçeneklerinden yararlanılabilir. Bu seçenekler kullanıldığında projede kullanılacak görselin en-boy oranı, 
kompozisyonun Sahne boyutlarının oranından farklı ise görsel üzerinde kenarlardan basıklık 
oluşabilmektedir. Bu durumda Transform işlemleri için Katmanlar (Layer) panelinden yararlanmak daha 
iyi sonuç verir. Bu konu, “Hareketli Görüntüler” adlı öğrenme biriminde işlenecektir. 

Görsel 4.1: Transform penceresi 

Görsel 4.2: Flip Horizontal yöntemiyle görseli farklı yönlere döndürme işlemi 
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 Fit to Comp: Görselin boyutlarının, kompozisyondaki Sahne’nin boyutlarına göre 
ayarlanmasını sağlar. 

 Fit to Comp Height:  Görselin yüksekliğini, Kompozisyon Sahnesi’nin yüksekliğine 
sığdırır. 

 Fit to Comp Width: Görselin genişliğini, Kompozisyon Sahnesi alanına göre ayarlar. 

 Flip Horizontal: Seçili görselin sağa veya sola dönme işlemini gerçekleştirir (Görsel 4.2). 

 Flip Vertical: Görselin ters dönmesini sağlar. 

 Center Anchor Point In Layer Content: Çıpa noktasının merkeze alınmasını sağlar. 

4.2. Dönüştürme (Transform) İşlemleri 

Materyallerin Sahne üzerinde Dönüştürme (Transform) işlemleri, açılan pencerede; Anchor 
Point (enkır point), Position (pozişın), Scale (skeyl), Rotation (roteyşın), Opacity (opasiti) seçenekleriyle 
yapılabilir.  

 Anchor Point: Açılan pencerede girilen değerlerle, görselin hareket merkezi değiştirilir 
(Görsel 4.3). 

 

 

 Rotation: Belirlenen merkez noktasına göre görselin döndürülmesi işleminin 
gerçekleştirilmesini sağlar (Görsel 4.4). 

 

 

  Scale: Materyalin boyutunun büyütülüp küçültülme işlemlerinin gerçekleşmesini sağlar 
(Görsel 4.5). 

 

Görsel 4.3: Anchor Point penceresi 

Görsel 4.5: Scale penceresi 

Görsel 4.4: Rotation (döndürme) işlemi 
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 Reset seçeneği kullanıldığında görseller, başlangıçta Sahne üzerine aktarıldıkları şekle 
dönüşürler. 

Transform > Scale seçimi gerçekleştirildiğinde, açılan pencerede genişlik ve yükseklik 
değerleri girilebilir. Link işareti açıksa Currrent Aspect Ratio seçeneği aktifleşir. Bu da 
mevcut en-boy oranının korunduğunu gösterir. 

 Position: Dosyanın Sahne üzerindeki konumunun belirlenmesinde kullanılır. 

 Opacity: Görselin şeffaflığını değiştirme aracıdır. Birden fazla dosyanın birleştirilmesinde 
kullanılabilir. 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 

 

İşlem Basamakları 

1. “GORSELEFEKTDERSI /141” numaralı klasörde bulunan materyalleri Project paneline 
aktarınız. 

2. Dosyaları klasör şeklinde düzenleyiniz. 

3. Composition > Composition Settings penceresini açarak yeni bir kompozisyon 
oluşturunuz. 

4. Kullanılacak görseli kompozisyona alınız. 

5. Fit to Comp seçeneğiyle görselin boyutlarını, kompozisyon monitörünün boyutlarına 
göre ayarlayınız. 

6. Fit to Comp Width, Fit to Comp Height seçenekleriyle görselin en-boy düzenlemelerini 
yapınız. 

7. Flip Horizontal seçeneğiyle görseli sağa ya da sola döndürünüz. 

8. Flip Vertical seçeneğiyle (Görsel 4.6) görselin ters dönmesini sağlayınız. 

9. Anchor Point seçeneğiyle merkez noktasını ayarlayınız. 

10. Birden fazla görseli seçerek Flip Horizontal, Flip Vertical ve Anchor Point işlemlerini 
yapınız. 

 

 

ÖĞRENME BİRİMİ 
GÖRSEL EFEKT YAZILIMINDA TEMEL  

DÜZENLEMELER UYGULAMA 
YAPRAĞI 1 

KONU MATERYALLERİN DÖNÜŞTÜRME İŞLEMLERİ-1 

Görsel 4.6: Flip Vertical (görseli ters döndürme) işlemi 
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! Yapılan işlemler, Ctrl+Z tuşuyla geri alınır. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Projede kullanılacak dosyalar, Project paneline aktarıldı.   

Dosyalar, klasör şeklinde düzenlendi.   

Composition > Composition Settings penceresi açılarak yeni bir 
kompozisyon oluşturuldu. 

  

Kullanılacak görsel, kompozisyona alındı.   

Fit to Comp seçeneğiyle görselin boyutları, kompozisyon 
monitörünün boyutlarına göre ayarlandı. 

  

Fit to Comp Width ve Fit to Comp Height seçenekleriyle 
görselin en-boy düzenlemeleri yapıldı. 

  

Flip Horizontal seçeneğiyle görsel, sağa ya da sola döndürüldü.   

Flip Vertical seçeneğiyle, görselin ters dönmesi sağlandı.   

Anchor Point seçeneğiyle merkez noktası ayarlandı.   

Birden fazla görsel seçilerek Flip Horizontal, Flip Vertical ve 
Anchor Point işlemleri yapıldı. 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 

 

İşlem Basamakları 

1. “GORSELEFEKTDERSI /142” numaralı klasörde bulunan materyalleri Project paneline 
aktarınız. 

2. Dosyaları klasör şeklinde düzenleyiniz. 

3. Composition > Composition Settings penceresini açarak yeni bir kompozisyon 
oluşturunuz. 

4. Kullanılacak görseli kompozisyona alınız. 

5. Görselin üzerine sağ tıklanarak açılan pencerede Transform > Position seçeneğine değer 
girerek konumu ayarlayınız. 

6. Transform > Scale seçeneğine değer girerek boyutu ayarlayınız. 

7. Transform > Rotation seçeneğine değer girerek döndürme açısını ayarlayınız. 

8. Transform > Opacity seçeneğine değeri girerek şeffaflık ayarını yapınız. 

9. Birden fazla görsel seçerek, Auto-Orient seçeneğiyle yapılan dönüştürme işlemlerini 
tekrarlayınız (Görsel 4.7). 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Projede kullanılacak dosyalar, Project paneline aktarıldı.   

Dosyalar, klasör olarak düzenlendi.   

ÖĞRENME BİRİMİ 
GÖRSEL EFEKT YAZILIMINDA TEMEL  

DÜZENLEMELER UYGULAMA 
YAPRAĞI 2 

KONU MATERYALLERİN DÖNÜŞTÜRME İŞLEMLERİ-2 

Görsel 4.7: Dönüştürme (Transform) işlemleri 
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Composition > Composition Settings penceresi açılarak yeni bir 
kompozisyon oluşturuldu. 

  

Kullanılacak görsel, kompozisyona alındı.   

Görselin üzerine sağ tıklanarak açılan pencerede Transform > 
Position seçeneğine değer girilerek konum ayarlandı. 

  

Transform > Scale seçeneğine değer girilerek boyut ayarlandı.   

Transform > Rotation değeri girilerek döndürme açısı ayarlandı.   

Transform > Opacity değeri girilerek şeffaflık ayarı verildi.   

Birden fazla görsel seçilerek, Auto-Orient seçeneğiyle yapılan 
dönüştürme işlemleri tekrarlandı. 
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5.1. Kaydetme 

Görsel efekt programında çalışmalar devam ederken veya bittiğinde; File > Save (Ctrl+S) 
seçeneği kullanılarak, açılmış olan projenin üzerine kaydetme işlemi yapılabilir. Save as (Ctrl+Shift+S) 
seçeneği kullanılırsa proje başka bir yere, başka bir isimle kaydedilir.  

Çalışma sırasında kaydetme işleminin yapılmaması durumunda, olası aksaklıklar nedeniyle 
kayıplar oluşabilir. Programın otomatik kaydetme işleminin ayarlanması, çalışma kayıplarının önüne 
geçilmesini sağlar. Edit > Preferences penceresinden Auto-Save seçilerek programın otomatik kaydetme 
ayarlarına giriş yapılır (Görsel 5.1). 

 

 

Save every (seyv evıri): Programın kaç dakika aralıkla kayıt yapması isteniyorsa bu seçenekten 
giriş yapılabilir. 

Save when starting render queue (seyv ven starting rendır kiyu): Bu seçenek işaretlenirse çıktı 
(render) alma işlemi başlatılmadan önce proje kaydedilir. Render alma işlemi sırasında oluşabilecek 
sorunlara karşı projenin korunmasını sağlar. 

Maximum Project Versions (maksimum procekt vörjıns): Otomatik kayıt işlemiyle kaydedilen 
dosyaların en fazla kaç tanesinin saklanacağının belirlenmesini sağlar. 

Auto-Save Location (oto seyv lokeyşın): Otomatik kayıt işlemlerinin proje dosyasına mı yoksa 
seçilen farklı bir yere mi yapılacağını belirlemeye yarar. 

5.2. Çıktı (Render) Alma 

Animasyon, video, 3D, 4D içerik üreten programlarda render (çıktı) işlemi gerçekleştirilir (Görsel 
5.2). Kullanılan bilgisayarın özellikleri, dosya özellikleri ve çalışmadaki materyallerin fazla olması, render 
süresini uzatır. Görsel efekt programında render işlemi, proje üzerinde ihtiyaca göre birden fazla kez 
tekrarlanabilir.  

ÖĞRENME BİRİMİ 
GÖRSEL EFEKT YAZILIMINDA TEMEL 

DÜZENLEMELER 
BİLGİ YAPRAĞI 

KONU 5. ÇIKTI (RENDER) 

Görsel 5.1: Otomatik kaydetme ekranı 
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Render alma işlemi, File > Export > Add To Render Queue (Ctrl+M) seçeneği kullanılarak 
gerçekleştirilir (Görsel 5.3). 

Bu seçimlerden sonra programda Render Queue (Çıktı Kuyruğu) penceresi açılır. Buradan render 
almak için gerekli ayarlar, projeye göre yapılabilir. 

 

 

Render Settings > Custom: Best Settings özelliği seçildiğinde açılan pencereden, render almak 
için gerekli olan bazı ayarlara ulaşılır. 

 Quality: Görüntü kalitesini ayarlama seçeneğidir. Best, Draft ve Wireframe (vayırfreym) 
seçenekleri vardır. Best seçeneği tercih edilmelidir. 

 Resolution: Çözünürlüğün ayarlandığı kısımdır. Görüntü kalitesi yüksek tutulmak 
istendiğinde Full seçilir. Çalışma sırasında işlemleri hızlandırmak için daha düşük 
çözünürlükler tercih edilebilir fakat çıktı almadan önce Full seçeneği tercih edilmelidir. 

 Frame Rate (freym reyt): Animasyon ve videolarda saniye başına düşen kare sayısı 
bilgisini girmeye yarayan seçenektir. Kompozisyonda verilmiş olan kare sayısı değeri 
tercih edilebilir veya render işleminden önce bu seçenekle yeni kare sayısı değeri 
girilebilir. Dikkat edilmesi gereken önemli nokta, kompozisyondakinden çok daha fazla 
kare sayısı girilmemesidir. Çünkü program, aradaki kareleri çok fazla tekrarla doldurur. 

 Start ve End seçenekleri, render süresi için düzenlemelerin yapıldığı seçeneklerdir. 
Custom Time Span seçeneği ile yeni değerler girilebilir. 

 

Output Module > Lossless seçeneğiyle açılan pencerede “dışarıya aktarım ayarları” yapılır. 

 Format: Render alınabilecek dosya formatları yer almaktadır. Video, görsel ve ses 
formatlarından çalışmaya uygun olan ve kullanılmak istenen format seçilir. JPEG 
Sequence formatı, animasyonlarda 25 karenin ayrı ayrı fotoğraf olarak kaydedilmesini 
sağlar. PNG Sequence ise işlem yapılan video karelerinde alpha bilgisi bulunuyorsa bu 
bilgiyi koruyarak kaydetme işlemini gerçekleştirir. 

 Video Output > Channels seçeneği, renk kanallarıyla ilgili seçim yapmayı sağlar. RGB, 
Alpha, RGB+Alpha seçenekleri bulunur. Alpha seçilirse karelerde yalnızca alpha 
bölgeleri kaydedilir. Animasyonlarda RGB+Alpha’yı aktif duruma getirebilmek için 
Format Options > Video Codec kısmından Animation seçeneği seçilmelidir. Bu 
seçenekte hem RGB hem de Alpha kısımlar kaydedilebilir. 

 Resize seçeneğiyle projenin çözünürlüğü değiştirilebilir. 

Görsel 5.2: Dışarı aktarma (Export) seçeneğiyle render 

Görsel 5.3: Çıktı kuyruğu ekleme 
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 Audio Output Auto seçeneğiyle projenin “ses kaydını açıp kapatma” ve “sesle ilgili 
özelliklerini düzenleme” işlemleri yapılabilir. 

 

Output To seçeneğiyle ise projenin kayıt yeri ve adı seçilir. 

 

! Birden fazla kompozisyon, aynı proje içinde sıralı olarak render alınabilir. 

 

Render Queue penceresinde düzenleme işlemleri yapıldıktan sonra Render düğmesine tıklanır. 
Loading Bar (yükleme çubuğu) şeklinde bir çizgi hattı görülür. Bu çizgi tamamlandığında render işlemi de 
tamamlanmış olur. 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulamada kullanacağınız dosyaların uzantısını uygun formatlara dönüştürünüz. 

 

İşlem Basamakları 

1. Projede kullanılacak fotoğraf ve video dosyalarını Project paneline aktarınız. 

2. Dosyaları klasör şeklinde düzenleyiniz. 

3. Composition > Composition Settings penceresini açarak yeni bir kompozisyon 
oluşturunuz. 

4. Kullanılacak videoyu kompozisyona alınız. 

5. Herhangi bir işlem yapmadan kaydetme işlemi yapınız.  

6. Kompozisyon alanında, video üzerine arka plansız fotoğraf alarak “farklı kaydetme 
işlemi” yapınız. 

7. Edit > Preferences > Auto-Save ayarlarını yapınız. 

8. Otomatik kaydetme süresini değiştiriniz. 

9. Render işlemine başlamadan önce kaydetme seçeneğini belirleyiniz. 

10. Toplam kaç kayıt yapılacağı bilgisini değiştiriniz. 

11. Projenin kayıt yerini seçiniz OK düğmesine basınız. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Projede kullanılacak fotoğraf ve video dosyaları, Project 
paneline aktarıldı. 

  

Dosyalar, klasör şeklinde düzenlendi.   

Composition > Composition Settings penceresi açılarak yeni bir 
kompozisyon oluşturuldu. 

  

Kullanılacak video, kompozisyona alındı.   

Herhangi bir işlem yapılmadan kaydetme işlemi yapıldı.   

Kompozisyon alanında, video üzerine arka plansız fotoğraf 
alınarak farklı kaydetme işlemi yapıldı. 

  

Edit > Preferences > Auto-Save ayarları yapıldı.   

Otomatik kaydetme süresi değiştirildi.   

Render işlemine başlanmadan önce kaydetme seçeneği seçildi.   

Toplam kaç kayıt yapılacağı bilgisi değiştirildi.   

Projenin kayıt yeri seçildi ve OK düğmesine basıldı.   

 

ÖĞRENME BİRİMİ 
GÖRSEL EFEKT YAZILIMINDA TEMEL  

DÜZENLEMELER UYGULAMA 
YAPRAĞI 1 

KONU KAYDETME 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 

İşlem Basamakları 

1. Projede kullanılacak dosyaları Project paneline aktarınız. 

2. Dosyaları klasör şeklinde düzenleyiniz. 

3. Composition > Composition Settings penceresini açarak yeni bir kompozisyon 
oluşturunuz. 

4. Kullanılacak resim ve videoları kompozisyona alınız. 

5. File > Export > Add to Render Queue panelini açınız. 

6. Best Settings penceresinde kalite, çözünürlük, kare sayısı ve süre bilgilerini inceleyiniz. 

7. Lossles penceresinde Format, Format Options ve Video Output bilgilerini seçiniz. 

8. Output To seçeneğiyle videonun kayıt yerini ve adını belirleyiniz. 

9. Render düğmesine tıklayınız. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Projede kullanılacak dosyalar, Project paneline aktarıldı.   

Dosyalar, klasör şeklinde düzenlendi.   

Composition > Composition Settings penceresi açılarak yeni bir 
kompozisyon oluşturuldu. 

  

Kullanılacak resim ve videolar, kompozisyona alındı.   

File > Export > Add to Render Queue paneli açıldı.   

Best Settings penceresinde kalite, çözünürlük, kare sayısı ve 
süre bilgileri incelendi. 

  

Lossles penceresinde Format, Format Options ve Video Output 
bilgileri seçildi. 

  

Output To seçeneğinden videonun kayıt yeri ve adı seçildi.   

Render düğmesine tıklandı ve render işleminin sonuçlanması 
takip edildi. 

  

 

 

 

 

 

 

ÖĞRENME BİRİMİ 
GÖRSEL EFEKT YAZILIMINDA TEMEL  

DÜZENLEMELER UYGULAMA 
YAPRAĞI 2 

KONU ÇIKTI (RENDER) 
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ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
BİLGİ YAPRAĞI 

KONU 1. ZAMAN ÇİZELGESİ 

 

Zaman Çizelgesi; üzerinde çalışılan kompozisyonun içerdiği katmanları, kompozisyon süresini ve 
her katmana ait süreyi gösterir. Zaman Çizelgesi’nin sol tarafında Katman paneli, sağ tarafında ise 
Zaman Cetveli bulunur (Görsel 1.1). 

 

1.1. Katman (Layer) Paneli 

Görsel efekt programı, daha verimli çalışmayı sağlamak amacıyla; Menü çubuğunda bulunan 
birçok özelliği; Çalışma Alanı’nda simgelerin, açılır listelerin ve araçların altına da ekler. Katmanlarla 
çalışılırken ihtiyaç duyulan birçok özelliğe de Katman panelinde bulunan araçlar, simgeler ve açılır 
listelerden kolayca ulaşılır (Görsel 1.2). 

 

 

A) Zaman Göstergesi: Zaman Cetveli’nde Geçerli Zaman Göstergesi’nin olduğu noktayı; Saat 
(Hour) : Dakika (Minute) : Saniye (Second) : Kare (Frame) olarak gösterir. 

 

 

Görsel 1.1: Zaman Çizelgesi (Timeline) Paneli 

Görsel 1.2: Katman Paneli (Layer Panel) 
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Örneğin Geçerli Zaman Göstergesi’nin 5. saniyeye gitmesi için “500” yazmak yeterlidir. Program 
süreyi, otomatik olarak soldan sağa doğru ve başına “0” atarak 00:00:05:00 şeklinde oluşturur veya 
doğrudan saniye alanına tıklanarak gidilmek istenen süre yazılabilir (0:00:05:00). 

B) Arama Alanı: Katman panelinde arama yapmak için kullanılır.  

C) Katman Anahtarları: Zaman Çizelgesi’nde kolonları olan anahtarlar [switches (sviçıs)], önce 
bu alanda seçilerek aktif hâle getirilir. Ardından katmana ait kolondan seçim yapılarak uygulanır (Görsel 
1.3). 

 

 

D) Katman Ayarlama Simgeleri: 
 

 

Göz Simgesi: Çoklu katmanlarla çalışılırken katmanın Sahne’de görünmesini ya da 
görünmemesini sağlar. Kapatılmak istenen katmanın Göz simgesine tıklanır ve Göz simgesi kaybolur. 
Böylece katman Sahne’de görünmez. Tekrar aynı kutuya tıklanırsa hem Göz simgesi hem de Sahne’deki 
katman görünür hâle gelir. 

Hoparlör Simgesi: Sesi olan katmanların sesini aktif veya pasif yapmak için kullanılır. Sesli 
katmanlarda hoparlör aktif olarak görünür. Hoparlörün üzerine tıklanarak ses kapatılır. Tekrar 
tıklandığında ses aktif edilir. 

Solo Simgesi: Sahne’de sadece bir veya birkaç katmanın görünmesi istendiğinde kullanılır. Çok 
fazla sayıda katmanla çalışılıyorsa ve sadece bir veya birkaç katmanın Sahne’de görünmesi isteniyorsa 
katman satırındaki Solo kutusuna bir kez tıklanır. Solo işareti aktif olur. Tekrar tıklandığında Solo işareti 
kalkar ve diğer tüm katmanlar Sahne’de görünür. 

Kilit Simgesi: Katmanın kilitlenmesi ve katmana herhangi bir müdahale yapılmasının 
engellenmesi için kullanılır. Kilitlenmek istenen katman satırındaki Kilit kutusuna tıklandığında Kilit 
simgesi aktif hâle gelir. 

 

 

 

 

Görsel 1.3: Zaman Çizelgesi Katman Anahtarları 

Görsel 1.4: Zaman Çizelgesi “katman ayarlama” simgeleri 
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E) Katman İsimleri, Renk Kutusu ve Katman Özellikleri Alanı 

 

 

Küçük Ok: Katman özelliklerini açar. Katman üzerinde yapılacak bütün çalışmalar (efekt, 
animasyon ve dönüştürme), bu alanda yapılır.  

Katman Renk Kutusu: Katman rengini ve katmana ait Süre Çubuğu’nun rengini gösterir. Bu 
renkler isteğe bağlı olarak değiştirilebilir. Kutunun üzerine gelinerek sağ tıklandığında renk listesi açılır ve 
listeden bir renk seçilir. Katman kutu rengi ve katmana ait Süre Çubuğu’nun rengi değişir. 

Katman İsmi: Katmanların adı yazılıdır. Dışardan içe aktarılan (import) materyaller, kendi 
adlarıyla bir katman oluşturur. Çalışma Alanı’ndan eklenen katmanlar ise türüne göre otomatik olarak 
adlandırılır. Katman isimleri değiştirilebilir. Katmanın üzerine gelinerek sağ tıklandığında açılan listeden 
Adını Değiştir (Rename) seçilir. İsim kutusuna bir isim yazılır ve klavyede Enter tuşuna basılır. 

Katman isimlerinin başında, her katmanın türünü gösteren bir simge bulunur.  

F) Katman Anahtarlarını Uygulama Alanı 

 

 

Utangaç Simgesi: Katmanları, Katman panelinde gizlemek için kullanılır. Bir katman gizlenmek 
istendiğinde katmana ait Utangaç sütunundaki kutuya tıklanır ve katman gizlenir. Kutuya tekrar 
tıklandığında katman görünür. 

Güneş Simgesi:  Kompozisyondaki vektör katmanları Rasterleştirmek için kullanılır. Vektör 
katmanların kenarlarının daha düzgün görünmesini sağlar.   

Slash Simgesi (Draf-Best): Katmanla çalışılırken görüntü kalitesini düşürerek bilgisayarın RAM, 
işlemci ya da ekran kartı gibi donanımlarına fazla yük binmesini engeller. Render (çıktı) alınacağı zaman 
tekrar eski hâline getirilir.  

Fx Simgesi: Katmana efekt eklendiğinde otomatik olarak katman sütununa eklenir. Katmana 
eklenen efektin Sahne’de görünmesi istenmediğinde kapatılarak pasif hâle getirilir.   

Film Karesi Simgesi: Düşük kareli (low frame) videolara uygulandığında görüntünün daha akıcı 
olması için program, otomatik ara kareler ekleyerek görüntünün daha kaliteli olmasını sağlar. Film Karesi 
simgesinin uygulanmak istendiği katman, Film Karesi sütunundaki kutuya tıklanarak aktif hâle getirilir.  

Görsel 1.5: Katman isimleri, renk kutusu ve katman özellikleri alanı 

Görsel 1.6: Katman Anahtarları’nın katmanlara uygulanması 
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Bulanıklaştırma (Motion Blur) Simgesi: Eklendiği katmana bulanıklık uygulayarak hareketli 
görüntüye “doğal hareket etkisi” kazandırır. Eklenmek istenen katmanın Motion Blur sütunundaki 
kutuya tıklanarak aktif hâle getirilir.  

Ayarlama (Adjustment) Simgesi: Ayarlama katmanı eklendiğinde program, Katman sütununda 
otomatik olarak aktif hâle gelir. Simgeye tıklanarak kapatıldığında Ayarlama katmanının etkisi kaldırılır.  

3D Simgesi: Bir katman, 3D katman yapılmak istendiği zaman 3D sütunundaki Katman kutusu 
işaretlenerek simge eklenir. 

G) Katmanları Bağlama Simgesi ve Katman Seçim Alanı 

Ana Bağlantı (Parent & Link) : Bir katmanı başka bir katmana bağlar. Bağlama simgesine 
basıldığında siyah bir ip çıkar. İp çekilerek uzatılır ve bağlanmak istenen katmanın adına tıklanır. İki 
katman arasında siyah bir çizgi şeklinde bağlantı oluşur. Katman, bağlandığı katmanın dönüştürme 
özelliklerini alır. Bağlama simgesinin yanında bulunan None açılır listesinden de bağlanmak istenen 
katman adı seçilerek o katmana link (bağlantı) verilebilir.  

H) Katman Anahtarları, Transfer Modları ve Katman Süreleri Alanı 

Sol baştaki simge seçildiğinde Katman Anahtarları’nı, ikinci simge seçildiğinde Transfer 
Modları’nı,  üçüncü simge seçildiğinde katmanların kompozisyon içindeki sürelerini ayarlamayı sağlayan 
araçları Katman paneline ekler.  

Sağdaki alan ise Zaman Çizelgesi’nde sadece Katman Anahtarları ile Transfer Modları’nı açıp 
kapatır (Görsel 1.7). 

 

1.1.1.  Katman Paneline Materyal Ekleme 

Bir proje hazırlanırken Proje paneline aktarılan materyaller (yazı, video, resim, ses, müzik ve 
dosya), Araç çubuğundan oluşturulan yazı ve şekiller ile Layer (katman) menüsünde bulunan katmanlar 
(yazı, şekil, solid, kamera, ışık, vb.) kompozisyona eklenebilir.  

Proje Panelinden Materyal Ekleme 

Görsel 1.7: Katman panelinde Modlar seçildiği zaman Katman panelinin görünümü 

Görsel 1.8: Katman paneline Proje panelinden materyal ekleme 
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Proje panelinde materyaller, tek tek seçilerek ya da bir materyal seçildikten sonra SHIFT tuşu 
basılı tutulup diğer materyaller de seçilerek Katman paneline, Sahne’ye veya Proje panelindeki 
kompozisyona sürüklenerek taşınır (Görsel 1.8). 

Araç Çubuğundan Şekil Ekleme 

Araç çubuğunda bulunan Şekil aracının (Shape Tool) köşesinde bulunan küçük üçgene tıklanıp 
basılı tutularak bir süre beklenir. Şekil araçları listesi açılır (Görsel 1.9). İstenen Şekil aracı seçilir. İmleç, 
şekil çizim imlecine dönüşür (Kısayolu: Q). Q tuşuna her basılışta şekiller arasında geçiş yapılır. 

 

 

Şekil aracı seçildiğinde Araç çubuğunda iki yeni araç oluşur: Bunlar Fill (doldur) ve Stroke 
(kenarlık) araçlarıdır. 

Fill aracında bulunan renk, şekil çizildiğinde şeklin içini dolduracak olan renktir. Stroke aracında 
bulunan renk ise şeklin kenarlık rengidir. Stroke aracının yanında bulunan değer, kenarlık boyutudur. 
Buradan kenarlık boyutu ayarlanır. 

Fill ve Stroke renklerini değiştirmek için kutuların içine bir kez tıklanır. Renk penceresinden veya 
Damlalık aracıyla, ekranın istenen bir yerinden bir renk seçilir ve OK düğmesine tıklanır (Görsel 1.10).  

 

 

Fill ve Stroke yazılarının üzerine tıklandığında ise Dolgu Özellikleri (Fill Options) ve Kenarlık 
Özellikleri (Stroke Options) “ayarlama pencereleri” açılır. Buradan Dolgu ya da Kenarlık için renk, 
Degrade ya da saydamlık ayarları yapılabilir. Ayarlar istenen şekilde yapıldıktan sonra OK düğmesine 
tıklanır (Görsel 1.11). 

Görsel 1.9: Şekil araçları (Shape Tool) listesi 

Görsel 1.10: Dolgu (Fill) rengi ayarlama penceresi 

Görsel 1.11: “Dolgu Özellikleri” ve “Kenarlık Özellikleri” ayarlama pencereleri 
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İstenen ayarlar yapıldıktan sonra Sahne’ye tıklanır ve imleç sürüklenerek şekil çizilir (Görsel 
1.12). Shift tuşu basılı tutularak çizim yapılırsa “en-boy oranı” korunur. 

 

 

Şekil çizildiği anda Katman panelinde Shape Layer 1 adında bir Şekil katmanı oluşur. Zaman 
Cetveli’nde ise kompozisyonun süresiyle aynı uzunlukta olan Şekil katmanına ait bir Süre Çubuğu oluşur.  

Çizim bittiğinde şeklin çevresinde çerçeve ve tutamaçlar oluşur. Tutamaçlar, şekli ölçeklendirmek 
ve döndürmek için kullanılır.  

Şekli Ölçeklendirmek: 

Araç çubuğundan Seçim aracı (Kısayolu: V) seçilerek köşelerdeki tutamaçlardan biri tutulur. 
Tutamaçlar; şekli küçültmek için içe doğru, büyütmek için dışa doğru sürüklenir. Şekil sağa sola veya 
yukarı aşağı doğru ölçeklendirilmek istendiğinde yanlardaki tutamaçlardan tutularak sürüklenir.  

En-boy oranı korunarak ölçeklendirilmek isteniyorsa tutamaç seçildikten sonra Shift tuşu basılı 
tutulur ve sürükleme tamamlanana kadar bırakılmaz.   

Şekli Döndürmek: 

Araç çubuğundan Dönme aracı (Rotation Tool) seçilerek tutamaçlardan biri tutulur ve şekil 
döndürülür (Görsel 1.13). (Kısayolu: W) 

 

 

Şekli Taşımak: 

Klavyede V tuşuna basılarak Seçim aracı seçilir. Fare imleciyle şeklin üzerine gelinir. Farenin sol 
tuşu şekle basılı tutularak sürükleme yoluyla şekil, istenen yere taşınır.  

 

! Kompozisyona, Pen Tool aracılığıyla ve Layer menüsünden de şekil eklenir. Şekil 

katmanıyla ilgili detaylı çalışmalar, “Şekil Oluşturma” konusunda anlatılacaktır. 

 

 

Görsel 1.12: Sahne’ye şekil çizmek 

Görsel 1.13: Araç çubuğunda bulunan Dönme aracı (Rotation Tool)   
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Araç Çubuğundan Yazı Ekleme 

Araç çubuğunda bulunan Yazı aracının (Type Tool) köşesinde bulunan küçük üçgene tıklanıp 
farenin sol tuşu basılı tutarak bir süre beklenir. Yazı aracının altında bulunan dikey ve yatay “yazı yazma 

araçları” listelenir (Görsel 1.14). Yapılacak çalışmaya göre istenen Yazım aracı seçilir. İmleç, metin 
imlecine dönüşür. (Kısayolu: Ctrl+T) 

 

 

 

Sahne’ye bir kez tıklandığında yazı imleci görünür (Görsel 1.15). İstenen metin yazılır.  

 

 

Eğer belirli bir alana yazı yazılmak isteniyorsa kompozisyon alanına bir kez tıklanır ve farenin sol 
tuşu basılı tutularak Metin kutusu sürüklenir. İstenen ölçüde bir Metin kutusu çizilir (Görsel 1.16). 
İstenen metin yazılır. 

 

 

Metin kutusunun yeniden ölçeklendirilmesi için köşelerde oluşan tutamaçlardan herhangi biri, 
farenin sol tuşu basılı tutularak içe ya da dışa doğru sürüklenir (Görsel 1.17). 

 

 

 

 

 

Görsel 1.14: Araç çubuğunda bulunan Yazı aracı (Type Tool)  

Görsel 1.15: Yazı imleci 

Görsel 1.16: Metin kutusu 

Görsel 1.17: Metin kutusu ölçeklendirme imleci 
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Yazı yazıldığı anda Katman panelinde, metin içeriğiyle aynı isimde bir Yazı katmanı oluşur. 
Zaman Cetveli’nde kompozisyonun süresiyle aynı uzunlukta, Yazı katmanına ait bir Süre Çubuğu oluşur 
(Görsel 1.18). 

Yazı biçimlendirme araçları, Karakter panelinde bulunur. Bu panel kullanılarak bir metin 
katmanındaki tüm metin biçimlendirilebilir. Karakter paneli, Çalışma Alanı’nda görünmüyorsa Window 
> Character Panel seçilir. 

“GÖKYÜZÜ” sözcüğünün fontu, rengi ve boyutu, Çalışma Alanı’nın sağında bulunan Karakter 
panelinde görünen özelliklerdedir. Bu özellikler değiştirilebilir.  

Tüm metinde değişiklik yapılması için Seçim aracıyla Yazı katmanına bir kez tıklanarak yazı seçilir.  

Karakter panelinde istenen değişiklikler yapılır (Görsel 1.19). 

 

 

Eğer metnin sadece belirli karakter parçaları biçimlendirilmek isteniyorsa sadece o karakterler 
seçilir. Bunun için Yazı aracı seçilir. Sahne’de seçilecek karakterin soluna tıklanır ve yazı imleci oluşunca 
basılı tutulup sürüklenerek istenen karakterler seçilir (Görsel 1.20). 

 

Görsel 1.18: Sahne’de metin oluşturma 

Görsel 1.19: Karakter panelinde (Character Panel) yazının düzenlenmesi 
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Yazı Katmanını Taşımak: Kompozisyon panelindeki veya Katman panelindeki Yazı katmanı, 
üzerine Seçim aracıyla bir kez tıklanarak seçilir. Yazı, istenen yere sürüklenerek taşınır.  

Yazı Katmanını Ölçeklendirmek: Yazı katmanı, Seçim aracıyla seçilir. Yazı, etrafında oluşan 
tutamaçlardan tutularak içe veya dışa doğru sürüklenir.  

Yazı Katmanını Döndürmek: Yazı katmanı, Dönme aracıyla (Kısayolu: W) seçilir. Yazı, etrafında 
oluşan tutamaçlardan tutularak sağa ya da sola doğru döndürülür.  

Yazı Katmanını Silmek: Yazı katmanı seçilir. Klavyede Delete tuşuna basılır.  

Yazı Katmanını Kopyalamak: Yazı katmanı seçilir. Klavyede Ctrl+D tuşlarına basılır. 

 

! Bu işlemler, seçim yapıldıktan sonra Menü çubuğunda Edit menüsünden de yapılabilir. 

 

1.1.2. Katmanları Sıralama 

Sahne’deki görüntü, Katman panelinde birçok katmanın üst üste gelmesiyle oluşur. Katman 
panelinde en üstte olan katman, Sahne’de de en önde olan katmandır. Kompozisyona yeni bir materyal 
eklendiğinde eğer Katman panelinde seçili bir katman varsa o katmanın üzerinde, seçili bir katman yoksa 
en üstte yeni bir katman oluşur. Katmanlar bir bütünün parçalarıdır ve belli bir sıraya göre üst üste 
gelerek görüntüyü oluşturur. Bu nedenle katmanların, Sahne’de görülmesi istenen sıraya göre yeniden 
düzenlenmesi gerekir. 

Katman panelinde bir katman seçilerek dikey yönde (aşağı ya da yukarı) sürüklenir. Bir katmanın 
altına veya üstüne gelindiğinde mavi renkli bir çizgi oluşur. Çizgi oluştuğunda istenen sırada bırakılır 
(Görsel 1.21). 

 

 

 

Görsel 1.20: Yazının belli bir alanının seçilmesi ve düzenlenmesi 

Görsel 1.21: Katmanların sıralanması ve Sahne’deki görüntünün düzenlenmesi 



 

 

59 

 

1.1.3. Temel Transform (Dönüştürme) Parametreleri 

Katman isminin solunda bulunan Ok simgesine tıklanarak Katman parametreleri açılır. 
Katmanlar, türlerine göre farklı parametrelere sahiptir. Ancak katmanların tamamında Transform özelliği 
vardır (Görsel 1.22). 

 

 

Transform (Dönüştürme): Dönüştürme özelliği altındaki seçeneklerle bir nesnenin konumu, 
ölçeği, dönme derecesi, dönme sayısı ve opaklığı ayarlanır. Transform özelliğinin solundaki Ok simgesine 
tıklanarak Transform parametreleri açılır.  

Anchor Point [Merkez Noktası / Çıpa Noktası (Kısayolu: A)] 

Nesnenin merkez noktasıdır (Görsel 1.23). Bir nesne konumlandırılırken, ölçeklendirilirken ya da 
döndürülürken merkez olarak bu nokta referans alınır. 

 

 

Merkez noktasının yeri, Transform özelliğinden ayarlanabilir. Burada X ve Y düzlemindeki 
değerlere tıklanır. İmleç, iki yönlü Ok şeklini alır (Görsel 1.24). İmleçle sağa veya sola doğru tıklanarak 
Merkez noktasının yeri ayarlanır. Ayrıca X ve Y değerlerine tıklanarak açılan kutuya istenen değer 
girilebilir. 

 

 

 

 

 

 

 

Görsel 1.22: Şekil katmanının Transform özelliği parametreleri 

Görsel 1.23: Merkez noktası (Anchor Point) 

Görsel 1.24: Parametre değerini değiştirme imleci 
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Anchor Point değerlerinde değişiklik yapılırken Merkez noktasının sabit kaldığı, nesnenin ise 
Merkez noktasına doğru hareket ettiği görülür (Görsel 1.25). Sahne’de nesnenin konumu değişmiştir. 
Ancak Transform özelliğinin Position değerlerine bakıldığında herhangi bir değişiklik olmamıştır. Bunun 
nedeni; nesne oluşturulurken Merkez noktası referans alındığı için Position değerlerinin, bu referansa 
göre oluşturulmasıdır. Sahne’deki karenin merkezi, en başta Merkez noktasının bulunduğu yerdir. 

 

 

Merkez noktasının değiştirilmesi için genellikle Araç çubuğunda bulunan Anchor Point aracı 
kullanılır (Görsel 1.26). 

Araca bir kez tıklandığında Merkez noktası, otomatik olarak nesnenin ortasına gelir. Eğer Merkez 
noktası nesnenin orta noktasına gelmediyse veya başka bir yere taşınmak isteniyorsa araç seçildikten 
sonra Merkez noktası, üzerine tıklanarak seçilir ve sürüklenerek istenen noktaya taşınır (Görsel 1.27).  

 

 

Nesnenin Merkez noktası bu yöntemle değiştirildiğinde nesne aynı konumda kalır. Ancak 
Position değerleri ( X ve Y eksenindeki değerler) değişir. Çünkü nesne oluşturulurken Merkez noktası 
referans alındığı için Merkez noktasının yeri değiştiğinde nesnenin yeri de değişir. 

Position [Pozisyon (Kısayolu: P)] 

Yatay ve dikey eksende nesnenin konumunun ayarlanmasını sağlar. 

 

Görsel 1.25: Merkez noktası ayarlama 

Görsel 1.26: Araç çubuğunda Merkez noktası aracı (Anchor Point Tool) 

Görsel 1.27: Merkez noktasını taşıma işlemi 
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Araba görseli Zaman Çizelgesi’ne eklendiğinde bir katman oluşturur ve Sahne’ye yerleşir (Görsel 
1.28). 

Arabanın yatay düzlemdeki (X ekseni) pozisyonunun değiştirilmesi için Transform özelliğinin 
parametreleri açılır. İmleç, Position parametresinin X eksenindeki değerlerine getirildiğinde “kaydırma 
okları” şeklini alır. 

 

İmleç sağ ok ya da sol ok yönünde hafifçe sürüklenerek istenen konuma getirilir veya X ekseni 
bir kez tıklandığında açılan kutuya istenen değer girilir (Görsel 1.29). 

 

 

Yukarıda sadece X ekseninde değişiklik yapılmıştır. Yatay düzlemde (Y ekseninde) herhangi bir 
değişiklik yapılmamıştır. Y ekseni seçilerek istenen değer girilir ve arabanın pozisyonu ayarlanır (Görsel 
1.30). 

 

Görsel 1.28: Katmanda Transform özelliğinin anlık görüntüsü 

Görsel 1.29: Aracın Position değerinin X ekseninde değiştirilmesi 

Görsel 1.30: Aracın Position değerinin Y ekseninde değiştirilmesi  
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! Nesne, Seçim aracı ile seçilerek de istenen yere taşınabilir.  Aracın yeni konumunun X ve 

Y eksenindeki değerleri, otomatik olarak Position parametresine atanır. 

 

Scale [Ölçek (Kısayolu: S)] 

Nesnenin boyutunun yatay ve dikey eksende ayarlanmasını sağlar.  

Kompozisyona eklenen nesnenin boyutu, her zaman %100’dür. Bu, nesne boyutunun 
ölçeklendirilmesinde henüz herhangi bir değişiklik yapılmadığı anlamına gelir (Görsel 1.31).  

Nesnenin boyutunun ayarlanması için Scale parametresindeki değerler değiştirilir (Görsel 1.32). 
(%-100, 0 ve %100 arasında). Değer %-100’e geldiğinde görüntü, ters dönmüş olur.  

En-boy oranının korunması için değerlerin solundaki Zincir simgesi kullanılır. Simge görünür 
durumdaysa en-boy oranı korunuyor demektir. Simge, üzerine tıklanarak pasif veya aktif yapılabilir. 

 

 

 

 

 

 

 

 

Görsel 1.32: Aracın Scale değeri değiştirildiğinde Sahne’deki görünümü 

Görsel 1.31: Aracın Scale değerinin anlık görüntüsü 
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Köşelerdeki tutamaçlar, köşelerden çekilerek nesnenin boyutlandırılmasını sağlar. Bu işlem 
yapılırken en-boy oranı korunmak isteniyorsa, Shift tuşu basılı tutulurken sürükleme işlemi yapılır 
(Görsel 1.33). 

Köşelerin ortalarında bulunan tutamaçlar, büyütmeyi yukarı aşağı veya sağa sola doğru yapar. 

Bütün boyutlandırma sürecinde program, Merkez noktasını referans alır. 

Rotation [Dönme (Kısayolu: R)] 

Nesnenin dönme sayısı ve dönme oranı (0 ile 360 derece arasında) ayarlanır. 

 

 

Nesnenin dönme sayısı, ilk değerden ayarlanır. İlk değer tıklanarak açılan kutuya istenen dönme 
değeri girilir. Rotation derecesi, kutuya “0” ile “360” arasında bir değer girilerek ya da imleç 
sürüklenerek ayarlanır (Görsel 1.34).  

Rotation değerleri incelendiğinde arabanın iki kez tam dönmesi ve döndükten sonra “56” 
derecelik bir açıyla durması istenmiştir.  

Arabanın dönmesi, Merkez noktası referans alındığı için merkezden  yapılır. Bu nedenle arabanın 
pozisyonu ve Anchor Point değerleri değişmez.  

 

 

 

 

Görsel 1.33 Shift tuşu basılı tutularak sürükleme işlemi görünümü 

Görsel 1.34: Aracın Rotation değeri değiştirildiğinde Sahne’deki görünümü 
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Ancak arabanın Merkez noktası değiştirilerek aynı dönme değerleri girildiğinde Anchor Point ve 
Position değerleri, aşağıdaki şekilde değişir (Görsel 1.35). 

 

 

Opacity [Opaklık / Saydamlık / Transparanlık (Kısayolu: T)] 

Nesnenin saydamlığını ayarlamak için kullanılır. “%100” ile  “%0” arasında bir değer girilir. 
Nesnenin görünürlüğü “%0”dan “%100”e doğru artar.  

Nesnenin opaklığını ayarlamak için Opacity değerine tıklanır ve istenen değer girilir (Görsel 
1.36). 

 

1.2. Zaman Cetveli 

Zaman Cetveli, kompozisyonun süresini ve katmanların sürelerini gösterir (Görsel 1.37). Zaman 
Cetveli’ne Anahtar Kareler eklenerek nesnelere hareket verilir. 

 

 

Görsel 1.35: Aracın Merkez noktası değiştirildiğinde Position değerleri 

Görsel 1.36: Aracın Opacity değeri değiştirildiğinde Sahne’deki görünümü 

Görsel 1.37: Zaman Cetveli 
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Zaman Cetveli’ndeki mavi uzun çizgi, Geçerli Zaman Göstergesi’dir. Geçerli Zaman 
Göstergesi’nin bulunduğu kare, o anda Sahne’de görünen karedir. Katman panelinde sol üst köşede 
bulunan Zaman Göstergesi alanında da Geçerli Zaman Göstergesi’nin bulunduğu süre görünür. 

Zaman Cetveli’nde kompozisyon süresi; dakika(m), saniye(s) ve kare sayısı (f) olarak görünür. 
Zaman Cetveli’nde kompozisyon süresini gösteren bir Süre Çubuğu ve her bir katman için oluşturulmuş 
Süre Çubukları bulunur. 

Zaman Cetveli’nde Geçerli Zaman Göstergesi’nin bulunduğu noktaya işlem yapılır.  

Geçerli Zaman Göstergesi’ni Zaman Cetveli’nde taşımanın farklı yolları vardır:  

1. Geçerli Zaman Göstergesi’ni Zaman Cetveli’nin başına taşımak için klavyeden Home 
veya I tuşuna basılır. Zaman Cetveli’nin sonuna taşımak için ise klavyeden End veya O 
tuşuna basılır. 

2. Kompozisyon süresini gösteren Süre Çubuğu’nda istenen noktaya bir kez tıklandığında 
Geçerli Zaman Göstergesi, tıklanan noktaya gelir (Görsel 1.38). 

 

 

3. Oynatma Kafası tutulur ve istenen noktaya sürüklenir (Görsel 1.39). 

 

 

4. Geçerli Zaman Göstergesi, Katman panelinde Zaman Göstergesi alanına istenen süre 
yazılarak belirlenen sürenin olduğu noktaya taşınır (Görsel 1.40). 

 

 

“Görsel 1.40”ta Geçerli Zaman Göstergesi, 2. saniye 11. karededir. 

 

 

 

Görsel 1.38: Geçerli Zaman Göstergesi’ni imleçle seçilen noktaya taşıma işlemi 

Görsel 1.39: Oynatma kafası 

Görsel 1.40: Zaman Göstergesi’ne süre girilerek Geçerli Zaman Göstergesi’nin taşınması 
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İşlem Basamakları 

1. Görsel efekt programında “UYGULAMA_211” adında bir proje açınız. 

2. “GORSELEFEKTDERSI” klasöründe bulunan “211” dosyasındaki materyalleri projeye 
aktarınız. 

3. Aşağıda belirtilen özelliklerde bir kompozisyon oluşturunuz. 

Name (Adı): Uygulama11 

Width (Genişlik): 1920 - Height (Yükseklik): 1080  

Frame Rate (Kare Hızı): 60 

Duration (Süre): 5sn  

Background Color (Arka Plan Rengi): Siyah  

4. Proje panelindeki materyalleri kompozisyona taşıyınız (Görsel 1.42). 

 

 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
UYGULAMA 
YAPRAĞI 1 

KONU VİDEO ÜZERİNE LOGO VE SOLID EKLEMEK 

Görsel 1.41: Uygulama tamamlandığında kompozisyondan bir karenin görünümü 

Görsel 1.42: Materyaller Katman paneline taşındığında Sahne’nin görünümü 
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5. Video katmanının çözünürlüğü “1920x1080” olduğu için Çalışma Alanı’na tam yerleşir 
(Video ile ilgili bilgiler, proje panelinde küçük ön izleme ekranında görülebilir.) (Görsel 
1.43). 

 

 

6. Logoyu ölçeklendirerek videonun sol üst köşesine taşıyınız (Görsel 1.44). 

 

 

7. Ctrl+Y kısayol tuşunu kullanarak yeni bir Solid katman oluşturunuz. Solid katmanın 
özellikleri; “Weight: 1500, Height: 500, Color: Koyu Mavi” şeklinde olmalıdır. 

8. Katman panelinde Solid katmanın Opacity değerini “%60” olarak belirleyiniz. Solid 
katmanı ekranda görünmesini istediğiniz alana taşıyınız (Görsel 1.45). 

Görsel 1.43: Proje panelinde Preview (ön izleme) penceresi 

Görsel 1.44: Position ve Scale değerleri değiştirildiğinde Sahne’nin görünümü 

Görsel 1.45: Opacity değeri değiştirildiğinde Solid katmanın Sahne’deki görünümü 
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9. Space tuşuna basarak ön izleme yapınız.  

10. Proje dosyasını kaydediniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“GORSELEFEKTDERSI” klasörü bilgisayara indirildi.   

“UYGULAMA_211” adında bir proje oluşturuldu.   

“GORSELEFEKTDERSI” klasöründe bulunan “211” numaralı 
dosyadaki materyaller, projeye aktarıldı. 

  

İstenen özelliklerde bir kompozisyon oluşturuldu.   

Materyaller kompozisyona eklendi.   

“Logo” ölçeklendirilerek ekranın sol üst köşesine yerleştirildi.   

İstenen özelliklerde bir Solid katman oluşturuldu.   

Solid katmanın Opacity değeri değiştirildi.    

Solid katman, istenen yere taşındı.    

Kompozisyon, Space tuşuna basılarak izlendi.   

Proje dosyası kaydedildi.   
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İşlem Basamakları 

1. Görsel efekt programında “UYGULAMA_212” adında bir proje oluşturunuz.  

2. “GORSELEFEKTDERSI” klasöründen “212” numaralı dosyadaki materyalleri projeye 
aktarınız. 

3. Aşağıda belirtilen özelliklerde bir kompozisyon oluşturunuz. 

Name (Adı):  Uygulama22 

Width (Genişlik): 1920- Height (Yükseklik): 1080  

Frame Rate (Kare Hızı): 60 

Duration (Süre): 5sn  

Background Color (Arka Plan Rengi): Siyah  

4. Materyalleri kompozisyona ekleyiniz. 

5. Katmanların isimlerini anlamlı olacak şekilde değiştiriniz (Görsel 1.47). 

 

 

6. Kompozisyon panelindeki görüntü “Görsel 1.48”deki gibi olmalıdır. 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
UYGULAMA 
YAPRAĞI 2 

KONU 
KOMPOZİSYON OLUŞTURMAK VE YAZI KATMANI 

EKLEMEK 

Görsel 1.46: Uygulama tamamlandığında Sahne’nin görünümü 

Görsel 1.47: Katman isimlerinin değiştirilmesi 
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“Uygulama22” kompozisyonunun çözünürlüğü, “1920x1080” iken; eklenen resmin çözünürlüğü, 
“1279x 1280”dir. Bu nedenle resmin yüksekliği kompozisyonun yüksekliğinden daha fazla, genişliği ise 
daha azdır. Bu durumda katman üzerinde farenin sağ tuşuna tıklanarak Transform seçeneğinden Fit to 
Comp özelliği seçildiğinde resim yanlara doğru deforme olacaktır. Resmin yanlara doğru deforme 
olmadan Kompozisyon paneline sığdırılması için Katman panelinde Transform’dan Scale seçilerek 
ölçeklendirilir. Ancak bu kez de resmin yanlarında veya yukarısında kayıplar oluşur.  

Bu durumda, en uygun yerleştirme şeklini tercih ediniz (Görsel 1.49).  

 

 

7. Arka Plan katmanıyla ilgili herhangi bir işlem yapılmayacağı için Arka Plan katmanını 
kilitleyiniz. 

8. “Helikopter” katmanının boyutunu ve pozisyonunu değiştirmek için Transform özelliğini 
açınız. Position ve Scale değerlerini ayarlayınız (Görsel 1.50). 

 

 

 

 

 

 

Görsel 1.48: Katman panelinde bulunan katmanların Sahne’de görünümü 

Görsel 1.49: “mountain-5428260_1280.jpg” dosya boyutunun Proje panelindeki ve Sahne’deki görünümü 
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9. Araç çubuğundan Yazı aracını seçiniz. Yazı aracını, istediğiniz yere konumlandırarak 
“PALMİYE ADASI” yazınız. Yazı fontunu değiştirmek için yazıyı seçerek Karakter 
panelinden font seçimi yapınız (Görsel 1.51). 

 

 

Yazı seçiliyken kırmızı çerçeveli alandan yazının fontunu, sarı çerçeveli alandan yazı ve kenarlık 
rengini, mavi çerçeveli alandan ise yazının büyüklüğünü değiştiriniz (Görsel 1.52). 

 

 

10. Space tuşuna basarak ön izleme yapınız. 

11. Çalışmayı proje dosyası olarak kaydediniz. 

 

 

Görsel 1.50: “Helikopter” katmanının Transfrom değerleri değiştirildiğinde Sahne’deki görünümü 

Görsel 1.51: Sahne’ye yazı ekleme 

Görsel 1.52: Yazı özelliklerinin Character panelinden değiştirilmesi 
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Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“UYGULAMA_212” adında bir proje oluşturuldu.   

“GORSELEFEKTDERSI” klasöründe bulunan “212” numaralı dosya 
içindeki materyaller projeye aktarıldı. 

  

İstenen özelliklerde bir kompozisyon oluşturuldu.   

Materyaller kompozisyona eklendi.   

Katmanların isimleri anlamlı olacak şekilde değiştirildi.   

Arka Plan katmanı ekrana tam olarak yerleştirildi.   

Arka Plan katmanı kilitlendi.   

Helikopter katmanının Position ve Scale değerleri değiştirildi.    

Yazı aracı seçilerek “PALMIYE ADASI” yazıldı. Yazının fontu, rengi 
ve büyüklüğü değiştirildi. 

  

Kompozisyon, Boşluk tuşuna basılarak izlendi.   

Çalışma, proje dosyası olarak kaydedildi.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

73 

 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
BİLGİ YAPRAĞI 

KONU 2. ANAHTAR KARELER 

 

Görsel efekt programında hareketli grafikler ve animasyonlar oluşturmak,  nesnelerin hareket 
hızlarını ayarlamak, efektler ekleyerek etkileyici görseller hazırlamak için Anahtar Kareler kullanılır. 

2.1. Katmanlara Anahtar Kare Ekleme 

Bir nesneye zaman içinde hareket ve değişim özelliği kazandırmak için en az iki Anahtar Kare 
gereklidir. Birinci Anahtar Kare nesnenin ilk durumunu, ikinci Anahtar Kare ise belli bir süre geçtikten 
sonraki durumunu gösterir. Değişim, bu iki Anahtar Kare arasındaki sürede gerçekleşir. 

Örneğin aşağıdaki görselde aracın üç saniyelik zaman diliminde yatay düzlemdeki hareketi 
görülmektedir (Görsel 2.1). 

 

 

Araca bu hareketin verilebilmesi için; 

1. Adım: Araç, animasyon başladığında nerede olması isteniyorsa o konuma getirilir 
(Örnekte Sahne’nin dışındadır.). 

Görsel 2.1: Zaman Cetveli’ne Anahtar Kare ekleme 



 

 

74 

 

2. Adım: Geçerli Zaman Göstergesi, Home tuşuna basılarak Zaman Cetveli’nin başına 
getirilir. 

3. Adım: “Araba” katmanının Transform özelliğinde Position’ın Kronometre simgesine bir 
kez tıklanır. Zaman Cetveli’nde Geçerli Zaman Göstergesi’nin bulunduğu noktaya bir 
Anahtar Kare eklenir (Görsel 2.2). 

 

 

 

4. Adım: İkinci Anahtar Kare’nin eklenmesi için Geçerli Zaman Göstergesi bir sonraki 
zamana (üçüncü saniyeye) taşınır. 

5. Adım: Araç, Seçim aracıyla tutulup sürüklenerek animasyon bittiğinde olması istenen 
konuma taşınır (Örnekte Sahne’nin dışındadır.). 

6. Adım: Program, bu noktaya otomatik olarak bir Anahtar Kare ekler (Görsel 2.3). 

Görsel 2.2: “Beyaz Araba” katmanına ilk Anahtar Kare eklendiğinde Çalışma Alanı’nın görünümü 

Görsel 2.3: “Beyaz Araba” katmanına ikinci Anahtar Kare eklendiğinde Çalışma Alanı’nın görünümü 



 

 

75 

 

7. Adım: Space tuşuna basılarak ön izleme yapılır. 

 

Anahtar Kareler ile animasyon oluşturulduğunda Katman panelinin en solunda iki tane Ok 
işareti ve ortasında bir Anahtar Kare simgesi oluşur (Görsel 2.4). 

 

 

Ok işaretleri, sağa ve sola doğru bir önceki ve bir sonraki Anahtar Kareler arasında gezinmeyi 
sağlar. Ortadaki Anahtar Kare simgesi ise yeni Anahtar Kare eklenmesini sağlar.   

Katman panelinde bulunan Zaman Göstergesi “00:00:00:00”da iken birinci Anahtar Kare’nin 
eklendiği görülür. Zaman Göstergesi “00:00:03:00”da iken ikinci Anahtar Kare’nin eklendiği görülür. 
Arabanın soldan sağa doğru yatay düzlemde hareketi üç saniye içinde gerçekleşir. 

Sahne’de birinci Anahtar Kare’nin olduğu noktayla ikinci Anahtar Kare’nin olduğu nokta 
arasında bir hareket yolu oluşmuştur (Görsel 2.5). Bu yol, düz bir çizgi değildir. Üç saniyelik zaman 
diliminde her saniye için “60” kare olarak ayarlanmış toplam “180” noktadan oluşmuştur. Program, 
kompozisyon ayarlanırken verilen sayıdaki kareyi her saniye için ekleyerek animasyonu oluşturur.  

 

2.2. Anahtar Kareler’i Taşıma 

Anahtar Kareler taşınarak birbirlerine yaklaştırılabilir veya birbirinden uzaklaştırılabilir. Anahtar 
Kareler birbirine yaklaştırıldığında hareket daha hızlı, birbirinden uzaklaştırıldığında ise hareket daha 
yavaş olur. 

Anahtar Kareler üç yolla taşınabilir: 

1. Yol: Zaman Cetveli’nde taşınmak istenen Anahtar Kareler’in yakınına tıklanır ve fareyle 
sürüklenerek etrafında bir çerçeve oluşturulur. Anahtar Kareler sürüklenerek istenen 
kareye taşınır (Görsel 2.6). 

 

Görsel 2.4: Kronometre, Anahtar Kare ekleme / silme ve gezinme simgeleri 

Görsel 2.5: Hareket yolu 

Görsel 2.6: Anahtar Kareler’i seçme ve taşıma 
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2. Yol:  Taşınacak ilk Anahtar Kare seçilir. Shift tuşu basılı tutularak diğer Anahtar Kareler 
de seçilir. Klavyeden Ctrl+X tuşlarına basılarak Anahtar Kareler kesilir. Geçerli Zaman 
Göstergesi istenen süreye getirilerek Ctrl+V tuşlarına basılır. 

3. Yol: Anahtar Kareler’i kopyalayarak taşımak için; seçim yapıldıktan sonra Anahtar 
Kareler, klavyeden Ctrl+C tuşlarına basılarak kopyalanır. Geçerli Zaman Göstergesi 
istenen süreye getirilir ve Ctrl+V tuşlarına basılarak Anahtar Kareler yapıştırılır. 

2.3. Anahtar Kareler’i Silme 

1. Yol: Sadece bir kare silinecek ise Anahtar Kare’ye fareyle tıklanır ve Delete tuşuna 
basılır. Birden fazla kare silinecek ise ilk Anahtar Kare seçilir ve Shift tuşu basılı tutularak 
diğer kareler de seçilir. Delete tuşuna basılarak Anahtar Kareler silinir. 

2. Yol: Geçerli Zaman Göstergesi’nin üzerinde bulunduğu Anahtar Kare’nin silinmesi için 
Katman panelinde, katmanın en solunda bulunan Anahtar Kare simgesine tıklanır. 

3. Yol: Bir parametreye ait Anahtar Kareler’in tamamını silmek için Kronometre simgesine 
tıklanır. Katmana ait seçili parametrenin tüm Anahtar Kareler’i silinir.  

2.4. Ara Anahtar Kare Ekleme 

Yukarıdaki animasyonda araba A noktasından B noktasına gelirken düz bir şekilde değil, biraz 
eğimli gelmesi istendiğinde yeni bir Anahtar Kare’ye ihtiyaç vardır.  

Geçerli Zaman Göstergesi, arabanın yerinin değişmesi istenen zamana taşınır. Katmanın Position 
parametresinden istenen konuma getirilir. Program otomatik olarak yeni bir Anahtar Kare ekler (Görsel 
2.7). 

 

 

Yukarıdaki görselde Geçerli Zaman Göstergesi “1.” saniyeye getirilmiş ve araba, Position değeri 
değiştirilerek istenen konuma taşınmıştır. Taşıma yapıldığı anda program otomatik olarak iki Anahtar 
Kare arasına yeni bir Anahtar Kare eklemiştir. 

 

 

Görsel 2.7: Katmana “Ara Anahtar Kare” ekleme 
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! Sahne’de oluşan Hareket Çizgisi herhangi bir noktasından tutulup herhangi bir yere 

sürüklendiğinde Geçerli Zaman Göstergesi’nin bulunduğu noktaya Anahtar Kare eklenir. 

 

 

Hareket Çizgisi’nin başlangıç ve bitişinde oluşan noktadan tutulup sürüklenerek hareketin 
başlama ve bitiş hızı ayarlanabilir. Kare şeklinden tutulup sürüklenerek Anahtar Kare’nin yeri 
değiştirilebilir (Görsel 2.8). 

2.5. Anahtar Kareler Arasında Gezme 

Anahtar Kareler üzerinde herhangi bir işlem yapılabilmesi için Anahtar Kare’nin seçilmesi 
gerekir. Anahtar Kareler’i seçmenin ve Anahtar Kareler arasında gezinmenin farklı yolları vardır:  

1. Yol: Zaman Cetveli’nde Geçerli Zaman Göstergesi’nin bir Anahtar Kare’den diğerine 
direk geçmesi için katmanın en solunda bulunan Anahtar Kare ekleme/silme simgesinin 
sağ ve sol oklarına tıklanır. 

 

2. Yol: Klavyede Shift tuşu basılıyken Geçerli Zaman Göstergesi fareyle tutulur ve Anahtar 
Kareler’e yaklaştırıldığında yapışarak Anahtar Kareler’in üzerinde durur. 

3. Yol: Klavyeden J ve K tuşlarına basılarak Anahtar Kare’nin solundaki ve sağındaki 
Anahtar Kareler’e doğrudan gidilir. 

2.6. Anahtar Kareler’e “Easy Ease” Ekleme 

Harekete doğallık etkisi katmak için Easy Ease efekti uygulanır. Easy Ease efekti, hareketin yavaş 
başlayıp ardından normal hızına gelmesini ve yavaşlayarak bitmesini sağlar.  

Easy Ease efekti uygulanmadığı zaman hareket bir anda başlayıp bir anda bitiyor gibi görünür. 

Tüm Anahtar Kareler’e Easy Ease eklenmesi için Anahtar Kareler’in tamamı seçilir. Herhangi bir 
Anahtar Kare üzerine farenin sağ tuşuyla tıklanır. Açılan listeden Keyframe Assistant özelliği seçilir. Yeni 
bir liste açılır. Bu listede bulunan Easy Ease efekti, Anahtar Kare’nin hem başına hem sonuna yavaşlama 
etkisi verir (Kısayolu: F9 ). Easy Ease In, hareket başlangıcına yavaşlama etkisi verirken Easy Ease Out, 
hareketin sonuna yavaşlama etkisi verir.  

Sadece istenen Anahtar Kareler’e Easy Ease eklenmesi için istenen Anahtar Kare seçilerek 
üzerine farenin sağ tuşuyla tıklanır ve efekt eklenir. 

Anahtar Kare’ye Easy Easy özelliği verildiğinde Anahtar Kare’nin şekli değişir (Görsel 2.9). 

 

 

 

 

 

 

Görsel 2.8: Anahtar Kare 
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2.7. Grafik Düzenleme (Graphics Editör) 

Zaman Cetveli, Katman panelinde bulunan Grafik Editörü seçildiğinde basit bir Grafik 
Düzenleme ekranına dönüşür. Grafik Editörü, Anahtar Kareler ile daha ayrıntılı çalışılmasına olanak 
sağlar. 

Aşağıdaki görselde Grafik Editörü seçildiğinde Zaman Cetveli’nde Anahtar Kareler arasında 
oluşan bir Hız-Zaman grafiği görülmektedir. Katmanın sadece Position değerine yatay düzlemde bir 
hareket verildiğinde grafik, iki Anahtar Kare arasında oluşmuştur. 

Grafikte görüldüğü gibi hareket bir anda başlayıp düz bir çizgide devam ederek bir anda da 
bitmiştir (Görsel 2.10). 

 

 

! Grafik Editörü seçildiğinde ekranda grafik oluşması için kompozisyona Anahtar Kareler’in 

ekli olması ve bu parametrelerin de seçili olması gerekir. 

Görsel 2.9: Anahtar Kareler’e Easy Ease efekti ekleme 

Görsel 2.10: Grafik Editörü 
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Anahtar Kareler seçilip klavyede F9 tuşuna basılarak Easy Ease efekti eklendiğinde grafik, 
aşağıdaki şekilde değişir (Görsel 2.11). 

 

 

Easy Ease efekti, hareketin yavaş yavaş başlayarak zamanla hızlanmasını ve tekrar yavaşlayarak 
durmasını sağlar. Grafikte de görüldüğü gibi hareket yavaş başlamış, ardından hızlanarak en üst seviyeye 
ulaşmış ve tekrar yavaşlayarak bitmiştir.  

 

 

Anahtar Kare’nin üzerine gelinerek bir kez tıklandığında (Görsel 2.12) Anahtar Kareler’in 
yanında aşağıdaki gibi noktalı sarı bir çizgi oluşur (Görsel 2.13). Bu noktalar, imleçle tutularak 
sürüklendiğinde grafik üzerinde değişiklik yapılmasını sağlar. 

Anahtar Kare, üzerine tıklanarak seçildiğinde de sürükleme yoluyla istenen yere taşınabilir. 

 

 

Yukarıdaki grafikte Anahtar Kare, 3. saniyeden 2. saniyeye taşınmıştır. Sarı noktalar hareket 
ettirilerek hareketin hızı değiştirilmiştir. Artık toplam animasyon süresi 3 saniye değil, 2 saniyedir. 
Arabanın hareketi yavaş başlayıp giderek hızlanmış ve hızlı bir şekilde yavaşlayarak durmuştur. 

Görsel 2.11: Easy Ease efekti eklendiğinde Grafik Editörü’nün görünümü 

Görsel 2.12: Anahtar Kare 

Görsel 2.13: Grafik Editörü’nde Anahtar Kareler üzerinde düzenleme yapma 
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İşlem Basamakları 

1. Görsel efekt programında “UYGULAMA_221” adında bir proje açınız. 

2. “GORSELEFEKTDERSI” klasöründe bulunan “221” dosyasındaki materyalleri projeye 
aktarınız. 

3. Aşağıda belirtilen özelliklerde bir kompozisyon oluşturunuz. 

Name (Adı):  Uygulama21 

Width (Genişlik): 1920 - Hight (Yükseklik): 1080  

Frame Rate (Kare Hızı): 60 

Duration (Süre): 5sn  

Background Color (Arka Plan Rengi): Siyah  

4. Proje panelindeki materyalleri kompozisyona taşıyınız (Görsel 2.15). 

5. Katmanların isimlerini anlamlı olacak şekilde değiştiriniz (Görsel 2.15). 

 

 

6.  Katman paneline eklenen materyalleri Sahne’de görünmesini istediğiniz şekilde 
sıralayınız. 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
UYGULAMA 
YAPRAĞI 1 

KONU KONUM DEĞİŞTİRME ANİMASYONU 

Görsel 2.14: Uygulama tamamlandığında oluşan animasyonun farklı sürelerdeki görünümü 

Görsel 2.15: Katman paneline materyal eklendiğinde Sahne’nin görüntüsü 
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7. Katmanların rengini, katmanların renk kutularından değiştiriniz (Görsel 2.16). 

 

 

8. Katmanları tek tek ölçeklendiriniz.  “Şehir” katmanını ölçeklendirmek için “Güneş” ve  
“Minibüs” katmanlarını, Sahne’de Göz simgesine tıklayarak kapatınız. “Şehir” katmanını, 
Fit to Comp özelliğini seçerek ekrana yerleştiriniz. “Şehir” katmanını kilitleyiniz. 

9.  “Minibüs” katmanında Göz simgesine tıklayarak katmanı tekrar görünür hâle getiriniz.  
“Minibüs” katmanının boyutunu ayarlayınız. “Minibüs” katmanını, animasyonun başında 
durmasını istediğiniz yere (Sahne’nin solundan dışarı) taşıyınız.  

10. “Güneş” katmanının Göz simgesine tıklayarak katmanı tekrar görünür hâle getiriniz. 
“Güneş” katmanının boyutunu ayarlayınız. “Güneş” katmanını, animasyonun başında 
durmasını istediğiniz yere (Sahne’nin sağından dışarı) taşıyınız (Görsel 2.17). 

 

 

11.  “Güneş” ve “Minibüs” katmanlarını Shift tuşuyla seçiniz. Klavyede P tuşuna basarak iki 
katmanın da sadece Position değerlerini açınız. Home tuşuna basarak Geçerli Zaman 
Göstergesi’ni Zaman Cetveli’nin başına getiriniz. Katmanlardan birinin Kronometre 
simgesine bastığınızda iki katmana birden ilk Anahtar Kareler eklenir (Görsel 2.18). 

 

 

12. Geçerli Zaman Göstergesi’ni, 5. saniyeye taşıyınız. “Minibüs” ve “Güneş” katmanlarını 
animasyonun 5. saniyesinde olmalarını istediğiniz konumlara taşıyınız (Görsel 2.19). 

 

Görsel 2.16: Katman kutusu renginin ve Süre Çubuğu renginin değiştirilmesi 

Görsel 2.17: “Güneş” ve “Minibüs” katmanlarının animasyon başladığı andaki konumları 

Görsel 2.18: Katmanlara ilk Anahtar Kareler eklendiğinde Çalışma Alanı’nın görüntüsü 
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“Minibüs” katmanı ve “Güneş” katmanı için kompozisyonun 5. saniyesine Anahtar Kareler 
ekleyiniz (Görsel 2.20).  

 

 

13. Tüm Anahtar Kareler’i seçiniz ve F9 tuşuna basarak Easy Ease efektini ekleyiniz. 

14. 0 (sıfır) tuşuna basarak animasyonu izleyiniz. 

15. Projeyi kaydediniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“UYGULAMA_221” adında Proje oluşturuldu.   

“GORSELEFEKTDERSI” klasöründe bulunan “221” numaralı 
dosyadaki materyaller projeye aktarıldı. 

  

İstenen özelliklerde bir kompozisyon oluşturuldu.   

Materyaller kompozisyona eklendi.   

Katmanlar panelinde bulunan katmanların sırası ayarlandı.   

Görsel 2.19: Anahtar Kareler’i eklemek için katmanların taşınması işlemi 

Görsel 2.20: Anahtar Kareler 5. saniyeye eklenir. 
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Katman isimleri değiştirildi.   

Katman renkleri değiştirildi.   

“Minibüs” ve “Güneş” katmanları, Göz simgelerine tıklanarak 
gizlendi. 

  

“Şehir” katmanı ekrana yerleştirildi ve kilitlendi.   

“Minibüs” katmanının boyutu ayarlandı ve hareket 
başlangıcındaki pozisyonuna taşındı. 

  

“Güneş” katmanının boyutu ayarlandı ve hareket başlangıcındaki 
pozisyona taşındı. 

  

Katman panelinde ”Güneş” katmanı ve “Minibüs” katmanı seçildi. 
Klavyede P tuşuna basılarak Position değerleri açıldı. 

  

Katmanlardan herhangi birinin Position değeri Kronometre’sine 
tıklandı.  

  

İki katmanın ilk Position değerine de Anahtar Kareler eklendi.   

Geçerli Zaman Göstergesi 5. saniyeye taşındı (Klavyede End 
tuşuna basılarak taşınır.). 

  

“Minibüs” katmanı, animasyonun sonunda olması istenen yere 
taşındı. 

  

“Güneş” katmanı, animasyonun sonunda olması istenen yere 
taşındı. 

  

Zaman Cetveli’nde Anahtar Kareler’in tamamı seçildi. Klavyede 
F9 tuşuna basılarak Easy Ease efekti eklendi. 

  

Kompozisyon, klavyede 0 (sıfır) tuşuna basılarak izlendi.   

Proje dosyası kaydedildi.   
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İşlem Basamakları 

1. Bir önceki derste oluşturulan “UYGULAMA_212” proje dosyasını Menü çubuğundan 
New > Open Project yoluyla açınız.  

2. Katman panelinden “Helikopter” katmanını seçerek P harfine basınız. 

3. “Helikopter”i, pozisyon değerlerini girerek veya Sahne’den Seçim aracıyla taşıyarak 
Sahne’nin dışına çıkarınız (Görsel 2.22). 

4. Geçerli Zaman Göstergesi’ni Zaman Cetveli’nin başına getiriniz. Kronometre’yi 
tıklayarak ilk Anahtar Kare’yi ekleyiniz (Görsel 2.22). 

 

 

5. Geçerli Zaman Göstergesi’ni 3. saniyeye taşıyınız. 

6.  Helikopterin yatay eksendeki Position değerini, Sahne’nin solundan dışarı çıkacak 
şekilde değiştiriniz (Helikopteri Seçim aracıyla seçtikten sonra Shift tuşunu basılı tutarak 
düz bir çizgide Sahne’nin soluna doğru sürükleyiniz.). 

Program otomatik olarak ikinci Anahtar Kare’yi ekler (Görsel 2.23). 

 
 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
UYGULAMA 
YAPRAĞI 2 

KONU 
ANAHTAR KARELER İLE NESNELERİN 

TRANSPARANLIĞINI DEĞİŞTİRME ANİMASYONU 

Görsel 2.21: Uygulama tamamlandığında oluşan animasyonun farklı sürelerdeki görünümü 

Görsel 2.22: “Helikopter” katmanına ilk Anahtar Kare eklenir. 
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7. “Helikopter” katmanını seçiniz. Klavyede P tuşuna basınız. “Helikopter” katmanının 
Position parametresine ait Anahtar Kareler’i seçiniz. Klavyede F9 tuşuna basarak Easy 
Ease efekti ekleyiniz (Görsel 2.24). 

 

 

8. Yazı katmanını seçiniz. T harfine basarak sadece Opacity parametresini açınız (Görsel 
2.25). 

9. Home tuşuna basarak Geçerli Zaman Göstergesi’ni Zaman Cetveli’nin en başına getiriniz 
(Görsel 2.25). 

 

Görsel 2.23: Helikopter katmanına ikinci Anahtar Kare eklenir. 

Görsel 2.24: Anahtar Kareler’e Easy Ease efekti eklenir. 

Görsel 2.25: Yazı katmanına ilk Anahtar Kare eklenir. 
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10. Opacity değerini “0” (sıfır) olarak belirleyiniz ve Kronometre’yi tıklayarak ilk Anahtar 
Kare’yi ekleyiniz (Görsel 2.25). 

11. Geçerli Zaman Göstergesini 1. saniyeye getiriniz. Opacity değerini “100” olarak 
belirleyiniz ve Enter tuşuna basarak ikinci Anahtar Kare’yi ekleyiniz (Görsel 2.26).  

 

 

12. 1. saniye ile 2. saniye arasında Opacity değerinin sabit kalması için;  

Geçerli Zaman Göstegesi’ni 2. saniyeye getiriniz. Opacity parametresinin en solunda 
bulunan Anahtar Kare simgesine tıklayarak yeni bir Anahtar Kare ekleyiniz 
(Opacity değeri aynı kalır.). 

İkinci bir yol olarak; Opacity değeri “0” olduğunda oluşturulan ikinci Anahtar Kare, 
kopyalanıp ikinci saniyeye yapıştırılabilir (Görsel 2.27). 

 

 

13. Geçerli Zaman Göstergesi’ni 3. saniyeye taşıyınız. Opacity değerini “0” (sıfır) olarak 
belirleyip dördüncü Anahtar Kare’yi ekleyiniz (Görsel 2.28). 

 

 

 

 

 

Görsel 2.26: Yazı katmanına ikinci Anahtar Kare eklenir. 

Görsel 2.27: Anahtar Kare kopyalama 
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14. 0 (sıfır) tuşuna basarak animasyonu izleyiniz. 

15. Projeyi kaydediniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“UYGULAMA_212” proje dosyası açıldı.   

“Helikopter” katmanı seçildi ve klavyede P harfine basılarak 
Position parametresi açıldı. 

  

Geçerli Zaman Göstergesi, Zaman Cetveli’nin başına getirildi.   

“Helikopter” katmanı, hareket başlangıcındaki pozisyona taşındı.   

Position parametresinde bulunan Kronometre simgesine 
tıklanarak ilk Anahtar Kare eklendi. 

  

Geçerli Zaman Göstergesi 3. saniyeye taşındı (Klavyede End 
tuşuna basılarak taşınır.). 

  

“Helikopter” katmanı, animasyonun sonunda olması istenen yere 
taşındı. 

  

“Helikopter” katmanına ikinci Anahtar Kare eklendi.   

“Helikopter” katmanına ait Anahtar Kareler seçilerek Easy Ease 
efekti eklendi. 

  

Yazı katmanı seçildi. Opacity parametresi açıldı. Opacity için “0” 
(sıfır) değeri girildi. 

  

Geçerli Zaman Göstergesi, Zaman Cetveli’nin başına taşındı.   

Görsel 2.28: Yazı katmanına dördüncü Anahtar Kare eklenir. 
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Opacity değerinde bulunan Kronometre tıklanarak ilk Anahtar 
Kare eklendi. 

  

Geçerli Zaman Göstergesi 1. saniyeye taşındı.   

Opacity değeri “100” olarak belirlendi.   

Geçerli Zaman Göstergesi 2. saniyeye taşındı.   

1. saniyedeki Anahtar Kare seçildi ve Ctrl+C tuşlarına basılarak 
kopyalandı. Ctrl+V tuşlarına basılarak 2. saniyeye yapıştırıldı. 

  

Geçerli Zaman Göstergesi 3. saniyeye taşındı.   

Opacity değeri “0” (sıfır) olarak belirlendi.   

Kompozisyon, klavyede 0 (sıfır) tuşuna basılarak izlendi.   

Proje dosyası kaydedildi.   
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ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
BİLGİ YAPRAĞI 

KONU 3.KATMANLAR 

 

Proje paneline dışardan aktarılan video, resim, yazı, ses vb. dosyalar, kompozisyona eklendiği 
zaman Katman panelinde birer katman oluşturur. Kompozisyonu oluşturan katman sayısının fazla 
olması, katmanlara tek tek müdahale etmeyi kolaylaştırır. Çoklu katmanlarla çalışmak, kullanıcıya 
esneklik ve hız kazandırır. 

Kompozisyona eklenen video, resim, yazı, ses dosyalarının yanı sıra Layer menüsünden de farklı 
türde katmanlar kompozisyona eklenerek “görsel etkisi yüksek” animasyonlar hazırlanır. 

3.1. Kompozisyona Layer (Katman) Menüsünden Katman Ekleme 

Menü çubuğundan Layer > New seçilir (Görsel 3.1). 

 

 

Açılan listede istenen katmana tıklanır. Seçilen katmanın türüne göre bir ayarlama penceresi 
açılır. Açılan pencerede istenen özellikler belirlendikten sonra Tamam düğmesine tıklanır. Seçilen 
katman, kompozisyona eklenir.  

Örnek: “Katman” panelinde bir “Solid” katman oluşturmak için Layer > New > Solid seçilir. 

Solid Ayarlar penceresi açılır. Burada Solid katmana bir isim (Name), yükseklik (height) ve 
genişlik (width) değeri verilir. Rengi (color) ayarlanır. Make Comp Size seçeneği işaretlendiğinde Solid 
katman, kompozisyon ile aynı boyuta getirilmiş olur (Görsel 3.2). 

 

 

 

Görsel 3.1: Kompozisyona yeni katman ekleme menüsü 

Görsel 3.2: Solid katman ayarlama menüsü 
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Solid katmanda herhangi bir değişiklik yapılmak istendiği zaman Menü çubuğundan Layer > New 
> Solid Settings seçilerek istenen değişiklikler yapılır. 

 

! Aynı menüye Katman panelinde herhangi boş bir noktaya farenin sağ tuşuyla tıklanarak 

da ulaşılır. 

 

Text (Yazı katmanı): Yazı katmanı oluşturmak için kullanılır. Yazı katmanı, Araç çubuğunda 
bulunan T aracı seçilerek de oluşturulabilir. 

Solid Layer (Katı katman): İstenen renkte bir katman oluşturur. Genellikle Arka Plan katmanı ve 
“alt bant” olarak kullanılır.  

Light Layer (Işık katmanı): Üç boyutlu çalışmalarda sanal ışık kaynağı oluşturmak için kullanılır. 

Camera Layer (Kamera katmanı): Üç boyutlu çalışmalarda Çalışma Alanı’nda sanal kamera 
oluşturmak için kullanılır. 

Null Object (Boş obje katmanı): Null Object katmanının kendine ait Transform özelliği olan gizli 
bir katmandır. Null katman özelliklerine animasyon verilerek diğer katmanlar, bu katmana bağlanabilir. 

Shape Layer (Şekil katmanı): Kompozisyona şekil eklemek için kullanılır.  

Adjustment Layer (Ayarlama katmanı): Katmanla ilgili efektler, Adjustment Layer oluşturularak 
katmana eklenir. Adjustment Layer, sadece altında bulunan katmanlara etki eder.  

Her katmanın standart olarak Transform özelliği vardır. Ayrıca katmanlar türlerine göre farklı 
özelliklere sahiptir (Görsel 3.4). 

 

 

 

 

 

 

 

 

 

 

Görsel 3.3: Solid katman eklendiğinde Sahne’nin görünümü 
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3.2. Layer Menüsünden Katman Özelliklerini Değiştirme 

Layer menüsünde bulunan seçenekler, katmanlarla çalışılırken ihtiyaç duyulan komutları içerir 
(Görsel 3.5). Layer menüsünde bulunan seçeneklerin birçoğu, Katman panelinde katman seçilerek 
farenin sağ tuşuna tıklandığında da açılır. Bu seçeneklerin hemen hemen tamamı panellere, araçlara, 
simgelere, açılır menülere de eklenerek kullanım kolaylığı sağlanmıştır. 

 

 

Görsel 3.4: Katman türleri ve özellikleri 

Görsel 3.5: Menü çubuğunda Layer (katman) menüsü 
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Layer menüsü; katmanlara maske, katman stili, karıştırma modları, işaret, efekt, tracker 
eklemek; katmanları düzenlemek, dönüştürmek ve gruplamak; videonun hızını artırmak, azaltmak veya 
ters çevirmek gibi birçok komut içerir. 

3.2.1. Karışım Modları (Blending Modes) 

Karışım Modları; eklendiği katmanın, altındaki katmanla birlikte nasıl tepki vereceğini belirler. 
Karıştırma etkisi, sadece üstteki katmanla altındaki katman arasında olur.  

Bir katmana Karışım Modları eklemek için aşağıdaki adımlar uygulanır: 

1. Katmanın üzerine farenin sağ tuşuyla tıklanır. Açılan listeden Blending Mode seçilerek 
Karışım Modları açılır. Listeden istenen bir Karışım Modu seçilir. 

2. Katman Modu alanı, Katman panelinin altında bulunan düğmeye 
tıklanarak panelde görünür hâle getirilir. 

Katmanın sağında bulunan Normal kutusuna tıklanarak Karışım Modları listesi açılır (Görsel 
3.6). Listeden istenen Karışım Modu seçilir. 

 

 

Katmanlara Screen (Ekran) Modu Uygulama 

Ekran Modu, görüntünün karanlık bölümlerinden kurtulmak için kullanılan bir karıştırma 
modudur. Aşağıda “Görsel 3.7”deki iki fotoğraf Ekran Modu’yla karıştırıldığında “Görsel 3.8”deki görüntü 
elde edilir. 

Görsel 3.4: Katman Karışım Modları (Blending Modes) 
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3.2.2. Katman Stilleri (Layer Styles) 

Katmanlara ışık, gölge, kenarlık ve kabartma efektleri eklemek için Layer Styles kullanılır. 
Katman panelinde katmana farenin sağ tuşuyla tıklanır. Açılan menüden Layer Styles seçilerek Katman 
Stilleri menüsü açılır (Görsel 3.9). 

Hepsini Göster (Show All) seçeneği, katmana bütün stilleri ekler. Hepsini Kaldır (Remove All) 
seçeneği ise katmandaki bütün stilleri kaldırır (Görsel 3.10). 

 

 

 

 

 

 

Görsel 3.7: Ekran Modu uygulanacak görseller 

Görsel 3.8: Katmanlara Ekran Modu uygulama 
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Katmana “Inner Glow” Stili Uygulama 

Katmanın üzerine farenin sağ tuşuyla tıklanır ve Layer Styles > Inner Glow seçilerek eklenir. 
Katman panelinden katman özellikleri açılır. Katmana Katman Stili eklendiği zaman Karıştırma 
Özellikleri de eklenir. Katman Stilleri, Karıştırma Özellikleri’yle beraber etkili animasyonlar 
oluşturulmasını sağlar. 

Katman Stili katmana eklendiğinde parametre değerleri, aşağıdaki şekildedir (Görsel 3.11). Bu 
değerler değiştirilerek Katman Stili’nin etkisi ayarlanır. 

 

 

 

Görsel 3.9: Katman Stilleri 

Görsel 3.10: “Show All” seçildiğinde tüm stiller katmana eklenir. 

Görsel 3.11: Katmana Inner Glow stili ekleme 
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Katman panelinde Inner Glow stilinin parametreleri değiştirildiğinde aşağıdaki görsel elde edilir 
(Görsel 3.12). 

Blend Mode: Pin Light 

Noise: %50 

Color: Sarı 

Thecnique: Precise 

Size: 200  

 

 

Katman Stili’ne Anahtar Kareler eklenerek etkili animasyonlar hazırlanabilir.  

“Görsel 3.12”de Katman Stili eklenen katmana Anahtar Kareler eklemek için;  

1. Katman Stili değerleri değiştirilmeden önce Geçerli Zaman Göstergesi, Home tuşuna 
basılarak Zaman Cetveli’nin başına getirilir. 

2. Blend Mode, Noise, Color, Thecnique ve Size değerlerinin yanındaki Kronometre’ye 
tıklanır. İlk Anahtar Kareler eklenir. 

3. Geçerli Zaman Göstergesi 3. saniyeye taşınır.  

Blend Mode: Pin Light, 

Noise: %50, 

Color: Sarı, 

Thecnique: Precise, 

Size: 200, değerleri girilir (Görsel 3.13). 

4. Space tuşuna basılarak üç saniyelik animasyon izlenir. 

Görsel 3.12: Inner Glow parametreleri değiştirildiğinde katmana etkilerinin Sahne’deki görünümü 

Görsel 3.13: Inner Glow stiline Anahtar Kareler eklemek 
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! Katman panelinde katman parametrelerine verilen Anahtar Kareler’in görünmesi 

istendiği zaman Katman panelinde herhangi bir boş alana tıklanır ve U tuşuna basılır. 

3.2.3. Pre-Composition (Ön Kompozisyon) Oluşturma 

Büyük projelerde, çalışılan Katman panelinde çok fazla sayıda katman oluşur. İki veya daha fazla 
katmanın, kompozisyonun bir parçası olarak bir araya getirildiği ve ayrı ayrı işlem yapılmasına gerek 
olmayan durumlarda Pre-Composition oluşturulur. Böylece Katman panelindeki yığılma ve karmaşa 
önlenir.  

Aşağıda “Görsel 3.14”de Çalışma Alanı’nda iki katmanlı bir kompozisyon bulunuyor. İki katmanla 
ilgili ayrı ayrı herhangi bir işlem yapılmayacak ise bu katmanlar, Pre-Composition işlemiyle tek bir 
katman hâline getirilir.  

 

 

Pre-Composition oluşturmak için katmanlar seçilir ve seçili katmanların üzerine farenin sağ 
tuşuyla tıklanır. Açılan menüden Pre-Composition seçilir (Görsel 3.15). 

 

 

Pre-Composition ayarlama penceresi açılır. İsim alanına anlamlı bir isim yazılır. Programda 
standart olarak tüm katmanları, özellikleriyle birlikte aynı kompozisyon içinde oluşturma seçeneği 
işaretlidir. OK düğmesine tıklanarak Pre-Composition oluşturulur. 

Görsel 3.14: İki katmanlı bir kompozisyon 

Görsel 3.15: Katman panelindeki katmanların seçilerek Pre-Compose oluşturulması 
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Farklı bir kompozisyonda oluşması istenirse; 

Yeni Kompozisyon Aç (Open New Composition) seçilir. OK düğmesine tıklanarak Pre-
Composition oluşturulur. 

Aşağıda Katman panelinde Katman_Stili adında bir Pre-Composition oluşturulmuştur (Görsel 
3.16). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Görsel 3.16: Katman panelinde oluşturulan “Katman_Stili” isimli Pre-Compose 
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İşlem Basamakları 

1. “UYGULAMA_231” adında bir proje dosyası oluşturunuz. 

2. “GORSELEFEKTDERSI” klasöründe bulunan “231” numaralı dosyadaki materyalleri 
projeye aktarınız. 

3. Aşağıda belirtilen özelliklerde bir kompozisyon oluşturunuz. 

Name (Adı): Uygulama31 

Width (Genişlik): 1920 - Height (Yükseklik): 1080  

Frame Rate (Kare Hızı): 60 

Duration (Süre): 5 sn  

Background Color (Arka Plan Rengi): Siyah  

4. Fotoğrafı kompozisyona ekleyiniz (Görsel 3.18). 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
UYGULAMA 
YAPRAĞI 1 

KONU 
SOLİD KATMANA KATMAN STİLİ EKLEME  

ANİMASYONU 

Görsel 3.17: Uygulama tamamlandığında oluşan animasyonun farklı sürelerdeki görünümü 

Görsel 3.18: Üzerine efekt eklenecek görsel 
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5. Kompozisyon boyutunda bir Solid katman oluşturunuz (Renk daha sonra gradient olarak 
değiştirileceğinden herhangi bir renk olabilir.). 

6. Solid katmana farenin sağ tuşuyla tıklayarak Layer Styles > Gradient Overlay özelliğini 
seçiniz (Görsel 3.19). 

 

 

7. Solid katman özelliklerine Layer Styles > Gradient Overlay ekleyiniz. Gradient Overlay 
özelliğinin altında bulunan Colors parametresinde Edit Gradient’e tıklayarak Gradient 
Editor’ü açınız (Görsel 3.20). 

 

 

Gradient Editör’de başlangıç ve bitiş renklerini seçiniz. 

8. Solid katmanın Transform özelliğinde Opacity değerini “50” olarak belirleyiniz (Görsel 
3.21). 

 

 

9. Geçerli Zaman Göstergesi’ni 1. saniyeye taşıyınız. Solid katmanın Layer Styles > 
Gradient Overlay > Colors parametresinde Kronometre simgesine tıklayınız ve birinci 
Anahtar Kare’yi ekleyiniz (Görsel 3.22).  

 

 

Görsel 3.19: Layer Styles menüsünden Gradient Overlay ekleme 

Görsel 3.20: Colors parametresinde Edit Gradient ile Gradient renk penceresini açma 

Görsel 3.21: Solid katman Transform özelliği 
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10. Geçerli Zaman Göstergesi’ni 2. saniyeye taşıyınız. Solid katmanın Colors parametresinde 
Edit Gradient’e tıklayınız. Gradient Editör’de başlangıç ve bitiş renklerini seçerek OK 
düğmesine tıklayınız (Görsel 3.23). 

 

 

İkinci Anahtar Kare’yi ekleyiniz. 

11. Geçerli Zaman Göstergesi’ni 3. saniyeye taşıyınız. Solid katmanın Colors parametresinde 
Edit Gradient’e tıklayınız. Gradient Editör’de başlangıç ve bitiş renklerini seçerek OK 
düğmesine tıklayınız (Görsel 3.24). 

 

 

Üçüncü Anahtar Kare’yi ekleyiniz. 

12. Geçerli Zaman Göstergesi’ni 4. saniyeye taşıyınız. Solid katmanda Colors 
parametresinde Edit Gradient’e tıklayınız. Gradient Editör’de başlangıç ve bitiş 
renklerini seçerek OK düğmesine tıklayınız (Görsel 3.25). 

 

 

 

Görsel 3.22: Gradient Overlay stiline Anahtar Kare ekleme 

Görsel 3.23: Gradient Editörü 

Görsel 3.24: Gradient Editörü 



 

 

101 

 

 

Dördüncü Anahtar Kare’yi oluşturunuz. 

13. Space tuşuna basarak animasyonu izleyiniz ve proje dosyasını kaydediniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“UYGULAMA_231” adında proje oluşturuldu.   

“GORSELEFEKTDERSI” klasöründe bulunan “231” numaralı 
dosyadaki materyaller projeye aktarıldı. 

  

İstenen özelliklerde bir kompozisyon oluşturuldu.   

Materyaller kompozisyona eklendi.   

İstenen özelliklerde bir Solid katman oluşturuldu.   

Solid katmana Gradient Overlay stili eklendi.   

Gradient Editor açıldı. Gradient’in başlangıç ve bitiş renkleri 
seçildi. 

  

Solid katmanın Transform özelliğinde Opacity değeri, “50” olarak 
belirlendi. 

  

Edit Gradient seçilerek Gradient Editör açıldı. Renk aralığı 
ayarlandı. Geçerli Zaman Göstergesi 1. saniyeye taşındı. 

  

Gradient Overlay özelliğinin Color parametresine 1. Anahtar 
Kare eklendi. Geçerli Zaman Göstergesi 2. saniyeye taşındı. 

  

Edit Gradient seçilerek Gradient bitiş rengi değiştirildi. OK 
düğmesine tıklanarak ikinci Anahtar Kare eklendi. 

  

Geçerli Zaman Göstergesi 3. saniyeye taşındı.   

Edit Gradient seçilerek Gradient bitiş rengi değiştirildi. OK 
düğmesine tıklanarak üçüncü Anahtar Kare eklendi. 

  

Geçerli Zaman Göstergesi 4. saniyeye taşındı.   

Edit Gradient seçilerek Gradient bitiş rengi değiştirildi. OK 
düğmesine tıklanarak dördüncü Anahtar Kare eklendi. 

  

Animasyonun ön izlemesi yapıldı. Proje dosyası kaydedildi.   

 

Görsel 3.25: Gradient Editörü 
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İşlem Basamakları 

1. “UYGULAMA_232” adında bir proje dosyası oluşturunuz. 

2. “GORSELEFEKTDERSI” klasöründe bulunan “232” numaralı dosyadaki materyalleri 
projeye aktarınız. 

3. Aşağıda belirtilen özelliklerde bir kompozisyon oluşturunuz. 

Name (Adı): Uygulama32 

Width (Genişlik): 1920 – Hight (Yükseklik): 1080  

Frame Rate (Kare Hızı): 60 

Duration (Süre): 5 sn  

Background Color (Arka Plan Rengi): Siyah  

4. Materyalleri kompozisyona ekleyiniz (Görsel 3.27).  

 

 

 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
UYGULAMA 
YAPRAĞI 2 

KONU 
KATMANLARA KARIŞIM MODU EKLEME  

ANİMASYONU  

Görsel 3.26: Uygulama tamamlandığında oluşan animasyonun Sahne’deki görünümü 

Görsel 3.27: Kompozisyona eklenen materyaller 
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5. Katmanların adını değiştiriniz. “Kor” katmanını “Köz” katmanının ortasına yerleşecek 
oranda küçültünüz (Görsel 3.28).  

 

 

6. Katman panelinde modlar kapalıysa  düğmesine basarak 
açınız. “Kor” katmanına Add modu ekleyiniz (Görsel 3.29). 

 

 

7. Space tuşuna basarak ön izleme yapınız. 

8. Proje dosyasını kaydediniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“UYGULAMA_232” adında bir proje oluşturuldu.   

“GORSELEFEKTDERSI” klasöründe bulunan “232” numaralı 
dosyadaki materyaller projeye aktarıldı. 

  

İstenen özelliklerde bir kompozisyon oluşturuldu.   

Materyaller kompozisyona eklendi.   

Katman ismi değiştirildi.   

“Kor” katmanının boyutu değiştirildi.   

“Kor” katmanına Add modu eklendi.   

Animasyonun ön izlemesi yapıldı.   

Proje dosyası kaydedildi.   

 

Görsel 3.28: “Kor” katmanının boyutlarının küçültülmesi 

Görsel 3.29: “Köz” katmanına Add modu ekleme 
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ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
BİLGİ YAPRAĞI 

KONU 4. ZAMAN CETVELİ (TIME RULER) 

 

Zaman Cetveli, kompozisyonun ve katmanların sürelerini gösteren bir paneldir. Süre çubuklarına 
anahtar kareler eklenerek nesnelere hareket verilmesi işlemi, Anahtar Kareler konusunda anlatıldı. Bu 
başlık altında ise Zaman Cetveli’nin işlevleri ve süre ayarları anlatılacaktır.  

4.1. Zaman Cetvelinin İşlevleri 

 

A. Zaman Gezgini Çubuğu 

B. Zaman Cetveli 

C. Çalışma Alanı (Kompozisyon) Süre Çubuğu 

D. Katman Süre Çubuğu 

E. Kompozisyon İşaretleyici (Marker) Bölmesi 

F. Kompozisyona Dönme Simgesi 

G. Zaman Cetveli Zoom Kaydırıcı 

 

A) Zaman Gezgini Çubuğu, Çalışma Alanı’nı yakınlaştırarak kare kare çalışılmasını sağlar. Zaman 
Gezgini Çubuğu, başından veya sonundan tutulup sürüklenerek istenen alanda yakınlaştırma yapılır 
(Görsel 4.2). 

 

 

B) Kompozisyonun süresini gösterir. Her kompozisyon için ayrı Zaman Cetveli oluşur. 

C) Çalışma Alanı Süre Çubuğu, kompozisyonun oluşturulacak bölümünü gösterir. Kompozisyon 
üzerinde çalışılırken sadece bir kısmının oluşturulması istenirse Zaman Cetveli’nin bir bölümü Çalışma 
Alanı olarak belirlenir. Çalışma Alanı, iki farklı yolla ayarlanabilir: 

Görsel 4.1: Zaman Cetveli paneli 

Görsel 4.2: Zaman Gezgini çubuğu 
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1. Yol: Süre Çubuğu, başından veya sonundan tutularak sürüklenir (Görsel 4.3).  

 

 

2. Yol: Başı ayarlamak için B, sonu ayarlamak için N tuşuna basılır. Bu işlemlerin 
yapılabilmesi için Geçerli Zaman Göstergesi’nin kesilmek istenen süreye taşınması 
gerekir. 

Yeni oluşturulan Çalışma Alanı, render (çıktı) alındığında oluşturulacak alandır. 

Zaman Cetveli'ni yeni oluşan Çalışma Alanı Süre Çubuğu’na göre ayarlamak için Çalışma Alanı 
Süre Çubuğu üzerinde farenin sağ tuşuna tıklanır. Açılan listede Trim Comp to Work Area seçilir (Görsel 
4.4). 

 

 

D) Katman süresini gösterir. Her katmanın kendine ait bir süre çubuğu oluşur. 

E) Kompozisyonun belli noktalarına dikkat çekmek için işaretler koymak gerekebilir. Marker 
tıklandığında beliren işaret numarası, sürüklenerek işaretlenecek noktaya taşınır (Görsel 4.5). 

 

 

Marker’ı silmek için Marker numarasının yanında oluşan simge üzerine fareyle gelinir. Çift yönlü 
ok çıktığında, farenin sağ tuşuna tıklanır.Bir liste açılır (Görsel 4.6). Açılan listeden Delete This Marker 
seçilir. Tüm Marker’ları silmek için Delete All Markers seçilir.  

 

Görsel 4.3: Çalışma Alanı Süre Çubuğu 

Görsel 4.4: Çalışma Alanı ayar menüsü 

Görsel 4.5: Marker (işaret) ekleme 

Görsel 4.6: Marker ayarlama penceresi 



 

 

106 

 

F) Kompozisyon panelinin yanında, katman resimleri açıldığında görünen simgeye tıklanarak 
kompozisyon Sahne’sine geri dönülür (Görsel 4.7). 

 

 

G) Zaman Kaydırıcı, Zaman Cetveli’ni yakınlaştırıp uzaklaştırmak için kullanılır. Kaydırma 
düğmesi seçilir ve küçültmek için sola, büyütmek için sağa doğru sürüklenir. Uzun süresi olan videoları 
kabaca yakınlaştırıp uzaklaştırmada kullanılır. Detaylı çalışmalar için Zaman Gezgini Çubuğu kullanılır. 

Yakınlaşma ve uzaklaşma işlemi, Zaman Cetveli seçiliyken fare tekerleğinin ileri geri 
sürüklenmesiyle de yapılabilir. 

4.2. Katman Sürelerini Ayarlama 

Projeye eklenen her kompozisyonun kendine ait bir Zaman Cetveli vardır. Zaman Cetveli’nin 
boyu, kompozisyon oluşturulurken belirlenen süre kadardır.   

Projeye aktarılan (import) fotoğrafların ve Çalışma Alanı’nda oluşturulan katmanların (Text, 
Shape, Null, Camera vb.) süreleri, kompozisyon süresi kadar olur. 

Projeye aktarılan materyallerin kendilerine ait süreleri var ise (video ve ses dosyaları) ve bu süre 
kompozisyonun süresinden kısa ise kendi süreleri için bir Süre Çubuğu oluşur (Görsel 4.8). 

 

 

Yukarıdaki görselde “20” saniye uzunluğunda bir kompozisyona “8 sn 12 kare” uzunluğunda bir 
video eklendiğinde Zaman Cetveli’nde videonun kendi süresi uzunluğunda bir Süre Çubuğu oluşur. 

Kompozisyona eklenen materyalin süresi kompozisyonun süresinden uzun ise Zaman 
Cetveli’nde oluşan Süre Çubuğu, kompozisyon süresi kadardır (Görsel 4.9).  

 

 

 

 

Görsel 4.7: Kompozisyon Sahnesi(Comp 1) ve Footage Sahnesi 

Görsel 4.8: Proje panelinde katman süresi ve Zaman Cetveli’nde oluşan katmanın Süre Çubuğu 
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Yukarıdaki görselde 5 saniye uzunluğundaki kompozisyona 41 saniye uzunluğunda bir video 
eklendiğinde video katmanına ait Süre Çubuğu, kompozisyonun süresi kadardır. Videonun ilk 5 saniyesi 
kompozisyona eklenir.  

Ancak Video katmanına ait Süre Çubuğu sağdan sola doğru çekildiğinde, çekildiği süre kadar 
görüntü başından kırpılır ve devamındaki görüntü Süre Çubuğu’na eklenir (Görsel 4.10). 

 

 

Katman Süresini Kesmek 

Katmanın sadece belirli bir bölümünün görünmesi istendiğinde, katman süresi kesilerek sadece 
istenen alan bırakılır.  

Aşağıdaki zaman cetvelinde video katmanının 2. ve 3. saniyeleri arasındaki bölümün 
kompozisyonda görünmesi istendiğinde Geçerli Zaman Göstergesi, 2. saniyeye getirilir. Video, 
Ctrl+Shift+D tuşlarına basılarak kesilir (Görsel 4.11).  

 

 

Geçerli Zaman Göstergesi daha sonra 3. saniyeye getirilir. Yine Control+Shift+D tuşlarına 
basılarak video kesilir (Görsel 4.12). 

 

 

 

Görsel 4.9: Proje panelinde katman süresi ve Zaman Cetveli’nde oluşan katmanın Süre Çubuğu 

Görsel 4.10: Katman Süre Çubuğu sola doğru çekildiğinde baştaki görüntüler gider,  
ardında bulunan görüntüler Sahne’ye gelir. 

Görsel 4.11: Süre Çubuğu’nda süreyi kesme 
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Katman Süresini Silmek 

Süre Çubuğu’nda, kesilen uzunlukta yeni bir katman oluşur. Kesme işlemi tamamlandığında 
Katman panelinde üç katman ve Zaman Cetveli’nde de bu katmanlara ait üç Süre Çubuğu oluşur. “0 – 2” 
saniye aralığındaki Süre Çubuğu seçilerek Delete tuşuna basılır. Daha sonra “3 – 5” saniye aralığındaki 
Süre Çubuğu seçilir ve Delete tuşuna basılır (Görsel 4.13).  

 

 

İstenen zaman aralığı, Süre Çubuğu’nda kalır (Görsel 4.14). 

 

 

Bu Süre Çubuğu, tutulup sürüklenerek istenen yere taşınabilir (Görsel 4.15). 

 

 

Videonun süresini kırpmanın başka bir yolu da Süre Çubuğu’nun başından ve sonundan tutularak 
istenen süreye sürüklenmesidir (Görsel 4.16). Ancak burada dikkat edilmesi gereken bir nokta vardır: 

 

 

 

Görsel 4.12: Süre Çubuğu’nda süreyi kesme 

Görsel 4.13: Süre Çubuğu’nu silme 

Görsel 4.14: Zaman Cetveli’nde başı ve sonu kesilmiş Süre Çubuğu’nun görünümü 

Görsel 4.15: Süre Çubuğu’nu Zaman Cetveli’nin başına taşıma 
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Bitiş noktasında sürüklenerek kırpma işlemi yapılacaksa eklenen materyalin orijinal süresinin 
uzunluğu önemlidir. Bu süre, kompozisyon süresinden uzunsa bitiş noktasından sürüklendiğinde Süre 
Çubuğu’nda kırpma yapmaz. Süre Çubuğu’nu sola doğru iter. Bu nedenle burada kesme yapılması 
gerekir. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Görsel 4.16: Süre Çubuğu’nun, başından tutulup sağa doğru sürüklenerek kırpılması 
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İşlem Basamakları 

1. “UYGULAMA_241” adında bir proje dosyası oluşturunuz. 

2. “GORSELEFEKTDERSI” klasöründe bulunan “241” numaralı dosyadaki video dosyasını, 
projeye aktarınız. 

3. Aşağıda belirtilen özelliklerde bir kompozisyon oluşturunuz. 

Name (Adı): Uygulama41 

Width (Genişlik): 1920 – Hight (Yükseklik): 1080  

Frame Rate (Kare Hızı): 60 

Duration (Süre): 05 sn  

Background Color (Arka Plan Rengi): Siyah   

4. Kompozisyon ölçülerinde “Siyah” isimli bir Solid katman oluşturunuz. 

5. Kompozisyon ölçülerinde “Beyaz” isimli bir Solid katman oluşturunuz. 

6. Fotoğrafı kompozisyona ekleyiniz. Katman üzerinde farenin sağ tuşuna tıklayarak açılan 
listeden Trasform > Fit to Comp özelliğini seçiniz. Fotoğrafı Sahne’ye yerleştiriniz. 
Katman adını “Sporcu” olarak değiştiriniz (Görsel 4.18). 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
UYGULAMA 
YAPRAĞI 1 

KONU KATMANLARIN SÜRESİNİ AYARLAMA UYGULAMASI 

Görsel 4.17: Uygulama tamamlandığında oluşan animasyonun farklı sürelerdeki görünümü 

Görsel 4.18: Katman panelinde ve Sahne’de oluşan görüntü 
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7. “Sporcu” katmanını, Katman panelinde en alta taşıyınız. 

8. Geçerli Zaman Göstergesi’ni 1. saniyeye taşıyınız. Zaman Cetveli’nde “Beyaz” Solid 
katmanı ve “Siyah” Solid katmanı seçiniz. Ctrl+Shift+D tuşlarına basarak her iki katmanı 
da 1. saniyeden kesiniz (Görsel 4.19). 

 

 

9. Yeni oluşan 1 ve 3 numaralı katmanları siliniz (Görsel 4.20). 

 

 

10. “Beyaz” Solid katmanın Süre Çubuğu’nu tutarak sürükleyiniz ve 4. saniye ile 5. saniye 
arasına bırakınız (Görsel 4.21). 

 

 

11. “Beyaz” Solid katmanı seçiniz. Geçerli Zaman Göstergesi’ni 4. saniyeye (Süre 
Çubuğu’nun başına) getiriniz. Solid katmanın Transform özelliğinden Opacity değerini 
“0” (sıfır) olarak belirleyiniz (Görsel 4.22). Kronometre simgesine tıklayınız ve 4. saniyeye 
bir Anahtar Kare ekleyiniz. 

 

 

12. Geçerli Zaman Göstergesi’ni 5. saniyeye taşıyınız. Opacity değerini “100” olarak 
belirleyiniz ve ikinci Anahtar Kare’yi ekleyiniz (Görsel 4.23). 

Görsel 4.19: “Beyaz” ve “Siyah” Solid katmanların seçilerek Süre Çubukları’nın kesilmesi 

Görsel 4.20: Süre Çubukları kesildiğinde, kesilen süreler yeni birer katman oluşturur. 

Görsel 4.21: “Beyaz” katmanının Süre Çubuğu, Zaman Cetveli’nin sonuna taşınır. 

Görsel 4.22: “Beyaz” katmanının Transform özelliğinden Opacity değerinin değiştirilmesi 
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13. “Siyah” Solid katmanı seçiniz. Geçerli Zaman Göstergesi’ni Zaman Cetveli’nin en başına 
getiriniz. Solid katmanın Transform özelliğinden Opacity değerini “100” olarak 
belirleyiniz (Görsel 4.24). Kronometre simgesine tıklayarak “0” (sıfır) saniyeye bir 
Anahtar Kare ekleyiniz. 

 

 

14. Geçerli Zaman Göstergesi’ni 1. saniyeye taşıyınız. Opacity değerini “0” (sıfır) olarak 
belirleyiniz ve ikinci Anahtar Kare’yi ekleyiniz (Görsel 4.25). 

 

 

15. “Weight: 1800”, “Height: 300” değerlerinde olan ve mürdüm renginde, “Altbant” isimli 
bir Solid katman oluşturunuz. 

16. “Altbant” katmanının Transform özelliğinde Opacity değerini, “40” olarak belirleyiniz.  

17. “Altbant” katmanını, Sahne’de istediğiniz yere taşıyınız. 

18. Araç çubuğundan Text Tool’u seçiniz. Sahne’ye “ASLA VAZGEÇME” yazınız. Yazının Solid 
katman üzerindeki konumunu ayarlayınız. 

19. Character panelinde yazının rengini, fontunu ve boyutunu ayarlayınız. 

20. Zaman Cetveli’nde “Altbant” katmanını ve Yazı katmanını Süre Çubukları’ndan kırparak 
1. ve 4. saniyeler arasında görünecek şekilde ayarlayınız (Görsel 4.26).  

 

 

21. Geçerli Zaman Göstergesi’ni 1. saniyeye getiriniz. “Altbant”ı Sahne’nin solundan dışarı 
taşıyınız. 

Görsel 4.23: “Beyaz” katmanının Transform özelliğinden Opacity değerinin değiştirilmesi 

Görsel 4.24: “Siyah” katmanının Transform özelliğinden Opacity değerinin değiştirilmesi 

Görsel 4.25: “Siyah” katmanının Transform özelliğinden Opacity değerinin değiştirilmesi 

Görsel 4.26: Altbant ve Yazı katmanlarına ait Süre Çubukları’nın ayarlanması 
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22. “Altbant” katmanının Transform > Position değerindeki Kronometre simgesine tıklayınız 
ve birinci Anahtar Kare’yi ekleyiniz (Görsel 4.27). 

23. Geçerli Zaman Göstergesi’ni “1:30” noktasına taşıyınız. “Altbant” katmanını Sahne’de 
durmasını istediğiniz konuma taşıyınız ve ikinci Anahtar Kare’yi ekleyiniz (Görsel 4.27). 

24. Geçerli Zaman Göstergesi’ni “3:30” noktasına taşıyınız. Anahtar Kare ekleme simgesine 
tıklayınız ve üçüncü Anahtar Kare’yi ekleyiniz (Görsel 4.27). 

25. Geçerli Zaman Göstergesi’ni 4. saniyeye taşıyınız. “Altbant” katmanını Sahne’nin 
sağından dışarı taşıyınız ve dördüncü Anahtar Kare’yi ekleyiniz (Görsel 4.27). 

 

 

26. Yazı katmanına ait Süre Çubuğu’nun başlangıcını “1:30” noktasına, bitişini ise “3:30” 
noktasına getiriniz (Görsel 4.28). 

 

 

27. 0 (sıfır) tuşuna basarak animasyonun ön izlemesini yapınız.  

28. Proje dosyasını kaydediniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“UYGULAMA_241” adında bir proje oluşturuldu.   

“GORSELEFEKTDERSI” klasöründe bulunan “241” numaralı 
dosyadaki materyaller projeye aktarıldı. 

  

Görsel 4.27: Altbant katmanının Position değerine Anahtar Kare ekleme 

Görsel 4.28: Yazı katmanına ait Süre Çubuğu’nun başından ve sonundan sürüklenerek sürenin ayarlanması 
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İstenen özelliklerde bir kompozisyon oluşturuldu.   

Kompozisyon ölçülerinde “Siyah” isimli bir Solid katman 
oluşturuldu. 

  

Kompozisyon ölçülerinde “Beyaz” isimli bir Solid katman 
oluşturuldu. 

  

Fotoğraf kompozisyona eklendi.    

Fotoğraf Sahne’ye yerleştirildi.   

Katman adı “Sporcu” olarak değiştirildi.   

“Sporcu” katmanı, Katman panelinde en alta taşındı.   

Geçerli Zaman Göstergesi 1. saniyeye taşındı. “Beyaz” Solid 
katman ve “Siyah” Solid katman, 1. saniyelerinde kesildi.  

  

1 ve 3 numaralı katmanlar silindi.   

“Beyaz” Solid katman, 4. saniye ile 5. saniye arasına taşındı.   

Geçerli Zaman Göstergesi 4. saniyeye taşındı.     

“Beyaz” Solid katmanın Opacity değeri “0” (sıfır) olarak belirlendi. 
Anahtar Kare eklendi. 

  

Geçerli zaman Göstergesi 5. saniyeye taşındı.     

“Beyaz” Solid katmanın Opacity değeri “100” olarak belirlendi.   

Geçerli Zaman Göstergesi, Zaman Cetveli’nin en başına getirildi. 
“Siyah” Solid katman seçildi. 

  

“Siyah” Solid katmanın Opacity değeri “100” olarak belirlendi. 
Kronometre simgesine tıklandı. Anahtar Kare eklendi. 

  

Geçerli Zaman Göstergesi 1. saniyeye taşındı.  “Siyah” Solid 
katmanın Opacity değeri “0” (sıfır) olarak belirlendi. 

  

İstenen özelliklerde bir Solid katman oluşturuldu.    

“Altbant” katmanının Opacity değeri “40” olarak belirlendi.   

“Altbant” katmanı, Sahne’de istenen yere konumlandırıldı.   

Araç çubuğundan Text Tool seçilerek Sahne’de “ASLA 
VAZGEÇME” yazıldı.  

  

Sahne’de Yazı katmanının konumu ayarlandı.   

Yazının rengi, fontu ve boyutu ayarlandı.   

“Altbant” ve Yazı katmanları, Süre Çubukları’ndan kırpılarak 1. ve 
4. saniyeler arasında görünecek şekilde ayarlandı. 

  

Geçerli Zaman Göstergesi 1. saniyeye getirildi. Arka Plan 
katmanı, Sahne’nin solundan dışarı taşındı. 

  

“Altbant” katmanının Position değerine birinci Anahtar Kare 
eklendi. 

  

Geçerli Zaman Göstergesi “1:30” noktasına taşındı.    

“Altbant” katmanı, Sahne’de durması istenen konuma taşındı.  
İkinci Anahtar Kare eklendi. 
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Geçerli Zaman Göstergesi “3:30” noktasına taşındı. Anahtar Kare 
ekleme simgesine tıklandı ve üçüncü Anahtar Kare eklendi. 

  

Geçerli Zaman Göstergesi 4. saniyeye taşındı. Arka Plan katmanı, 
Sahne’nin solundan dışarı taşındı ve dördüncü Anahtar Kare 
eklendi. 

  

Yazı katmanına ait Süre Çubuğu’nun başlangıcı “1:30” noktasına, 
bitişi ise “3:30” noktasına getirildi. 

  

0 (sıfır) tuşuna basılarak kompozisyon izlendi.   

Proje dosyası kaydedildi.   
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İşlem Basamakları 

1. “UYGULAMA_242” adında bir proje dosyası oluşturunuz. 

2. “GORSELEFEKTDERSI” klasöründe bulunan “442” numaralı dosyadaki videoyu projeye 
aktarınız. 

3. Projeye eklenen videonun özelliklerinde bir kompozisyon oluşturunuz (Projeye eklenen 
videoyu tutup sürükleyerek Kompozisyon simgesinin üzerine bırakınız.). 

4. Katmanın ismini “Göl” olarak değiştiriniz. 

5. Geçerli Zaman Göstergesi’ni 2. saniyeye taşıyınız. “Göl” katmanını seçiniz. Ctrl+Shift+D 
tuşlarına basarak Süre Çubuğu’nu kesiniz (Görsel 4.30).  

 

 

6. “Göl” katmanını siliniz.  

7. Süre Çubuğu’nu tutup sürükleyerek “Göl 2” katmanını Zaman Cetveli’nin başına 
taşıyınız. Kompozisyonun Süre Çubuğu’nu sonundan tutup sağa doğru sürükleyerek “Göl 
2” katmanının Süre Çubuğu’yla aynı süreye getiriniz (Görsel 4.31). 

 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
UYGULAMA 
YAPRAĞI 2 

KONU VİDEOYU GERİYE OYNATMA UYGULAMASI 

Görsel 4.29: Uygulama tamamlandığında oluşan animasyonun farklı sürelerdeki görünümü 

Görsel 4.30: “Göl” katmanına ait Süre Çubuğu’nun kesilmesi 
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8. Çalışma Alanı Süre Çubuğu’na farenin sağ tuşuyla tıklayınız. Trim Comp to Work Area 
özelliğini seçiniz (Görsel 4.32).  

 

 

9. Süre Çubuğu’nda “Göl 2” katmanına farenin sağ tuşuyla tıklayınız. Açılan menüden Time 
> Time-Reverse Layer’ı seçiniz (Layer menüsü) (Görsel 4.33). “Göl 2” katmanındaki 
video, geriye doğru oynatılacaktır. 

 

 

10. Space tuşuna basarak animasyonu izleyiniz. 

11. Proje dosyasını kaydediniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“UYGULAMA_242” adında bir proje oluşturuldu.   

“GORSELEFEKTDERSI” klasöründe bulunan “242” numaralı 
dosyadaki materyaller projeye aktarıldı. 

  

İstenen özelliklerde bir kompozisyon oluşturuldu.   

Katman ismi değiştirildi.   

Görsel 4.31: Çalışma Alanı süresini “Göl 2” katmanının Süre Çubuğu’yla eşitleme 

Görsel 4.32: Zaman Cetveli’nin Çalışma Alanı uzunluğuna göre ayarlanması 

Görsel 4.33: Layer katmanında Time özelliği menüsü 
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Geçerli Zaman Göstergesi 2. saniyeye taşındı. “Göl” katmanının 
Süre Çubuğu kesildi.  

  

“Göl” katmanı silindi.   

“Göl 2” katmanı, Zaman Cetveli’nin başına taşındı.   

Kompozisyonun Süre Çubuğu, “Göl 2” katmanının Süre 
Çubuğu’yla aynı süreye getirildi. 

  

“Göl 2” katmanına “geriye oynatma” özelliği eklendi.   

Space tuşuna basılarak kompozisyon izlendi.   

Proje dosyası kaydedildi.   
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ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
BİLGİ YAPRAĞI 

KONU 5. YAZI OLUŞTURMA 

 

Görsel efekt programında karakter düzenleme araçları, yazı animatörleri ve yazı efektleri 
kullanılarak “etkileyici yazı animasyonları” oluşturulur.   

Yoğun olarak yazı ile çalışılacağı zaman “yazı hazırlama öncelikli” panellerin bulunduğu Text 
Çalışma Alanı kullanılır. Text Çalışma Alanı’nı açmak için Menü çubuğundan Windows > Workspace 
>Text seçeneği ile Çalışma Alanı seçilir.  

Mevcut Çalışma Alanları’nda yazı hazırlamak istendiğinde ise Menü çubuğundan Windows>  

Character ve Paragraph panelleri seçilerek Çalışma Alanı’na eklenir (Görsel 5.1, Görsel 5.2). 

 

 

 

 

 

 

Görsel 5.1: Character (Karakter) Paneli simgelerinin açıklamaları 

Görsel 5.2: Paragraph paneli simgelerinin açıklamaları 
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5.1. Kompozisyona Yazı Ekleme 

Projeye Import seçeneğiyle aktarılan yazılar ve Çalışma Alanı’nda oluşturulan yazılar 
kompozisyona eklenir. Çalışma Alanı’nda yazı oluşturmanın birkaç farklı yolu vardır:  

1. Yol: Metin oluşturmak için Araç çubuğundan Yazı aracı (T) seçilir. 

2. Yol: Ctrl+T tuşlarına basılır. 

3. Yol: Layer > New > Text seçilir. 

4. Yol: Katman paneline farenin sağ tuşuyla tıklandığında açılan listeden New > Text seçilir.  

Yazı aracı seçildikten sonra Sahne’ye bir kez tıklanarak imleç yerleştirilir ve yazı yazılır. Yazı 
özellikleri, Character panelinden değiştirilir (Görsel 5.3). 

 

5.2. Yazı Katmanı ve Özellikleri 

Görsel 5.3: Paragraf ve Karakter panellerinden yazı özelliklerini ayarlama 

Görsel 5.4: Text katmanının özellikleri 
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Sahne’ye yazı yazıldığında Katman panelinde Yazı katmanı oluşur. Katman panelinde Yazı 
katmanının yanındaki Ok işaretine tıklanarak katman parametreleri açılır.  Yazı katmanları, Dönüştürme 
(Transform) özelliğine ek olarak Text özelliğine de sahiptir (Görsel 5.4). 

5.2.1. Text Özelliği  

Text açılır menüsünün solundaki Ok işaretine tıklanarak Text parametreleri açılır. 

Source: Source parametresi, kaynak yazının karakterlerini kapsar. Kaynak yazıdaki harfler, 
animasyonun belli zaman aralığında Source parametresinden değiştirilebilir. 

Path Options: Yazıya bir yol belirleme seçeneğidir. Kompozisyon alanında bir yol çizerek yazının 
bu yol üzerinde hareket etmesini sağlar. 

Path düğmesinin altında “yazının yolu nasıl takip edeceğiyle ilgili seçenekler” bulunur.  

More Options: Yukarıda yapılan seçimlerden daha farklı seçenekler bulunur. Örneğin Anchor 
Point Grouping seçeneğinin yanındaki seçim listesi açıldığında yazı harflerinin teker teker ya da 
tamamının seçilmesi yöntemiyle, “aynı yol üzerindeki oturma şekilleri” değiştirilebilir.  

 

! Konuyla ilgili örnek uygulama, konu sonunda “UYGULAMA 1” de yapılmıştır. 

5.2.2. Text Animate Özelliği  

Animate özelliği, Text özelliğinin sağında bulunur (Görsel 5.5). Animate menüsünde yazı 
karakterlerinin fiziksel özelliklerinde değişiklikler yapılmasını sağlayan birçok farklı özellik bulunur. Çok 
karışık olan karakter animasyonları, Text Animate özelliği sayesinde Anahtar Kareler eklenerek kolayca 
yapılır. 

 

 
Görsel 5.5: Text Animate menüsü 
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Animate listesinden istenen özellik seçilerek katmana eklenir. Text özelliğinin altına Animator 1 
adında yeni bir özellik eklenir (Görsel 5.6). Animatörler eklendikçe “Animator 1, Animator 2, …” şeklinde 
sıralanır. Eklenen animatörler, özelliklerine göre farklı parametrelere sahiptir. Parametrelere Anahtar 
Kareler eklenerek animasyonlar oluşturulur.  

 

 

“Animator 1”in sağında bulunan Add özelliği yoluyla Animatör’e yeni özellikler de eklenebilir 
(Görsel 5.7). 

 

5.2.3. Transform Özelliği  

Transform özelliği; standart tüm katmanlarda olan Position, Scale, Rotation ve Opacity 
parametreleridir.  

 

 

Görsel 5.6: Yazı katmanına Animate menüsünden Animatör ekleme 

Görsel 5.7: Yazı katmanı Add menüsü 
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5.3. Hazır Yazı Animasyonu Ekleme 

Hazır yazı animasyonu, Yazı katmanına Effects & Presets panelinden eklenir. Çalışma Alanı’nda 
Effects & Presets paneli açık değilse Windows > Effects & Presets seçilir.  

Effects & Presets panelinden Animation Presets > Text seçilir (Görsel 5.8). 

Açılan listeden “animasyon hazır ayarı” seçilir. Text klasörünün altında bulunan alt klasörlerin 
her birinde onlarca hazır animasyon bulunur.  

Örnek olarak “Animate In” klasöründen hazır yazı animasyonunun eklenmesi:  

 

 

Animasyonların her birinin katmana eklenerek animasyonun etkisinin izlenmesi, oldukça zordur. 
Burada bulunan animasyonların ön izlemesinin yapılması için;  

Menü çubuğunda bulunan Animation / Browse Presets seçimi yapılır (Görsel 5.9). 

 

Görsel 5.8: Hazır yazı animasyonunun eklenmesi 

Görsel 5.9: Menü çubuğunda Animation menüsü 
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Yeni bir arayüz ekranı açılır.  

Bu ekranda Text klasörü seçilir (Görsel 5.10). 

 

 

Açılan sayfada Animate In klasörü seçilir (Görsel 5.11). 

 

 

Aşağıdaki içerik ve ön izleme sayfası ekrana gelir. İçerik panelinden bir içerik tıklanır ve ön izleme 
ekranında animasyonun yazı üzerindeki etkisi izlenir (Görsel 5.12).  

 

 

 

 

Görsel 5.10: Animation menüsünde bulunan Browse Presets listesindeki Text klasörü 

Görsel 5.11: Text klasöründen Animate In “hazır yazı animasyonu”nun seçilmesi 

Görsel 5.12: Animate In “hazır yazı animasyonu”nun ön izleme penceresi 
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Yazıya eklenmek istenen animasyona çift tıklanır. Animasyon, Katman panelinde seçili olan Yazı 
katmanına eklenir (Görsel 5.13). 

 

 

Animate In eklendikten sonra Zaman Çizelgesi incelendiğinde;  

Yazı katmanının Text özelliğinin altına Spiral ve Fade In efektlerinin eklendiği görülür (Görsel 
5.14). 

 

 

Zaman Cetveli’nde Spiral ve Fade In efektlerine farklı zaman aralıklarında Anahtar Kareler 
eklendiği görülür (Görsel 5.15). 

 

 

Hazır yazı animasyonunun parametre değerleri ve Zaman Cetveli’nde Anahtar Kareler’in yerleri 
değiştirilerek animasyon yeniden düzenlenebilir. 

 

Görsel 5.13: Animate In “hazır animasyonu”nun Yazı katmanına etkisi 

Görsel 5.14: Text özelliğinin altına Animate In animasyonu için eklenen efektler 

Görsel 5.15: Animate In efektinin oluşturduğu Anahtar Kareler 
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İşlem Basamakları 

1. “UYGULAMA_251” isminde bir proje oluşturunuz. 

2. Aşağıda belirtilen özelliklerde bir kompozisyon oluşturunuz. 

Name (Adı): Uygulama51 

Width (Genişlik): 1920 - Height (Yükseklik): 1080  

Frame Rate (Kare Hızı): 60 

Duration (Süre): 5sn  

Background Color(Arka Plan Rengi): Siyah  

3. “1200 x 800” çözünürlüğünde beyaz renkli bir Solid katman oluşturunuz (Görsel 5.17). 

 

 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
UYGULAMA 
YAPRAĞI 1 

KONU 
YAZI KATMANININ “SOURCE TEXT” ÖZELLİĞİ İLE 

ANİMASYON HAZIRLAMA 

Görsel 5.16: Uygulama tamamlandığında oluşan animasyonun farklı sürelerdeki görünümü 

Görsel 5.17: Solid katman ekleme 

 
http://kitap.
eba.gov.tr/K
odSor.php?K
OD=20888 

http://kitap.eba.gov.tr/KodSor.php?KOD=20888
http://kitap.eba.gov.tr/KodSor.php?KOD=20888
http://kitap.eba.gov.tr/KodSor.php?KOD=20888
http://kitap.eba.gov.tr/KodSor.php?KOD=20888
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4. Araç çubuğundan Yazı aracını seçiniz. “ILKBAHAR” yazınız. Böylece Katman panelinde 
Yazı katmanı oluşur (Görsel 5.18). 

 

 

Yazıyı Solid katmanın orta noktasına yerleştirmek için Align panelini kullanınız. Align paneli 
Çalışma Alanı’nda açık değilse Windows > Align özelliğini seçerek Çalışma Alanı’na getiriniz. 
Yazı seçiliyken “ortalama” işaretlerini seçerek yazıyı ortalayınız (Görsel 5.19, Görsel 5.20). 

 

 

 

5. Yazı katmanının yanındaki Ok işaretine tıklayarak Text özelliklerini açınız. Source Text 
parametresinin Kronometre özelliğini seçerek animasyonun başlangıç noktasına bir 
Anahtar Kare ekleyiniz (Görsel 5.21). 

 

 

 

Görsel 5.18: Sahne’ye yazı ekleme 

Görsel 5.19: Align paneli kullanılarak Yazı katmanının Solid katmanda ortalanması 

Görsel 5.20: Yazı, Solid katmanda ortalanır. 
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6. Geçerli Zaman Göstergesi’ni 30. kareye taşıyınız (30f).  

Yazı aracını seçerek “İLKBAHAR” sözcüğünü siliniz ve “YAZ” sözcüğünü yazınız (Görsel 5.22). 

 

 

7. Geçerli Zaman Göstergesi’ni 1. saniyeye taşıyınız.  

Yazı aracını seçerek “YAZ” sözcüğünü siliniz ve “SONBAHAR” sözcüğünü yazınız (Görsel 5.23). 

 

 

 

Görsel 5.21: “İLKBAHAR” Yazı katmanının Source Text parametresine birinci Anahtar Kare eklenir. 

Görsel 5.22: Source Text’in (Kaynak Yazı-İLKBAHAR) değiştirilmesi 

Görsel 5.23: Source Text’in (Kaynak Yazı-YAZ ) değiştirilmesi 



 

 

129 

 

8. Geçerli Zaman Göstergesi’ni “1:30f” noktasına taşıyınız.  

Yazı aracını seçerek “SONBAHAR” sözcüğünü siliniz ve “KIŞ” sözcüğünü yazınız (Görsel 5.24). 

 

 

9. Sözcüklerin rengini değiştirmek için Anahtar Kareler’i üzerlerine tıklayarak seçiniz. 
(Anahtar Kareler’i seçmek için klavyede K ve J tuşlarını da kullanabilirsiniz.) 

10. İlk sözcüğün rengi değişmeyeceği için ikinci Anahtar Kare’yi seçiniz. Sahne’de “YAZ” 
sözcüğünü seçerek Character panelinden rengini değiştiriniz.  

11. Üçüncü Anahtar Kare’yi seçiniz. “SONBAHAR” sözcüğünü seçerek rengini değiştiriniz. 

12. Dördüncü Anahtar Kare’yi seçiniz. “KIŞ” sözcüğünü seçerek rengini değiştiriniz.  

13. Space tuşuna basarak ön izleme yapınız. 

14. Proje dosyasını kaydediniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“UYGULAMA_251” adında bir proje oluşturuldu.   

İstenen özelliklerde bir kompozisyon oluşturuldu.   

İstenen özelliklerde bir Solid katman oluşturuldu.   

Yazı aracı seçildi ve Sahne’ye “İLKBAHAR” yazıldı.   

Align panelinde yazı, Solid katmana ortalandı.   

Geçerli Zaman Göstergesi, Zaman Cetveli’nin başına taşındı.   

Katman panelinde Text > Source Text parametresine ait 
Kronometre tıklanarak ilk Anahtar Kare oluşturuldu. 

  

Geçerli Zaman Göstergesi 30. kareye taşındı. Sahne’ye “YAZ” 
sözcüğü yazıldı.  

  

Geçerli Zaman Göstergesi “1:00f” noktasına taşındı. Sahne’ye 
“SONBAHAR” sözcüğü yazıldı. 

  

Görsel 5.24: Source Text’in (Kaynak Yazı-SONBAHAR) değiştirilmesi 
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Geçerli Zaman Göstergesi “1:30f” noktasına taşındı. Sahne’ye 
“KIŞ” sözcüğü yazıldı. 

  

İkinci Anahtar Kare seçildi. Sahne’de “YAZ” sözcüğü seçilerek 
Character panelinden rengi değiştirildi. 

  

Üçüncü Anahtar Kare seçildi. Sahne’de “SONBAHAR” sözcüğü 
seçilerek Character panelinden rengi değiştirildi. 

  

Dördüncü Anahtar Kare seçildi. Sahne’de “KIŞ” sözcüğü seçilerek 
Character panelinden rengi değiştirildi. 

  

Animasyon, Boşluk tuşuna basılarak izlendi.   

Proje dosyası kaydedildi.   
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İşlem Basamakları 

1. “UYGULAMA_252” isimli projeyi açınız. 

2. “GORSELEFEKTDERSI/ 252” numaralı klasörde bulunan fotoğrafı projeye aktarınız. 

3. Aşağıda belirtilen özelliklerde bir kompozisyon oluşturunuz. 

Name (Adı): Uygulama52 

Width (Genişlik): 1920 – Height (Yükseklik): 1080  

Frame Rate (Kare Hızı): 60 

Duration (Süre): 5 sn  

Background Color (Arka Plan Rengi): Siyah  

4. Fotoğrafı kompozisyona ekleyiniz. 

5. Yazı aracını seçiniz.  Sahne’ye “SEYYAH” sözcüğünü yazınız (Görsel 5.26). 

 

 

 

 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
UYGULAMA 
YAPRAĞI 2 

KONU “TEXT ANIMATION” İLE ANİMASYON HAZIRLAMA 

Görsel 5.25: Uygulama tamamlandığında oluşan animasyonun farklı sürelerdeki görünümü 



 

 

132 

 

 

6. Yazının fontunu, büyüklüğünü, dolgu ve kenarlık rengini, kenarlığın etki edeceği alanı ve 
bu alanın büyüklüğünü Character (karakter) panelinden ayarlayınız (Görsel 5.27). 

 

 

7. Katman panelinden Yazı katmanının özelliklerini açınız. Text > Animate > Position 
özelliğini seçiniz. 

Text özelliğinin altına Animator 1 özelliği ekleyiniz (Görsel 5.28). 

 

 

8. Geçerli Zaman Göstergesi’ni, Zaman Cetveli’nin başına getiriniz. Position değeri “0” 
(sıfır) iken Kronometre’ye tıklayınız ve ilk Anahtar Kare’yi ekleyiniz (Görsel 5.29). 

 

Görsel 5.26: Sahne’ye “SEYYAH” sözcüğü eklenir. 

Görsel 5.27: “SEYYAH” sözcüğünün özellikleri ve Character panelinden değiştirildiğinde Sahne’deki görünümü 

Görsel 5.28: Yazı katmanına Animate menüsünden Position parametresi ekleme 

Görsel 5.29: Position parametresine ilk Anahtar Kare’nin eklenmesi 
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9. Geçerli Zaman Göstergesi’ni 1. saniyeye taşıyınız. Position parametresinin Y eksenindeki 
değerini “300” olarak belirleyiniz (Görsel 5.30). 

 

 

10. Range Selector 1 özelliğini yanındaki Ok işaretine tıklayarak açınız. Geçerli Zaman 
Göstergesi’ni Zaman Cetveli’nin başına taşıyınız. Offset değeri “0” (sıfır) iken 
Kronometre’ye tıklayınız ve Anahtar Kare ekleyiniz (Görsel 5.31).  

 

 

11. Geçerli Zaman Göstergesi’ni 1. saniyeye taşıyınız. Offset değerini “100” olarak 
belirleyiniz ve ikinci Anahtar Kare’yi ekleyiniz (Görsel 5.32). 

 

 

12. Animator 1’in sağında bulunan Add özelliğine tıklayınız. Açılan menüden Property > 
Opacity özelliğini seçiniz. 

Böylece Animator 1’in altına Opacity eklenir (Görsel 5.33). 

 

 

13. Opacity değerini “0” (sıfır) olarak belirleyiniz. 

14. Çalışma Alanı Süre Çubuğu’nu “01:10f” noktasında klavyeden N tuşuna basarak kesiniz. 
Farenin sağ tuşuna tıklayarak Trim Comp to Work Area özelliğini seçiniz (Görsel 5.34). 

 

 

 

Görsel 5.30: Position değeri değiştirilerek ikinci Anahtar Kare’nin eklenmesi 

Görsel 5.31: Range Selector 1 özelliğinin Offset değerine birinci Anahtar Kare’nin eklenmesi 

Görsel 5.32: Range Selector 1 özelliğinin Offset değerine ikinci Anahtar Kare’nin eklenmesi 

Görsel 5.33: Animator 1’e Add listesinden Opacity ekleme 
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15. Katman panelinde bulunan iki katmanı da seçiniz. Farenin sağ tuşuna tıklanarak açılan 
listeden Pre-compose özelliğini seçiniz (Görsel 5.35).  

 

 

Açılan Pre-Compose penceresinde New Composition Name kutusuna “SEYYAH” yazınız. OK 
düğmesine tıklayınız.  

Katman panelinde “01: 10” kare uzunluğunda “SEYYAH” isimli bir Pre-Composition oluşur.  

16. Space tuşuna basarak ön izleme yapınız.  

17. Proje dosyasını kaydediniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“UYGULAMA_252” adında bir proje oluşturuldu.   

“GORSELEFEKTDERSI 252” dosyasında bulunan fotoğraf projeye 
aktarıldı. 

  

İstenen özelliklerde bir kompozisyon oluşturuldu.   

Fotoğraf, kompozisyona eklendi.   

Yazı aracı seçildi ve Sahne’ye “SEYYAH” sözcüğü yazıldı.   

Yazı özellikleri, Character panelinden ayarlandı.   

Katman panelinden Yazı katmanının özellikleri açıldı. Text > 
Animate > Position özelliği seçildi. Text’in altına Animator 1 
eklendi. 

  

Geçerli Zaman Göstergesi, Zaman Cetveli’nin başına taşındı.   

Position değeri “0” (sıfır) iken Kronometre tıklanarak ilk Anahtar 
Kare oluşturuldu. 

  

Görsel 5.34: Çalışma Alanı Süre Çubuğu’nun “sağ tık” penceresi 

Görsel 5.35: Katman panelinde bulunan katmanlardan Pre-Compose oluşturma 
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Geçerli Zaman Göstergesi 1. saniyeye taşındı. Position 
parametresinin Y eksenindeki değeri “300” olarak belirlendi. 

  

Geçerli Zaman Göstergesi, Zaman Cetveli’nin başına taşındı.   

Range Selector 1 özelliğinde Offset değeri “0” (sıfır) iken 
Kronometre tıklandı ve Anahtar Kare eklendi. 

  

Geçerli Zaman Göstergesi 1. saniyeye taşındı.   

Offset değeri, “100” olarak belirlendi. İkinci Anahtar Kare 
eklendi. 

  

Animator 1’in sağında bulunan Add özelliği açıldı. Menüden 
Property > Opacity seçilerek Animator 1’in altına eklendi. 

  

Opacity değeri, “0” (sıfır) olarak belirlendi.   

Çalışma Alanı Süre Çubuğu; “01:10” noktasında, klavyede N 
tuşuna basılarak kesildi. Farenin sağ tuşuna tık tıklanarak Trim 
Comp to Work Area seçildi. 

  

Katman panelinde bulunan iki katman seçildi. Farenin sağ tuşuna 
tıklanarak açılan menüde Pre-Compose seçildi. İsim alanına 
“SEYYAH” sözcüğü girildi. OK düğmesine tıklandı. 

  

Animasyon, Boşluk tuşuna basılarak izlendi.   

Proje dosyası kaydedildi.   
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ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
BİLGİ YAPRAĞI 

KONU 6. ŞEKİL OLUŞTURMA 

 

Geometrik şekillerin oluşturulması için şekil araçları kullanılır. Görsel efekt programında beş 
temel şekil aracı vardır. Bunlar; Rectangle Tool (dikdörtgen aracı), Rounded Rectangle Tool (yuvarlanmış 
dikdörtgen aracı), Ellipse Tool (elips aracı), Polygon Tool (çokgen aracı) ve Star Tool (yıldız aracı) 
araçlarıdır. Temel şekil araçlarının dışında Araç çubuğunda bulunan Kalem aracıyla da özel şekiller çizilir. 

6.1. Temel Şekil Araçlarıyla Şekil Oluşturma 

1.  Yol: Menü çubuğunda Layer > New > Shape  Layer seçilir. 

2.  Yol: Katman panelinde farenin sağ tuşuna tıklanarak New > Shape Layer seçilir. 

3.  Yol: Araç çubuğundan Şekil aracı seçilir. 

Açılan listede istenen Şekil aracının üzerine tıklanır. İmleç, “şekil çizim imleci”ne dönüşür. Şeklin 
rengi ve kenarlığı, Araç çubuğunda bulunan Fill ve Stroke araçlarından ayarlanır.  

İmleç Sahne’ye yerleştirilerek şekil çizilir. Katman panelinde bir Şekil katmanı oluşur (Görsel 
6.1). Kompozisyona yeni bir Şekil katmanı eklemek için Katman panelinde herhangi bir katmanın seçili 
olmadığından emin olunduktan sonra yeni bir Şekil aracı seçilir. Dolgu rengi, kenarlık rengi ve boyutu 
ayarlanır. Sahne’ye gelinerek bir kez tıklanır ve şekil çizilir (Görsel 6.1). 

 

 

Katman panelinde herhangi bir şekil katmanı seçiliyken Sahne’ye şekil çizildiğinde oluşan yeni 
şekil, kompozisyona katman olarak eklenmez. Seçili katmanın içine eklenir. Böyle bir durumda katmanda 
yapılan bütün değişiklikler, oluşan yeni şekle de uygulanır. 

Yukarıdaki görselde Shape Layer 2 seçiliyken Sahne’ye çizilen yeni şekil, Shape Layer 2’nin 
Contents özelliğine eklenir (Görsel 6.2). 

 

 

 

 

 

Görsel 6.1: Sahne’ye şekil eklendiğinde Katman panelinin ve Sahne’nin görünümü 
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Shape Layer 2’nin Transform özelliğinde Opacity değeri “0” (sıfır) olarak değiştirildiğinde her iki 
şekil de transparan olur (Görsel 6.3). 

 

 

Katman panelinde Şekil katmanı dışında herhangi bir katman seçiliyken Sahne’ye şekil 
çizildiğinde Maske oluşur (Görsel 6.4). 

 

Görsel 6.2: Bir katman seçiliyken Sahne’ye yeni bir şekil eklendiğinde Katman panelinin görünümü 

Görsel 6.3: Aynı katman içinde oluşturulan şekillerin Opacity değeri düşürüldüğünde şekillerin görünümü 

Görsel 6.4: Şekil katmanından farklı bir katman seçiliyken Sahne’ye şekil eklendiğinde  
Katman panelinin ve Sahne’nin görünümü 
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6.2. Kalem Aracıyla (Pen Tool) Özel Şekiller Oluşturma 

Özel şekiller oluşturmak için Araç çubuğundan Pen Tool [Kalem Aracı (Kısayolu: G)] seçilir (Görsel 
6.5). 

 

 

Fill ve Stroke araçlarından isteğe göre ayar yapılır. 

Kalem aracı, noktalar arasındaki boşlukları doldurarak şekil oluşturur. Sahne’ye bir kez tıklanarak 
başlangıç noktası oluşturulur. Çizilecek şekle göre Kalem aracı ile ikinci bir noktaya tıklanır. İki nokta 
arasında düz bir çizgi oluşur.  İki nokta arasında eğim oluşması isteniyorsa Sahne’ye tıklandığında farenin 
tuşu basılı tutularak imleç sürüklenir. Başlangıç noktasına gelinerek tıklanırsa kapalı bir şekil oluşur 
(Görsel 6.6). 

 

 

Oluşan şekil; köşelerinden tutularak uzatılıp kısaltılabilir, şeklin herhangi bir yerine noktalar 
eklenerek farenin tuşu basılı iken sürüklemek yoluyla eğim verilebilir (Görsel 6.7). 

 

 

Kalem aracı ile şekil oluşturulurken şekil sadece kenarlık rengi verilerek, sadece dolgu rengi 
verilerek veya hem kenarlık hem dolgu rengi verilerek çizilebilir (Görsel 6.8). 

 

 

 

 

Görsel 6.5: Kalem aracı (Pen Tool) 

Görsel 6.6: Şeklin Kalem aracı ile çizilmesi 

Görsel 6.7: Add Vertex Tool ile köşe noktaları eklenerek şeklin bükülmesi 
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Kalem aracı ile hareket yolu oluşturmak, nesneleri çizerek seçmek ya da Maske oluşturmak 
istendiğinde Fill ve Stroke rengi olmadan şekil oluşturulur. Bu durumda Sahne’de şekil görünmez ancak 
Katman panelinde bir Şekil katmanı ve/veya Maske oluşur. Şekil katmanı seçildiğinde ekranda mavi 
renkli şekil çizgileri görünür (Görsel 6.9). 

 

6.3. Şekil Katmanı ve Özellikleri 

Kompozisyona bir Şekil katmanı eklendiğinde, katmanların standart Transform özelliğine ek 
olarak Contents (içerik) özelliği de oluşur.  İçerik özelliğinde; oluşturulan şeklin yolu (Path 1), kenarlığı 
(Stroke 1), dolgu rengi (Fill 1) ve transform özellikleri ile ilgili ayarlar yapılmasını sağlayan parametreler 
bulunur (Görsel 6.10).  

 

 

 

 

 

Görsel 6.8: Kalem aracı ile oluşturulan şekiller 

Görsel 6.9: Kalem aracı ile “Fill ve Stroke renkleri” olmadan şekil oluşturma 
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Shape Layer 1 katmanında Rectangle 1’in altında bulunan tüm seçeneklerden Rectangle 1 ile 
ilgili bütün özellikler değiştirilebilir ve Kronometre bulunan parametrelerine Anahtar Kare eklenerek 
animasyonlar oluşturulabilir (Görsel 6.11). 

 

 

Shape Layer 1 seçiliyken Sahne’ye yeni bir daire şekli çizildiğinde Contents içine Ellipse 1 adında 
yeni bir şekil eklenir. Ellipse 1 şeklinin, Shape Layer 1’in Transform özelliğinden ve Rectangle 1’in 
özelliklerinden bağımsız olarak kendi özellikleri vardır (Görsel 6.12).  

 

 

 

 

 

Görsel 6.10: Sahne’ye çizilen Şekil katmanı ve Katman panelindeki özellikleri 

Görsel 6.11: Rectangle 1’in Color parametresinde renk değişimi 
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Yukarıdaki görselde Ellipse 1 ve Rectangle 1’in dolgu rengi, kenarlık rengi ve Transform 
özellikleri birbirinden bağımsız şekilde değiştirilebilir (Görsel 6.13). Shape Layer 1’in Transform 
özelliğinden yapılan değişiklikler ise iki şekli de etkiler.  

 

 

Add (Ekleme) Özelliği 

Şekil katmanının Contents özelliğinin sağında Add açılır listesi bulunur (Görsel 6.14). Add 
yanındaki Ok işaretine tıklanarak liste açılır (Görsel 6.15). 

 

 

 

 

 

 

 

Görsel 6.12: Şekil katmanı seçiliyken yeni bir şekil eklendiğinde Katman paneli ve Sahne’nin görünümü 

Görsel 6.13: Aynı katmanda bulunan iki şekildeki değişiklikler, şekillerin kendi parametrelerinden yapılır. 

Görsel 6.14: Şekil katmanında Add özelliği 
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Add listesinde şekiller, kenarlık ve dolgu renkleri, şekli deforme özellikleri (buruşturma, 
kırpıştırma, kabartma, bükme, zig zag) gibi özellikler bulunur. İstenen özellikler seçilerek katmana 
eklenir. 

Şekil Katmanına “Wiggle Paths” (Kırpıştırma) Eklemek 

Araç çubuğundan Rectangle seçim aracı seçilir. Sahne’ye bir dikdörtgen çizilir. Katman panelinde 
Şekil katmanı özellikleri açılır. Add > Wiggle seçilir. Bu seçenek, Contents’e Wiggle Paths 1 ekler. 

Wiggle parametreleri, başlangıçta sahip oldukları değerler ile şekle “dalgalanma” etkisi verir. 
Wiggle, Anahtar Kare eklenmeden katman süresi boyunca uygulanır (Görsel 6.16).  

 

 

Wiggle Pahts 1’deki parametre değerleri değiştirilerek etki, istenen şekilde ayarlanabilir. 

Kıpırdama etkisinin; Size değeri (boyu) “90”, Detail (ayrıntı) değeri “60”, Points Smooth 
(pürüzsüzlük), Wiggles / Second (Kıpırdama / Saniye) değerleri de “20” yapıldığında çok daha yoğun bir 
hareket gözlenir (Görsel 6.17). 

 

 

 

 

 

 

Görsel 6.15: Şekil katmanında Add özelliği menüsü 

Görsel 6.16: Şekil katmanına Wiggle Paths eklendiğinde katman görünümü ve şekle etkisi 
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Wiggle Path 1 parametrelerine Anahtar Kare eklenerek farklı animasyonlar hazırlanabilir. 

6.4. Puppet Pin Tool (Kukla Aracı) 

Puppet Tool, hareketsiz nesnelere bağlantı noktaları ekleyerek bu noktalarla nesneye hareket 
verilmesini sağlar.  

Puppet Tool, Araç çubuğunda bulunur. Puppet Tool simgesinin altında farklı hareket ayarları 
yapılmasını sağlayan Puppet araçları vardır (Görsel 6.18). 

 

 

Örnek olarak “Puppet Tool” İle hareket oluşturma: 

Hareket verilecek olan görsel, Sahne’ye taşınır (Görsel 6.19). Aşağıdaki görselde filin hortumuna 
hareket verilecektir. Araç çubuğundan Puppet Position Pin Tool seçilir. 

Görsel 6.17: Wiggle Paths 1’de yapılan değişikliklerin şekle etkisi 

Görsel 6.18: Puppet Tools 

Görsel 6.19: Puppet Tool ile hareket verilecek görsel 
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Pin eklenmeden önce Geçerli Zaman Göstergesi, hareketin başlayacağı noktaya taşınır. Çünkü 
program, Pin eklenen noktaya otomatik olarak bir Anahtar Kare ekler. 

Filin hortumunun başladığı noktaya bir Pin eklenir. Pin eklendiğinde filin gövdesinde bağlantı 
noktaları oluşur (Görsel 6.20). 

 

 

Kıvrımlı hareket verilecek olan hortumda daha hassas çalışmak için “kıvrım” yerlerine Pin eklenir 
(Görsel 6.21). 

 

 

Katman panelinde “YavruFil” katmanının özelliklerindeki Effects > Puppet > Mesh 1 > Deform 
yolu altında bulunan Pin’lere Anahtar Kareler eklenerek hareket oluşturulacaktır (Görsel 6.22). 

 

 

Puppet Pin 1, Puppet Pin 2, Puppet Pin 3, Puppet Pin 4’ün parametreleri açılır. 

Pin Type kutusunda Puppet araç türleri bulunur. Burada Puppet aracı değiştirilebilir. (Araç 
çubuğunda bulunan Puppet araç türleri buradan da seçilebilir.) 

Görsel 6.20: Puppet Tool uygulandığında görselde hareket noktaları oluşur. 

Görsel 6.21: Puppet Tool ile farklı hareket pinleri oluşturma 

Görsel 6.22: Puppet Tool ile oluşturulan Pin’lerin Katman panelindeki görünümü 
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Geçerli Zaman Göstergesi, Zaman Cetveli’nin en başına getirilerek Pin’lerin Kronometre 
simgelerine tıklanır. İlk Anahtar Kareler eklenir (Görsel 6.23). 

 

 

Geçerli Zaman Göstergesi 1. saniyeye taşınır.  “Hortum”, üzerinde oluşturulan Pin’lerden 
ve/veya Position değerlerinden 1. saniyede olması istenen şekilde hareket ettirilir (Görsel 6.24, Görsel 
6.25). 

 

 

 

Geçerli Zaman Göstergesi “1:30f” noktasına taşınır.  Hortum, üzerinde oluşturulan Pin’lerden 
ve/veya Position değerlerinden “1.30f” noktasında olması istenen şekilde hareket ettirilir (Görsel 6.26). 

 

 

Görsel 6.23: Pin’lerin Kronometre simgesine tıklayarak Position’a Anahtar Kare ekleme 

Görsel 6.24: Pin’leri sürükleyerek hortumun 1. saniyedeki duruşunu ayarlama 

Görsel 6.25: Position’a ikinci Anahtar Kareler’i ekleme 



 

 

146 

 

 

Klavyede 0 (sıfır) tuşuna basılarak animasyonun ön izlemesi yapılır ve animasyon kaydedilir. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Görsel 6.26: Pin’lerin pozisyonunu değiştirerek üçüncü Anahtar Kare’yi ekleme 
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İşlem Basamakları 

1. “UYGULAMA_261” isimli bir proje oluşturunuz. 

2. Aşağıda belirtilen özelliklerde bir kompozisyon oluşturunuz. 

Name (Adı): Uygulama61 

Width (Genişlik): 1920 – Height (Yükseklik): 1080  

Frame Rate (Kare Hızı): 60 

Duration (Süre): 5 sn  

Background Color (Arka Plan Rengi): Siyah  

3. Araç çubuğundan Polystar Shape Tool’u seçiniz.  

“Fill: Kırmızı”, “Stroke: Sarı”,  “Stroke Size: 3” olarak ayarlayınız. 

Sahne’ye bir yıldız (Polystar) çiziniz (Görsel 6.28). 

 

 

4. Katman panelinde Shape Layer 1’in özelliklerini açınız. Contents’in sağında bulunan Add 
listesini açarak Twist özelliğini seçiniz. Bu yolla Contents’in içine Twist 1 eklenir (Görsel 
6.29). 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
UYGULAMA 
YAPRAĞI 1 

KONU “TWIST” İLE ŞEKİL ANİMASYONU OLUŞTURMA 

Görsel 6.27: Uygulama tamamlandığında oluşan animasyonun farklı sürelerdeki görünümü 

Görsel 6.28: Sahne’de “Yıldız” şekli oluşturma 



 

 

148 

 

 

5. Geçerli Zaman Göstergesi’ni Zaman Cetveli’nin başına getiriniz. Angle (engıl)’ın 
Kronometre simgesine tıklayarak ilk Anahtar Kare’yi ekleyiniz. 

6. Geçerli Zaman Göstergesi’ni 1. saniyeye taşıyınız. Angle değerine “300” sayısını giriniz 
(Görsel 6.30). 

 

 

7. Katman panelinde bulunan Shape Layer 1’i seçiniz ve Ctrl+D tuşlarına basarak iki kez 
kopyalayınız.  

Böylece Katman panelinde Shape Layer 1,  Shape Layer 2 ve Shape Layer 3 adında üç 
katman oluşur (Görsel 6.31). 

Sahne’de üst üste binen katmanları Seçim aracıyla tutarak istediğiniz konuma taşıyınız.  

 

 

8. Shape Layer 1 katmanında Transform: Polystar 1’in parametrelerini açınız. Geçerli 
Zaman Göstergesi’ni Zaman Cetveli’nin başına getiriniz. Opacity değeri “100” iken 
Kronometre simgesine tıklayarak ilk Anahtar Kare’yi ekleyiniz (Görsel 6.32). 

Görsel 6.29: Add özelliğinden Twist ekleme 

Görsel 6.30: Twist 1’e ait Angle parametresinin değiştirilerek “Yıldız” şeklinin deforme edilmesi 

Görsel 6.31: Katman panelinde Şekil katmanlarının çoğaltılması 
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9. Geçerli Zaman Göstergesi’ni 1. saniyeye taşıyınız. Opacity için “0” (sıfır) değerini giriniz 
ve ikinci Anahtar Kare’yi ekleyiniz (Görsel 6.33). 

 

 

10. Aynı işlemleri Shape Layer 3 katmanına da uygulayınız. 

11. Shape Layer 2 katmanında Transform: Polystar 1’in parametrelerini açınız. Geçerli 
Zaman Göstergesi’ni Zaman Cetveli’nin başına getiriniz. Opacity değerini “0” (sıfır) 
olarak belirleyiniz ve Kronometre simgesine tıklayınız. İlk Anahtar Kare’yi ekleyiniz. 

12. Geçerli Zaman Göstergesi’ni 1. saniyeye taşıyınız. Opacity değeri olarak “100” sayısını 
giriniz ve ikinci Anahtar Kare’yi ekleyiniz. 

13. Scale değerini “180” olarak ayarlayınız (Görsel 6.34). 

 

 

14. “1920 x 1080” çözünürlükte bir Solid katman oluşturarak diğer katmanların altına 
yerleştiriniz. 

15. Geçerli Zaman Göstergesi’ni “1:30f” noktasına getiriniz ve klavyede N tuşuna basarak 
Çalışma Alanı Süre Çubuğu’nu kesiniz. Çalışma Alanı Süre Çubuğu’na farenin sağ tuşuyla 
tıklayarak Trim Comp to Work Area’yı seçiniz (Görsel 6.35). Çalışma Alanı’nı, “1:30” 
olarak ayarlayınız. 

Görsel 6.32: Shape Layer 1’in Opacity değerine birinci Anahtar Kare’nin eklenmesi 

Görsel 6.33: Shape Layer 1’in Opacity değerine ikinci Anahtar Kare’nin eklenmesi 

Görsel 6.34: Shape Layer 2’nin boyutunun büyütülmesi 

Görsel 6.35: Zaman Cetveli’nde Çalışma Alanı’na ait Süre Çubuğu’na farenin sağ tuşuyla tıklandığında açılan liste 
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16. Space tuşuna basarak “0” ile “1:30f” noktaları arasında oluşan animasyonu izleyiniz. 

17. Projeyi kaydediniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“UYGULAMA_261” adında bir proje oluşturuldu.   

İstenen özelliklerde bir kompozisyon oluşturuldu.   

Araç Çubuğu’ndan Polystar Shape Tool seçildi ve istenen 
özelliklerde bir “yıldız” şekli çizildi. 

  

Shape Layer 1’e Add listesinden Twist özelliği eklendi.   

Geçerli Zaman Göstergesi, Zaman Cetveli’nin başına getirildi. 
Angle değerine birinci Anahtar Kare eklendi. 

  

Geçerli Zaman Göstergesi 1. saniyeye taşındı. Angle değerine 
“300” sayısı girildi. İkinci Anahtar Kare eklendi. 

  

Shape Layer 1 seçilerek iki kez kopyalandı.   

Geçerli Zaman Göstergesi, Zaman Cetveli’nin başına getirildi. 
Shape Layer 1’de Polystar 1’in Opacity değeri “100” iken birinci 
Anahtar Kare eklendi. 

  

Geçerli Zaman Göstergesi 1. saniyeye taşındı. Polystar 1’in 
Opacity değeri, “0” (sıfır) olarak ayarlandı. İkinci Anahtar Kare 
eklendi. 

  

Geçerli Zaman Göstergesi, Zaman Cetveli’nin başına getirildi. 
Shape Layer 3’te Polystar 1’in Opacity değeri “100” iken birinci 
Anahtar Kare eklendi. 

  

Geçerli Zaman Göstergesi 1. saniyeye taşındı. Polystar 1’in 
Opacity değeri, “0” (sıfır) olarak ayarlandı. İkinci Anahtar Kare 
eklendi. 

  

Shape Layer 2 seçildi. Transform: Polystar 1’in Opacity değeri “0” 
(sıfır) olarak ayarlandı.  Geçerli Zaman Göstergesi, Zaman 
Cetveli’nin başına getirildi. Kronometre simgesine tıklandı. Birinci 
Anahtar Kare eklendi. 

  

Geçerli Zaman Göstergesi 1. saniyeye taşındı. Opacity değeri için 
“100” sayısı girildi. İkinci Anahtar Kare eklendi.  

  

Scale değeri “180” olarak ayarlandı.   

“1920x1080” çözünürlükte bir Solid katman oluşturuldu. Katman 
panelinde en alt sıraya yerleştirildi. 

  

Geçerli Zaman Göstergesi “1:30f” noktasına getirildi. Çalışma 
Alanı Süre Çubuğu, N tuşuna basılarak kesildi. Çalışma Alanı Süre 
Çubuğu’na farenin sağ tuşuyla tıklanarak açılan menüden Trim 
Comp to Work Area seçildi. 

  

Animasyon, Boşluk tuşuna basılarak izlendi.   

Proje dosyası kaydedildi.   
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İşlem Basamakları 

1. “UYGULAMA_262” isimli bir proje oluşturunuz. 

2. Aşağıda belirtilen özelliklerde bir kompozisyon oluşturunuz: 

Name (Adı): Uygulama62 

Width (Genişlik): 1920 – Height (Yükseklik): 1080  

Frame Rate (Kare Hızı): 60 

Duration (Süre): 5 sn  

Background Color (Arka Plan Rengi): Siyah  

3. Araç çubuğundan Yazı aracını (Text Tool) seçiniz.  

4. Sahne’ye “RÜZGAR” sözcüğünü yazınız. Character panelinden yazı rengini ve fontunu 
ayarlayınız (Görsel 6.37). 

 

 

5. Katman panelinde Yazı katmanını seçerek Yazı katmanına farenin sağ tuşuyla tıklayınız. 
Açılan listeden Create > Create Shapes from Text özelliğini seçiniz. Böylece Yazı 
katmanı, Şekil katmanına dönüşür (Görsel 6.38). 

 

 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
UYGULAMA 
YAPRAĞI 2 

KONU 
“WIGGLE PATHS” İLE YAZI ANİMASYONU 

OLUŞTURMA 

Görsel 6.36: Uygulama tamamlandığında oluşan animasyonun Sahne’deki görünümü 

Görsel 6.37: Sahne’de Text oluşturma 

Görsel 6.38: Text katmanının Şekil katmanına dönüştürülmesi 
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Contents’te her harfin tek tek şekil oluşturduğu görülür (Görsel 6.39). 

 

 

6. Add listesini açınız. Wiggle Paths’i seçerek katmana ekleyiniz (Görsel 6.40). 

 

 

! Anahtar Kareler verilerek ve Wiggle Paths 1’in parametreleri değiştirilerek her harfe 

ayrı ayrı animasyon uygulanabilir. 

 

7. Ön izleme yapınız. 

8. Proje dosyasını kaydediniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“UYGULAMA_262” adında bir proje oluşturuldu.   

İstenen özelliklerde bir kompozisyon oluşturuldu.   

Yazı aracı seçildi ve Sahne’ye “RÜZGAR” sözcüğü yazıldı. 
Character panelinden yazı rengi ve yazı fontu ayarlandı. 

  

Katman panelinde Yazı katmanı, Şekil katmanına dönüştürüldü.   

Yeni oluşan Şekil katmanı seçildi. Yanındaki Ok işaretine 
tıklanarak katman özellikleri açıldı. Add listesi açıldı. “Wiggle 
Paths” seçilerek katmana eklendi. 

  

Animasyon, Boşluk tuşuna basılarak izlendi.   

Proje dosyası kaydedildi.   

 

 

 

 

Görsel 6.39: Yeni oluşan Şekil katmanının görünümü 

Görsel 6.40: Add listesinden Wiggle Paths eklendiğinde Katman paneli ve Sahne’nin görünümü 



 

 

153 

 

 

 

İşlem Basamakları 

1. “UYGULAMA_263” isimli bir proje oluşturunuz. 

2. Aşağıda belirtilen özelliklerde bir kompozisyon oluşturunuz. 

Name (Adı):  Uygulama63 

Width (Genişlik): 1920 – Height (Yükseklik): 1080  

Frame Rate (Kare Hızı): 60 

Duration (Süre): 5 sn  

Background Color (Arka Plan Rengi): Beyaz 

3. Araç çubuğundan Elips aracını (Ellipse Tool) seçiniz.  

4. Dolgu rengini (Fill)  Radial Gradient olarak ayarlayınız. Gradient Editörü’nü açınız. 
Renkleri “sarı” ve “siyah” olarak seçiniz. Shift tuşunu basılı tutarak Sahne’ye bir daire 
çiziniz (Görsel 6.42). 

 

 

 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
UYGULAMA 
YAPRAĞI 3 

KONU “TRIM PATHS” İLE ŞEKİL ANİMASYONU OLUŞTURMA 

Görsel 6.41: Uygulama tamamlandığında oluşan animasyonun farklı sürelerdeki görünümü. 

Görsel 6.42: Sahne’ye Radial Gradient dolgu rengi olan bir dairenin eklenmesi 
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5. Fill (Dolgu) rengini kapatınız. Stroke (Kenarlık) rengini “sarı”, Stroke Size özelliğini “40” 
olarak ayarlayınız. Bir önceki dairenin çevresine bir daire çizerek çerçeve oluşturunuz 
(Görsel 6.43).  

 

 

6. “Koyu gri” renkli ve “1920 x 1080” çözünürlüğünde bir Solid katman oluşturarak Katman 
panelinde en alta taşıyınız. 

7. Katman panelindeki katmanları yeniden isimlendiriniz. “KENAR” katmanında Add listesi 
açınız ve Trim Paths özelliğini seçerek katmana ekleyiniz (Görsel 6.44). 

 

 

8. Trim Paths 1 parametrelerini açınız. Geçerli Zaman Göstergesi’ni Zaman Cetveli’nin 
başına getiriniz. 

Start değerini “100” olarak ayarlayınız. Kronometre simgesine tıklayınız ve ilk Anahtar 
Kare’yi ekleyiniz (Görsel 6.45). 

 

 

9. Geçerli Zaman Göstergesi’ni Zaman Cetveli’nde 2. saniyeye taşıyınız. 

Start değerini “0” (sıfır) olarak ayarlayınız ve ikinci Anahtar Kare’yi ekleyiniz (Görsel 6.46). 

 

Görsel 6.43: Daire şeklinin çevresine Stroke ile çerçeve şekli oluşturulması 

Görsel 6.44: Stroke ile oluşturulan kenarlığa Trim Paths ekleme 

Görsel 6.45: Trim Paths 1’in Start değerine birinci Anahtar Kare’nin eklenmesi 
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10. “0 – 2” saniye aralığında oluşan animasyonu izleyiniz. 

11. Proje dosyasını kaydediniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“UYGULAMA_263” adında bir proje oluşturuldu.   

İstenen özelliklerde bir kompozisyon oluşturuldu.   

Ellipse Tool seçildi. Sahne’ye istenen özelliklerde bir daire çizildi.   

Dolgu rengi kapatıldı. Kenarlık rengi “sarı” olarak ayarlandı. 
Kenarlık büyüklüğü “40” yapıldı. Sahne’de bulunan daire şeklinin 
çevresini saracak şekilde yeni bir daire çizildi. 

  

İstenen özelliklerde bir Solid katman oluşturuldu.   

Shape Layer 1’in ismi “DAIRE”, Shape Layer 2’nin ismi ise 
“KENAR” olarak değiştirildi. 

  

“KENAR” katmanının özellikleri açıldı. Add listesinden Trim Paths 
seçilerek katmana eklendi. 

  

Geçerli Zaman Göstergesi, Zaman Cetveli’nin başına taşındı. Trim 
Paths 1’de Start değeri “100” olarak ayarlandı. Kronometre 
simgesine tıklandı. İlk Anahtar Kare eklendi. 

  

Geçerli Zaman Göstergesi 2. saniyeye taşındı. Start değeri “0” 
(sıfır) olarak ayarlandı. İkinci Anahtar Kare eklendi.   

  

Animasyon, Boşluk tuşuna basılarak izlendi.   

Proje dosyası kaydedildi.   

 

 

 

 

 

 

 

 

 

 

 

Görsel 6.46: Trim Paths 1’in Start değerine ikinci Anahtar Kare’nin eklenmesi 
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ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
BİLGİ YAPRAĞI 

KONU 7. HAREKET TAKİBİ 

 

Bir katmana verilen hareket özelliğini diğer katmanlara da uygulamak; arabaların, insanların ve 
kameraların hareketini sorunsuz bir şekilde takip eden metinler, logolar veya grafikler oluşturmak için 
hareket takip araçlarından faydalanılır. Böylece daha hızlı animasyonlar hazırlanır.  

7.1. Parent (Ebeveyn) Özelliği İle Hareket Takibi 

A katmanında oluşturulan bir hareketin B katmanında da olmasını sağlamak için Parent 
özelliğinden yararlanılır (Görsel 7.1). Parent ile B katmanı, A katmanına bağlanır ve böylece B katmanı, A 
katmanına ait bütün Transform özelliklerine sahip olur. 

 

 

Örneğin “Görsel 7.2” de Sahne’deki dairenin; 1. saniyede Sahne’nin solundan Sahne’nin sağına 
doğru büyüyerek ve üç kez dönerek gelmesi için Position, Scale ve Rotation parametrelerine 0 (sıfır) ve 
1. saniyelerde Anahtar Kareler eklenir (Görsel 7.3). 

 

 

 

 

Görsel 7.1: Parent simgesi 

Görsel 7.2: Sahne’de oluşturulan Yazı ve Şekil katmanları 

Görsel 7.3: Daire katmanının Position, Scale ve Rotation parametrelerine  
0 (sıfır) ve 1. saniyelerde Anahtar Kare eklenmesi 
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Geçerli Zaman Göstergesi, Zaman Cetveli’nin başına getirilir. Yazı katmanında bulunan H harfi 
küçültülerek dairenin içine yerleştirilir (Görsel 7.4). (Sahne büyütülerek yapılırsa daha kolay yerleştirilir.) 

 

 

Parent simgesi seçilir. Bağ sürüklenerek Daire katmanı üzerine bırakılır. Yazı katmanının Parent 
seçim kutusunda, bağ oluşturduğu katmanın (Daire katmanı) ismi yazılıdır (Görsel 7.5).  

Parent özelliğini uygulanmasının başka bir yolu da Parent simgesinin yanındaki kutudan katman 
ismi seçilmesidir. 

 

 

Animasyon izlendiğinde Yazı katmanına herhangi bir Anahtar Kare eklenip hareket verilmediği 
hâlde Daire katmanıyla aynı hareketi yaptığı görülür (Görsel 7.6). 

 

 

Katmanların Transform özelliğinde parametrelerinin her birine ait Parent simgesi oluşur. Bir 
katmanın Transform özelliğinde sadece istenen parametreler referans alınabilir (Görsel 7.7). 

 

 

Görsel 7.4: Sahne’yi büyüterek “H” harfini daire içine yerleştirme 

Görsel 7.5: Parent simgesini seçerek Yazı katmanını Daire katmanına bağlama 

Görsel 7.6: Daire katmanına verilen hareketlerin “0-1” saniye aralığında Sahne’deki görünümü 
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Katmanların farklı parametreleri Parent özelliği ile birbirine bağlanabilir (Görsel 7.8).  

 

 

Yazı katmanının Scale değeri, Daire katmanının Opacity parametresine bağlanır. Yazı katmanının 
Scale değeri, Daire katmanının Opacity değerine bağlandığı anda “100” olur (Görsel 7.9). 

 

 

Daire katmanının Opacity değeri, bir saniyelik animasyon süresinde “100” den “0”a düşer. Yazı 
katmanının Scale değeri de Daire katmanının Opacity değerine bağlı olduğundan “0-1” saniye aralığında 
“100” den “0”a düşer (Görsel 7.10). 

 

Görsel 7.7: Yazı katmanına ait Opacity parametresinin, Daire katmanına ait Opacity parametresine bağlanması 

Görsel 7.8: Yazı katmanına ait Scale parametresinin, Daire katmanına ait Opacity parametresine bağlanması 

Görsel 7.9: Yazı katmanının Scale değeri, Daire katmanın Opacity değerine bağlandığında gerçekleşen değişim 

Görsel 7.10: Yazı katmanına ait Scale değerinin, Daire katmanına ait Opacity değerine bağlanmasıyla oluşan animasyon 
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7.2.“Motion Tracking” Özelliği İle Hareket Takibi 

Video katmanında bulunan hareketli bir nesneyi takip etmek için Motion Track özelliği kullanılır. 
Motion Track ile katmana Tracker (takipçi) eklenir. Tracker’lara şekil, video, yazı, fotoğraf ve efekt 
eklenerek hareketli nesneyi takip etmesi sağlanır.  Motion Track panelini (Görsel 7.11) Çalışma 
Alanı’nda açmak için: 

 

1. Yol: Menü çubuğundan Animation > Motion Track seçilir. 

2. Yol: Zaman Cetveli’nde katmanın üzerine farenin sağ tuşuyla tıklanır ve açılan listede 
Motion Track seçilir. 

3. Yol: Windows içinde Tracker paneli seçilir ve Çalışma Alanı’na eklenir. Burada Motion 
Track seçilir. 

 

 

Motion Source’un yanındaki kutu açılarak katman seçilir (Görsel 7.11). 

Track Motion düğmesine tıklanır. Tracker panelindeki diğer seçenekler de aktif hâle gelir (Görsel 
7.12). 

 

Görsel 7.11: Tracker paneli 

Görsel 7.12: Tracker panelinde Track Motion düğmesi 
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Program, standart olarak Position’a Tracker 1’i ekler. Sahne’de birden fazla Track Point 
oluşturulabilir. Nesne hareketinde Position ile birlikte Rotation veya Scale özelliklerinin takibi 
gerektiğinde bu özellikler için de Track Point oluşturulur (Görsel 7.13). 

 

 

Sahne yakınlaştırılarak Track Point 1’e bakıldığında (Görsel 7.14) Track Point’in ortasında bir + 
işareti ve çevresinde iki kare olduğu görülür. Ortadaki artı değeri, takip için referans noktasıdır. Artı 
değeri ve onu çevreleyen kare alanı içindeki piksel değerleri, Track Point 1’in takip için sürekli olarak 
referans alacağı değerlerdir. Büyük kare ise; küçük karedeki piksel değerlerini, bir sonraki karede ne 
kadar büyüklükte bir alan içinde arayacağını ifade eder. Bu nedenle küçük karenin nesne üzerinde 
yerleştirileceği alanın ayırt edici özellikte olması gerekir (yüksek kontrast ve renk farkı gibi). 

 

 

Track Point 1 tutulup sürüklenerek nesne üzerine yerleştirilir (Sürükleme için siyah renkli imlecin 
oluşması gerekir.) (Görsel 7.15). Track Point’in boyutu, çerçeve köşelerinde oluşan tutamaçlar tutulup 
sürüklenerek ayarlanır. Takip noktası belirlendikten sonra bir sonraki karede takip noktasının aranacağı 
kutu büyüklüğü de ayarlanır. 

 

Görsel 7.13: Track Point 1’in uzaktan ve yakından görünümü 

Görsel 7.14: Track Point’i taşıma imleci 

Görsel 7.15: Track Point’in hareketli nesneye yerleştirilmesi 
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İşlem Basamakları 

1. “UYGULAMA_271” adında bir proje dosyası oluşturunuz. 

2. “GORSELEFEKTDERSI” klasöründen “271” numaralı dosyadaki materyalleri projeye 
aktarınız. 

3. Aşağıda belirtilen özellikte bir kompozisyon oluşturunuz. 

Name (Adı): Uygulama71 

Width (Genişlik): 1920 – Height (Yükseklik): 1080  

Frame Rate (Kare Hızı): 60 

Duration (Süre): 5 sn  

Background Color (Arka Plan Rengi): Siyah  

4. Materyalleri kompozisyona ekleyiniz. 

5. Katmanların ismini değiştiriniz (Görsel 7.17). 

 

 

6. Sahne’deki katmanların boyutunu ayarlayınız (Görsel 7.18). 

 

 

 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
UYGULAMA 
YAPRAĞI 1 

KONU “PARENT” ARACI İLE KATMAN TAKİP ANİMASYONU  

Görsel 7.16: Uygulama tamamlandığında oluşan animasyonun farklı sürelerdeki görünümü 

Görsel 7.17: Katmanların isminin değiştirilmesi 
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7. “Yeşilkaravan” katmanını Göz simgesine tıklayarak kapatınız. 

8. Geçerli Zaman Göstergesi’ni Zaman Cetveli’nin başına taşıyınız. 

9. “Pembearaba” katmanına 2 saniyelik sürede Sahne’nin solundan girip sağından çıkacak 
şekilde pozisyon hareketi veriniz (Görsel 7.19).  

 

 

10. “Yeşilkaravan” katmanını Sahne’nin dışına taşıyınız. Geçerli Zaman Göstergesi’ni sola 
doğru sürükleyerek “Pembearaba” katmanını Sahne’nin başına doğru, iki katmanın 
birleşerek hareket etmesi istenen noktaya getiriniz (Görsel 7.20). 

 

 

 

Görsel 7.18: Katmanlar Sahne’de boyutlandırıldığında Sahne’nin görünümü 

Görsel 7.19: “Pembearaba” katmanının pozisyonunu değiştirerek 0 (sıfır) ve 2. saniyelere Anahtar Kare ekleme 
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11. “Yeşilkaravan” katmanının Parent seçim kutusundan “Pembearaba” katmanını seçiniz 
(Görsel 7.21).  

 

 

12. Animasyonu izleyiniz. 

13. Proje dosyasını kaydediniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“UYGULAMA_271” adında bir proje oluşturuldu.   

İstenen özelliklerde bir kompozisyon oluşturuldu.   

Materyaller kompozisyona eklendi.   

Katmanların adı değiştirildi.   

Sahne’deki katmanların boyutu ayarlandı.   

“Yeşilkaravan” katmanı Göz simgesine tıklanarak kapatıldı.   

Geçerli Zaman Göstergesi, Zaman Cetveli’nin başına taşındı.   

“Pembearaba” katmanı Sahne’nin solundan dışarı taşındı. 
Position değerinin Kronometre simgesine tıklanarak birinci 
Anahtar Kare eklendi. 

  

Geçerli Zaman Göstergesi 2. saniyeye taşındı.   

Görsel 7.20: Araba ve karavanın bağlantı pozisyonunun ayarlanması 

Görsel 7.21: Araba ve karavanın bağlantı pozisyonunun ayarlanması 
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“Pembearaba” katmanı Sahne’nin sağından dışarı taşındı. 
Position değerine ikinci Anahtar Kare eklendi. 

  

“Yeşilkaravan” katmanı Sahne’nin dışına taşındı.    

Geçerli Zaman Göstergesi geriye doğru sürüklenerek 
“Pembearaba” katmanı, iki katmanın birleşerek hareket etmesi 
istenen noktada bırakıldı. 

  

“Yeşilkaravan” katmanının Parent seçim kutusundan 
“Pembearaba” katmanı seçildi. 

  

Animasyon, Boşluk tuşuna basılarak izlendi.   

Proje dosyası kaydedildi.   
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İşlem Basamakları 

1. “UYGULAMA_272”  isimli bir proje açınız. 

2. “GORSELEFEKTDERSI” klasöründeki “272” numaralı dosyayı projeye ekleyiniz. 

3. Aşağıda belirtilen özelliklerde bir kompozisyon oluşturunuz. 

Name (Adı):  Uygulama72 

Width (Genişlik): 1920 – Height (Yükseklik): 1080  

Frame Rate (Kare Hızı): 30 

Duration (Süre): 5 sn  

Background Color (Arka Plan Rengi): Siyah  

4. “Travel” videosunu kompozisyona ekleyiniz. (Pre-comp 1 daha sonra eklenecektir.) 

5. Katman panelinde katman seçiliyken Animation > Track Motion özelliğini seçiniz. 

Position değeri için Sahne’deki katmana standart olarak Track Point 1 eklenir (Görsel 7.23). 

ÖĞRENME BİRİMİ HAREKETLİ GÖRÜNTÜLER 
UYGULAMA 
YAPRAĞI 2 

KONU “TRACK POINT” İLE HAREKET TAKİBİ ANİMASYONU  

Görsel 7.22: Uygulama tamamlandığında oluşan animasyon görüntüsü 

Görsel 7.23: Katmana Track point 1 eklendiğinde Sahne’deki görünümü 

 
http://kitap.
eba.gov.tr/K
odSor.php?K
OD=20889 

http://kitap.eba.gov.tr/KodSor.php?KOD=20889
http://kitap.eba.gov.tr/KodSor.php?KOD=20889
http://kitap.eba.gov.tr/KodSor.php?KOD=20889
http://kitap.eba.gov.tr/KodSor.php?KOD=20889
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6. Araba rengi çevreden farklı olduğu için arabanın üzerine Track Point 1 yerleştiriniz 
(Görsel 7.24). 

 

 

7. Hareketi analiz etmek için Tracker panelinden Analyze Forward düğmesine basınız 
(Görsel 7.25). 

 

 

8. Geçerli Zaman Göstergesi’ni Zaman Cetveli’nin başına taşıyarak takip ediniz. 

9. Hareketi takip ederken herhangi bir taşma görürseniz düzeltiniz. Bunun için Katman 
panelinde Tracker Motion > Tracker 1 > Track Point 1’i açınız. Zaman Cetveli’nde 
Anahtar Kareler görülür (Görsel 7.26). Burada Zaman Cetveli’ni yakınlaştırarak Anahtar 
Kareler üzerinde düzenleme yapınız veya Sahne yakınlaştırıldığında oluşan Anahtar 
Kareler’den tutup sürükleyerek düzenleyiniz 

 

 

 

Görsel 7.24: Track Point 1’in arabaya taşınması ve yerleştirilmesi 

Görsel 7.25: Track point 1, hareket analizi yaparak hareket yoluna Anahtar Kareler ekler. 
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10. Layer menüsünden Null Object’i seçiniz. Katman panelinde Null 1 katmanı oluşur. 

11. Tracker panelinden Edit Target düğmesine tıklayınız ve Null 1’i seçerek OK düğmesine 
tıklayınız (Görsel 7.27).  

 

 

12. Null 1 objesi, arabaya bağlanarak arabayı takip eder (Görsel 7.28). 

 

 

Görsel 7.26: Zaman Cetveli ve Sahne’de Track point 1’e eklenen Anahtar Kareler’in görünümü 

Görsel 7.27: Edit Target penceresi 

Görsel 7.28: Null Object, Travel katmanına bağlanarak Track Point 1’in hareket yolunu takip eder. 
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13. Projeye Import seçeneğiyle projeye aktarılan Pre-comp 1’i kompozisyona ekleyiniz. 
(Katman panelinde en üstte olması gerekir.)  

14. Geçerli Zaman Göstergesi’ni Zaman Cetveli’nin başına taşıyınız. Pre- Comp 1 katmanının 
Sahne’deki konumunu ayarlayınız. Parent simgesi ile Null 1 katmanına bağlayınız. 

15. O tuşuna basarak animasyonu izleyiniz. 

16. Proje dosyasını kaydediniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“UYGULAMA_272” adında bir proje oluşturuldu.   

İstenen özelliklerde bir kompozisyon oluşturuldu.   

Materyaller kompozisyona eklendi.   

Track Motion paneli çalışma alanına eklendi.   

Track Point 1, arabanın üzerine yerleştirildi.   

Tracker panelinden Analyze Forward düğmesine basılarak 
hareket analizi yapıldı. 

  

Geçerli Zaman Göstergesi, Zaman Cetveli’nin başına taşınarak 
takip edildi. Hareket takibinin sağlıklı yapılıp yapılmadığı kontrol 
edildi. 

  

Kompozisyona Null Object eklendi.   

Tracker panelinde Edit Target düğmesine tıklanarak açılan 
pencereden Null 1 seçildi. 

  

Proje panelinde bulunan Pre-comp 1, kompozisyona eklendi.   

Pre-comp katmanı, Sahne’de arabaya ve Null 1 objesine yakın bir 
yere yerleştirildi.  

  

Pre-Comp katmanı, Parent aracı ile Null 1 objesine bağlandı.   

Animasyon, Boşluk tuşuna basılarak izlendi.   

Proje dosyası kaydedildi.   
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ÖĞRENME BİRİMİ MASKELEME TEKNİKLERİ 
BİLGİ YAPRAĞI 

KONU 1. MASKELEME (MASK) 

1.1. Maskeleme Yöntemiyle Yeni Görüntüler Oluşturmak 

Görsel efekt programlarında sıklıkla kullanılan maskeler; kullanılacak farklı katmanlardaki [layer 
(leyır)] fotoğraf ve video materyallerinin belirli alanlarının yok edilerek bir araya getirilmesine, hızlı ve 
kolay geçişler oluşturulmasına olanak tanıyan bir yöntemdir. Maskeler, hareketli tasarımların ve görsel 
efekt uygulamalarının temelini oluşturur.  

1.1.1. Maskeleme Alanlarıyla Çalışmak 

Maskeleme yapabilmek için programın Araç paneli üzerindeki Shape Tool ve Pen Tool kullanılır 
(Görsel 1.1). 

 

 

 Pen Tool: Katman seçili değilken serbest şekilleri oluşturur, katman seçiliyken serbest 
biçimde maskeleme yapar. 

 Rectangle Tool: Katman seçili değilken dikdörtgen şekilleri oluşturur, katman seçiliyken 
dikdörtgen bir alanı kapsayarak maskeleme yapar. 

 Rounded Rectangle Tool: Katman seçili değilken köşeleri yuvarlatılmış dikdörtgen 
şekilleri oluşturur, katman seçiliyken kenarları yuvarlatılmış dikdörtgen bir alanı 
kapsayarak maskeleme yapar. 

 Ellipse Tool: Katman seçili değilken elips şekilleri oluşturur, katman seçiliyken elips bir 
alanı kapsayarak maskeleme yapar. 

 Polygon Tool: Katman seçili değilken çokgen şekilleri oluşturur, katman seçiliyken 
çokgen şekillerin alanını kapsayarak maskeleme yapar. 

 Star Tool: Katman seçili değilken yıldız şekilleri oluşturur, katman seçiliyken yıldız 
şeklinde bir alanı kapsayarak maskeleme yapar. 

 

 

Görsel 1.1: Pen Tool ve Shape Tool 
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Ekranda sadece Pen Tool ve Shape Tool ile şekiller oluşturulmak isteniyorsa şekiller herhangi bir 
katman seçilmeden ve araçlar yardımıyla çizilir (Görsel 1.2). 

  

 

Kompozisyonda bulunan herhangi bir katman (layer) seçiliyken Pen Tool veya Shape Tool 
seçilirse şekil çizimi yerine maskeleme işlemi yapılmış olur ve seçilen katmanın altında Mask katmanı 
veya katmanları oluşur (Görsel 1.3). 

 

 
 

 

 

 

 

Görsel 1.2: Pen Tool ve Shape Tool kullanılarak yapılan örnek çizimler 

Görsel 1.3: Pen Tool ve Shape Tool kullanılarak yapılan örnek maskelemeler 
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Maskeleme işlemi yapıldıktan sonra Seçim aracı yardımıyla seçilen maske alanı, düzenleme 
noktalarından tutularak “maske boyutları” ve “maskenin kapsadığı alan” ayarlanabilir (Görsel 1.4). 

 

 

Maskeleme ile ilgili ayarlar, Mask seçeneği altında açılan menüde bulunur (Görsel 1.5). 

 

 

 Mask Path: Maskenin kapladığı alanın boyutunun ayarlanmasını sağlar. 

 Mask Feather: Maske çevresinde yumuşatılarak geçiş yapılan bir alan oluşturur. 

 Mask Opacity: Maskenin şeffaflık oranını ayarlar. 

 Mask Expansion: Maskenin çevresindeki etki alanı boyutunun ayarlanmasını sağlar. 

 

Görsel 1.4: Maskelerin kapsadığı alanın düzenlenmesi 

Görsel 1.5: Maske ayarları 

Görsel 1.6: Maske ayarlarının maske üzerindeki etkileri 
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İşlem Basamakları 

1. Uygun çözünürlük ve fps değerlerine sahip bir Composition oluşturunuz. 

2. “GORSELEFEKTDERSI /311” klasöründeki fotoğrafları programa aktarınız. 

3. Fotoğrafları; kompozisyon panelinde maskelenecek fotoğraf üstte, diğer fotoğraf altta 
olacak şekilde sıralayınız ve konumlarını ayarlayınız (Görsel 1.7).  

4. Maskeleme yapılacak fotoğrafı seçiniz. 

5. Araç panelinden Pen Tool’u seçiniz. 

 

 

6. Fotoğraftaki maskelenecek alanı Pen Tool yardımıyla ve belirli aralıklarla işaretleyiniz. 
Oval kısımlarda farenin sol tuşunu basılı tutarak bezier (eğimli) işaretleme yapınız 
(Görsel 1.8). 

 

! Pen Tool seçildikten sonra RotoBezier seçeneği aktif hâle getirilirse oval kısımlar, program 

tarafından otomatik olarak seçilecektir. 

 

 

 

 

 

 

 

 

ÖĞRENME BİRİMİ MASKELEME TEKNİKLERİ 
UYGULAMA 
YAPRAĞI 1 

KONU 
PEN TOOL KULLANARAK 

 MASKELEME YAPMAK 

Görsel 1.7: Maskelenecek materyallerin sıralanması ve konumlarının ayarlanması 
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7. Araç panelinden seçim aracını seçtikten sonra maskeleme seçim noktalarını hassas bir 
şekilde ayarlayınız ve gerekiyorsa Pen Tool ile yeni seçim noktaları ekleyiniz veya 
fazladan eklenen noktaları seçerek Delete tuşu ile siliniz. 

8. Maskelenen fotoğrafın Mask 1 seçeneği altındaki Mask Path, Mask Feather, Mask 
Opacity ve Mask Expansion seçeneklerini kullanarak gerekli ayarları yapınız (Görsel 1.9). 

 

 

 

 

 

 

 

Görsel 1.8: Maskenin kontrol noktalarının düzenlenmesi 

Görsel 1.9: Maskeleme ayarlarının yapılması 
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Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

Uygun çözünürlük ve fps değerlerine sahip bir Composition 
oluşturuldu. 

  

“GORSELEFEKTDERSI /311” klasöründeki fotoğraflar programa 
aktarıldı. 

  

Fotoğraflar; kompozisyon panelinde maskelenecek fotoğraf üstte, 
diğer fotoğraf altta olacak şekilde sıralandı ve konumları 
ayarlandı. 

  

Maskeleme yapılacak fotoğraf seçildi.   

Araç panelinden Pen Tool seçildi.   

Maskelenecek fotoğraftaki alan, Pen Tool kullanılarak noktalarla 
işaretlendi. 

  

İşaretleme yapılırken oval kısımlarda farenin sol tuşu basılı 
tutularak bezier (eğimli) işaretleme yapıldı. 

  

Araç panelinden Seçim aracı seçildikten sonra maskeleme seçim 
noktaları, hassas bir şekilde ayarlandı. Gerektiğinde Pen Tool ile 
yeni seçim noktaları eklendi veya fazladan eklenen noktalar 
seçilerek Delete tuşu ile silindi. 

  

Maskelenen fotoğrafın Mask 1 seçeneği altındaki Mask Path, 
Mask Feather, Mask Opacity ve Mask Expansion seçenekleri 
kullanılarak gerekli ayarlar yapıldı. 
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İşlem Basamakları 

1. Uygun çözünürlük ve fps değerlerine sahip bir Composition oluşturunuz. 

2. “GORSELEFEKTDERSI /312” klasöründeki materyalleri programa aktarınız. 

3. Fotoğrafları; kompozisyonda maskelenecek fotoğraf üstte, diğer fotoğraf altta olacak 
şekilde sıralayınız (Görsel 1.10).  

 

 

4. Arka plan olarak kullanılacak fotoğraf üzerinde farenin sağ tuşuna tıklayınız. Açılan 
pencerede Transfom > Fit to Comp (Ctrl+Alt+F) işlemini yapınız. Bu sayede fotoğrafın 
belirlenen çözünürlük ayarlarında ve ekrana tam olarak sığacak şekilde genişlemesi 
sağlanır. 

5. Maskeleme yapılacak fotoğrafı seçiniz. 

6. Araç panelinden Polygonal Tool’u seçiniz. 

 

! Bu işlem için Rectangle Tool da kullanılabilir. Polygonal Tool’un seçilmesinin nedeni, daha 

fazla maske kontrol noktasına sahip olmasıdır.  

 

7. Fotoğraf üzerinde bir “polygonal maskeleme alanı” oluşturunuz (Görsel 1.11). 

 

 

 

 

 

 

ÖĞRENME BİRİMİ MASKELEME TEKNİKLERİ 
UYGULAMA 
YAPRAĞI 2 

KONU 
SHAPE TOOL KULLANARAK  

MASKELEME YAPMAK 

Görsel 1.10: Materyallerin sıralanması 
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8. Maske üzerine tıklayarak aktif hâldeki kontrol noktalarını fotoğraf üzerinde 
maskelenecek alanların üzerine konumlandırınız (Görsel 1.12). 

 

 

9. Masks > Mask 1 seçeneğinden Inverted özelliğini seçerek maskeleme alanını ters 
çeviriniz (Görsel 1.13).  

10. Maskeleme alanının kapsadığı yerleri, maskeleme noktaları yardımıyla hassas şekilde 
ayarlayınız. 

 

! Maskeleme kontrol noktaları, hassas ayar yapabilmek için yeterli olmazsa Pen Tool 

yardımıyla yeni maskeleme kontrol noktaları eklenerek hassas bir şekilde ayar yapılabilir. 

Görsel 1.11: Polygonal maskeleme alanı oluşturulması  

Görsel 1.12: Maske kontrol alanının düzenlenmesi 
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11. Maskelenen fotoğrafın Mask 1 seçeneği altındaki Mask path, Mask Feather, Mask 
Opacity ve Mask Expansion seçeneklerini kullanılarak gerekli ayarları yapınız (Görsel 
1.14). 

 

 

 

 

 

 

 

 

 

 

Görsel 1.13: Maskeleme alanının ters çevrilmesi 

Görsel 1.14: Maskeleme alanı ayarlarının yapılması 
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Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“GORSELEFEKTDERSI /312” klasöründeki materyaller programa 
aktarıldı. 

  

İstenilen çözünürlük ve fps değerlerine sahip bir Composition 
oluşturuldu. 

  

Materyaller; kompozisyonda maskelenecek fotoğraf üstte, diğer 
fotoğraf altta olacak şekilde sıralandı. 

  

Arka plan olarak kullanılacak fotoğrafın belirlenen çözünürlük 
ayarlarında ve ekrana tam olarak sığacak şekilde genişlemesi 
sağlandı. 

  

Maskeleme yapılacak fotoğraf seçildi.   

Araç panelinden Polygonal Tool seçildi.   

Maske üzerine tıklanarak aktif hâldeki kontrol noktaları, fotoğraf 
üzerinde maskelenecek alanların üzerine konumlandırıldı. 

  

Masks > Mask 1 seçeneğinden Inverted seçilerek maskeleme 
alanı ters çevrildi. 

  

Maskeleme alanının kapsadığı yerler, maskeleme noktaları 
yardımıyla hassas şekilde ayarlandı. 

  

Maskelenen fotoğrafın Mask 1 seçeneği altındaki Mask Path, 
Mask Feather, Mask Opacity ve Mask Expansion seçenekleri 
kullanılarak gerekli ayarlar yapıldı. 
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1.1.2. “Track Matte” Yöntemiyle Maskeleme Yapmak 

Track Matte yöntemiyle bir katmandaki görüntünün belirlenen alanları şeffaflaştırılarak 
değişken bir saydamlık elde edilir. Bu yöntemle hareketsiz bir görüntü altına hareketli veya hareketsiz 
görüntülerin eklenmesi sağlanabilir. Track Matte, Alpha (Alfa) ve Luma katmanlarının kullanıldığı 
saydam bir üst katman ve dolgu için kullanılacak görüntüleri içeren bir alt katman içerir. Animasyonlarda 
Track Matte yönteminin kullanılması, geleneksel bir maske kullanılmasına kıyasla çok daha az adımda ve 
daha kolay bir şekilde işlem yapılmasını sağlar. 

Alpha kanalı, bir görüntüdeki pikselin ya da bir bölgenin ne kadar saydam olacağını belirleyen 
kanaldır. Bir pikselin diğer piksel üzerine düştüğünde oluşturacağı rengin oranını belirler. Arka planın yok 
edilmesinde ve saydamlığının ayarlanmasında kullanılır. Luma kanalı, parlaklık bilgisini içeren kanaldır. 
Düşük ve yüksek parlaklıklı alanların saydamlıklarının ayarlanmasında kullanılır. 

 

 

Track Matte seçeneği zaman çizelgesi panelinde gözükmüyorsa katmanların üzerindeki bölüme 
sağ tıklanarak Columns menüsüne gidilir ve Modes kısmı etkinleştirilir (Görsel 1.16). 

 

 

Dört adet Track Matte Uygulama seçeneği bulunur. Bu uygulama seçenekleri şunlardır: 

 

 Alpha Matte: Üstteki katmanın alfa kanalının alttaki katman için maske olarak 
kullanılmasını sağlar. 

 Alpha Inverted Matte: Alpha maskeleme işlemini tersine çevirir. 

Görsel 1.15: Örnek bir Track Matte uygulaması 

Görsel 1.16: Track Matte seçeneklerinin etkinleştirilmesi 
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 Luma Matte: Üstteki katmanın parlaklığının alttaki katman için maske olarak 
kullanılmasını sağlar. 

 Luma Inverted Matte: Luma maskeleme işlemini tersine çevirir. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Görsel 1.17: Track Matte uygulamasıyla yapılmış jenerik örneği 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Alpha ve Luma kanalları ile ilgili araştırma yapınız ve sınıf arkadaşlarınıza bu konuyla ilgili 
sunum yapınız. 

 

İşlem Basamakları 

1. İstenilen çözünürlük ve fps değerlerine sahip bir Composition oluşturunuz. 

2. “GORSELEFEKTDERSI /313” klasöründeki fotoğrafları programa aktarınız. 

3. Çalışma alanında, belirlediğiniz font ve büyüklükte bir yazı oluşturunuz.  

4. Dolgu yapılacak fotoğrafı yazının altına gelecek şekilde konumlandırınız (Görsel 1.18).  

5. Track Matte seçeneğini aktif hâle getiriniz.  

 

 

6. Dolgu yapılacak fotoğrafın Track Matte seçeneğini Alpha Matte olarak seçiniz (Görsel 
1.19).  

7. Bu işlem sonucunda yazının dolgu rengi kalkar ve dolgu rengi olarak fotoğraf 
görüntülenir. 

 

ÖĞRENME BİRİMİ MASKELEME TEKNİKLERİ 
UYGULAMA 
YAPRAĞI 3 

KONU TRACK MATTE YÖNTEMİYLE MASKELEME YAPMAK 

Görsel 1.18: Dolgu için kullanılan fotoğraf ve yazının konumlandırılması 

Görsel 1.19: Dolgu için kullanılacak fotoğrafın Track Matte seçeneğinin aktif hâle getirilmesi 
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8. Aynı işlemi Alpha Inverted Matte, Luma Matte ve Luma Inverted Matte seçeneklerini 
ayrı ayrı uygulayarak yapınız ve aralarındaki farkı gözlemleyiniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

İstenilen çözünürlük ve fps değerlerine sahip bir Composition 
oluşturuldu. 

  

“GORSELEFEKTDERSI /313” klasöründeki fotoğraflar programa 
aktarıldı. 

  

Çalışma alanında, belirlenen font ve büyüklükte bir yazı 
oluşturuldu. 

  

Dolgu yapılacak fotoğraf, yazının altına gelecek şekilde 
konumlandırıldı. 

  

Track Matte seçeneği aktif hâle getirildi.   

Dolgu yapılacak fotoğrafın Track Matte seçeneği, Alpha Matte 
olarak seçildi. 

  

Aynı işlem Alpha Inverted Matte, Luma Matte ve Luma Inverted 
Matte seçenekleri ayrı ayrı uygulanarak yapıldı ve aralarındaki 
fark gözlemlendi.  
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1.1.3. Maskelemeyi Animasyonlarda Kullanmak 

Animasyon (canlandırma); yazıların, şekillerin veya görsellerin belli bir sırayla arka arkaya 
dizilerek bir senaryo dâhilinde hareketlendirilmesi işlemidir. Animasyonun temel amacı, izleyicinin 
ekrandaki görüntüyü hareket ediyormuş gibi algılamasını sağlamaktır. 

Görsel efekt programlarında hazırlanan çalışmalarda sıklıkla kullanılanır animasyon yöntemleri;  

 2 Boyutlu (2D) animasyonlar, 

 3 Boyutlu (3D) animasyonlar, 

 Karakter animasyonları, 

 Kinetik tipografiler, 

 UI / UX mockup [mokap] animasyonlarıdır. 

Maskeleme tekniklerini animasyonlarla birleştirmek, görsel efekt işlemlerinde sıklıkla kullanılan 
bir yöntemdir. Yazılar, şekiller ve görsellerin maskelerle birlikte kullanılmasıyla ilgi çekici animasyonlar 
hazırlanabilir. Çalışmalarda temel animasyon bilgisinin maskeleme bilgisi ile birlikte kullanılması 
oldukçaönemlidir. 

Daha önceki öğrenme birimlerinde anlatılan “anahtar kare” ve “hız-zaman” ayarlama gibi 
kısımların tekrar edilmesi, bu konuyla ilgili yapılacak uygulamalarda kolaylık sağlayacaktır. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Grup çalışması: 

1. Sınıf arkadaşlarınızla ortak çalışma grupları oluşturunuz ve animasyon oluşturma 
yöntemlerinin konu başlıklarını kendi aranızda paylaşınız. 

Animasyon oluşturma yöntemleri: 

 2 boyutlu (2D) animasyonlar 

 3 boyutlu (3D) animasyonlar 

 Karakter animasyonları 

 Kinetik tipografiler 

 UI / UX mockup [mokap] animasyonları 

2. İşbirliği içerisinde konuları araştırınız.  

3. Yaptığınız araştırmaları sunum hâline getirerek sınıf arkadaşlarınıza aktarınız. 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Daha önce öğrendiğiniz Keyframe (kiyfreym) kavramı ve “keyframe ivme seçenekleri” 
konularını tekrar ediniz (Easy Ease, Easy Ease In, Easy Ease Out).  

 

İşlem Basamakları 

1. İstenilen çözünürlük ve fps değerlerine sahip bir Composition oluşturunuz. 

2. Çalışma Alanı’nda bir yazı oluşturunuz. 

3.  Yazı katmanını seçiniz ve farenin sağ tuşuna basarak Mask > New Mask (Ctrl+Shift+N) 
yöntemi ile maske oluşturunuz (Görsel 1.20). 

 

 

4. Mask 1 > Mask Path özelliğini seçiniz ve maske yanındaki saat simgesine ( ) tıklayarak 
Zaman Çizelgesi’nde bir Anahtar Kare oluşturunuz. 

5. Zaman Sekmesi’ni istenen süreye konumlandırınız. 

6. Maskeyi seçim aracıyla tutarak yazı kaybolana kadar aşağı doğru kaydırınız. Bu şekilde 
maske, belirlenen zaman aralığında hareket etmiş olur (Görsel 1.21). 

 
 
 
 
 
 
 
 
 
 

 

ÖĞRENME BİRİMİ MASKELEME TEKNİKLERİ 
UYGULAMA 
YAPRAĞI 4 

KONU MASKELEME İLE YAZI ANİMASYONU HAZIRLAMAK 

Görsel 1.20: Yazı katmanının maskelenmesi 
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7. Zaman Sekmesi’ni belirlenen zaman aralığına çekiniz ve burada bir boş Anahtar Kare 
oluşturunuz. Böylece maskenin konumunun değişmemesi sağlanır. 

8. Zaman Sekmesi’ni hareketin belirlenen bitiş noktasına konumlandırınız ve maskeyi 
yukarı doğru taşıyınız (Görsel 1.22). 

 

 

9. Belirlenen zaman aralığında maskenin hareket etmesi sağlanmış olur. 

10. İlk iki Anahtar Kare’yi seçerek farenin sağ tuşuyla açılan pencereden Easy Ease In 
efektini seçiniz (Görsel 1.23). 

Görsel 1.21: Maskenin belirlenen sürede hareket ettirilmesi 

Görsel 1.23: İvmelendirme seçeneklerinin Anahtar Kareler’e uygulanması 

Görsel 1.22: Hareketin tamamlanması 
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11. Son iki Anahtar Kare’yi seçerek Easy Ease Out ekleyiniz.  

 

 

12. Anahtar Kareler’i ayrı ayrı seçerek Easy Ease, Easy Ease In ve Easy Ease Out 
ivmelendirme seçeneklerini teker teker deneyiniz, hareketlerin hızlanmasını ve 
yavaşlamasını gözlemleyiniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

İstenen çözünürlük ve Fps değerlerine sahip bir Composition 
oluşturuldu. 

  

Çalışma alanında bir yazı oluşturuldu.   

Yazı katmanı seçilerek bir maske oluşturuldu.   

Mask 1 > Mask Path seçildi ve maske yanındaki saat simgesine 

( ) tıklanarak Zaman Çizgisi’nde bir Anahtar Kare oluşturuldu. 
  

Zaman Sekmesi, istenen süreye konumlandırıldı.   

Maske, seçim aracıyla tutularak yazı kaybolana kadar aşağı doğru 
kaydırıldı. 

  

Zaman Sekmesi, belirlenen zaman aralığına çekildi ve burada bir 
boş Anahtar Kare oluşturuldu. 

  

Zaman Sekmesi, hareketin belirlenen bitiş noktasına 
konumlandırıldı ve maske, yukarı doğru taşındı. 

  

Belirlenen zaman aralığında maskenin hareket etmesi sağlandı.   

İlk iki Anahtar Kare seçilerek, farenin sağ tuşuyla açılan 
pencereden Easy Ease In efekti seçildi. 

  

Son iki Anahtar Kare seçilerek Easy Ease Out efekti seçildi.   

Anahtar Kareler ayrı ayrı seçilerek Easy Ease, Easy Easy In ve 
Easy Ease Out ivmelendirme seçenekleri teker teker denendi, 
hareketlerin hızlanması ve yavaşlaması gözlemlendi. 

  

 

 

Görsel 1.24: Hareketin ivmelendirilmesi 
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İşlem Basamakları 

1. İstenen çözünürlük ve fps değerlerine sahip bir Composition oluşturunuz. 

2. “GORSELEFEKTDERSI /315” klasöründeki fotoğrafı programa aktarınız. 

3. Çalışma alanında bir yazı oluşturunuz.  

4. Yazı katmanını seçerek dünya fotoğrafının boyutuna uygun, çember biçimli bir maske 
oluşturunuz (Görsel 1.25). 

 

! Maske veya şekiller çizilirken klavyede Shift tuşu basılı tutularak çizime başlanması, 

çizimin en-boy oranının korunmasını sağlar. Böylece tam bir çember oluşturulabilir. 

 

 

5. Yazı katmanının Path Options alanını açınız ve buradan Path seçeneğini Mask 1 olarak 
değiştiriniz. Bu işlemle maskenin çevresine yazı bağlanmış olur (Görsel 1.26). 

 

ÖĞRENME BİRİMİ MASKELEME TEKNİKLERİ 
UYGULAMA 
YAPRAĞI 5 

KONU MASKELEME İLE YAZI ANİMASYONU YAPMAK 

Görsel 1.25: Yazı ve maskenin oluşturulması 

Görsel 1.26: Maskeye yazı bağlanması 
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6. Path Path Options > Path seçeneği altındaki seçenekler (Görsel 1.27): 

 

 

 Reverse Path (rivörs pet): Yazıyı, bulunduğu konumun zıttına çevirir. 

 Perpendicular To Path (pırpindikiyulır tu pet): Yazıyı dik hâle getirir. 

 Force Alignment (fors elaynmınt): Yazıyı oluşturan harfleri (baş veya son) sabit tutarak 
diğerlerini maske ekseninde dağıtır. 

 First Margin-Last Margin (först marcin-last marcin): Yazının belirlenen Path (yol) 
boyunca hareket ettirilmesini sağlar. 

7. Perpendicular to Path > On seçimini yapınız. 

8. First Margin’i seçerek maske yanındaki saat simgesine ( ) tıklayınız ve zaman 
çizelgesinde bir Anahtar Kare oluşturunuz. 

9. Zaman Sekmesi’ni, istediğiniz süreye konumlandırınız. 

10. Zaman Sekmesi’ni belirlenen zaman noktasına kaydırınız ve First Margin değerini yazı 
tam bir tur atana kadar artırınız veya azaltınız (Görsel 1.28). 

 

 

11. “Dünya” yazısını ve fotoğrafını ekranda belirlenen yerlere konumlandırınız. 

12. Preview [priviyuv (ön izleme)] ile yazının dünya etrafında döndüğü gözlemlenir (Görsel 
1.29). 

Görsel 1.27: Path seçenekleri 

Görsel 1.28: Yazının maske etrafında hareket ettirilmesi 
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Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

İstenen çözünürlük ve fps değerlerine sahip bir Composition 
oluşturuldu. 

  

“GORSELEFEKTDERSI /315” klasöründeki fotoğraf programa 
aktarıldı. 

  

Çalışma alanında bir yazı oluşturuldu.   

Yazı katmanı seçilerek dünya fotoğrafının boyutuna uygun, 
çember biçimli bir maske oluşturuldu. 

  

Yazı katmanının Path Options alanı açıldı ve buradan Path 
seçeneği Mask 1 olarak değiştirildi.  

  

Perpendicular to Path > On seçimi yapıldı.   

First Margin seçilerek maske yanındaki saat simgesine ( ) 
tıklandı ve zaman çizelgesinde bir Anahtar Kare oluşturuldu. 

  

Zaman Sekmesi, istenen süreye konumlandırıldı.   

Zaman Sekmesi, belirlenen zaman noktasına kaydırıldı ve First 
Margin değeri, yazı tam bir tur atana kadar artırıldı veya azaltıldı.  

  

“Dünya” yazısı ve fotoğrafı ekranda belirlenen yerlere 
konumlandırıldı. 

  

Preview (ön izleme) ile yazının dünya etrafında döndüğü 
gözlemlendi. 

  

 

 

 

 

 

Görsel 1.29: Hareketin ön izlemesi 
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ÖĞRENME BİRİMİ MASKELEME TEKNİKLERİ 
BİLGİ YAPRAĞI 

KONU 2. YEŞİL PERDE (GREENBOX) 

2.1. Renk Ayrıştırma (Keying) 

Keying (anahtarlama- renkle ayrıştırma) ya da Chroma Key, (kilit renk) iki farklı görüntüyü 
birbirinin üstüne bindirebilmek için kullanılan bir çekim tekniğidir. Chroma Keying işlemi ile görüntüdeki 
belirli bir renk ayrılır ve daha sonra bu renk, bilgisayar yazılımıyla saydam hâle getirilir.  

Bu teknik büyük çaplı olarak ilk defa “Larry Butler” tarafından 1940 yılında çekilmiş “Bağdat 
Hırsızı (The Thief of Bagdad)” filminde kullanılmış ve bu tekniği geliştiren Petro Vlahos’a Oscar ödülü 
kazandırmıştır. Günümüzde filmlerde, dizilerde ve reklamlarda kullanılan sahneler, bu teknoloji 
sayesinde kolaylıkla çekilmektedir. Çoğunlukla çekimi zor ve tehlikeli sahneler için çekim ekibini herhangi 
bir yere götürüp orada çekim yapmak yerine aynı çekimler, özel bir stüdyo ortamında yapılır. Böylece 
hem zamandan hem de bütçeden büyük tasarruf edilmiş olur.  

Bu tekniğin kullanılabilmesi için günümüzde Greenbox (yeşil perde) ve Bluebox (mavi perde) adı 
verilen stüdyolar kullanılır. Dijital kameralardaki sensörlerin diğer renklere göre yeşile daha duyarlı 
olmaları ve yeşil rengin insan teninde en az bulunan renk olması nedeniyle Greenbox (yeşil perde), daha 
yaygın olarak kullanılmaktadır. Greenbox (yeşil perde) stüdyolarının aydınlatılması için daha az ışık 
gerekir. Bluebox (mavi perde) stüdyolar ise özellikle çekilen kişi veya nesnelerin yeşil renkli olması 
durumunda veya yeşil bir kostüm giyilmesi gerekiyorsa tercih edilir.  

 

2.2. Renk Ayrıştırma Yöntemi Kullanılırken Dikkat Edilmesi Gereken Noktalar 

Greenbox veya Bluebox kullanılırken dikkat edilmesi gereken bazı noktalar bulunmaktadır. Bu 
noktalara dikkat edilmesi, çekimlerin doğru şekilde yapılması için çok önemlidir: 

 

1. Çekilecek olan sahne veya fotoğrafın durumuna bağlı olarak uygun büyüklükte bir stüdyo 
veya fon oluşturulmalıdır. 

2. Kamera açısında bulunan tüm bölümler tamamen yeşil veya mavi boya ile boyanmalı ya 
da “kumaş fon perdesi” ile kaplanmalıdır. 

Görsel 2.1: Örnek bir Greenbox stüdyosu 
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3. Çekimlerde kullanılan fon rengi ile aynı renkte kıyafet, nesne veya aksesuar 
kullanılmamalıdır. 

4. Gökyüzü mavi renkte olduğu için dış çekim yapılırken fonda mavi renk tercih 
edilmemelidir.  

5. Çekimlerin en iyi şekilde yapılabilmesi için ışık çok önemlidir. Kullanılacak ışıklar doğru 
açı ile konumlandırılmalıdır. 

6. Kırışıklıklar gölge oluşumuna ve görüntüde bozulmalara sebep olacağından, kullanılacak 
fon kumaşı düzgün ve ütülü olmalıdır. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Görsel 2.2: Yeşil perde stüdyosu için örnek ışık ve kamera konumlandırılması 
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İşlem Basamakları 

1. İstenilen çözünürlük ve fps değerlerine sahip bir Composition oluşturunuz. 

2. “GORSELEFEKTDERSI /321” klasöründeki materyalleri programa aktarınız. 

3. Nesneleri; Greenbox ya da Bluebox ortamında hazırlanan fotoğraf üstte, fon    
görüntüsü altta olacak şekilde konumlandırınız (Görsel 2.3). 

 

 

4. Effects & Presets paneli altından Keying > Keylight 1.2’yi seçiniz. Fare ile tutarak 
Greenbox ya da Bluebox ortamında çekilen fotoğrafın üzerine sürükleyip bırakınız 
(Görsel 2.4). 

 

 

 

 

ÖĞRENME BİRİMİ MASKELEME TEKNİKLERİ 
UYGULAMA 
YAPRAĞI 1 

KONU YEŞİL PERDE UYGULAMASI 

Görsel 2.3: Görsellerin konumlandırılması 

Görsel 2.4: Keylight efektinin görsele uygulanması 

 
http://kitap.
eba.gov.tr/K
odSor.php?K
OD=20890 

http://kitap.eba.gov.tr/KodSor.php?KOD=20890
http://kitap.eba.gov.tr/KodSor.php?KOD=20890
http://kitap.eba.gov.tr/KodSor.php?KOD=20890
http://kitap.eba.gov.tr/KodSor.php?KOD=20890
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5. Screen Color’ın yanındaki Damlalık aracını seçiniz ve görüntü fon rengini tanımlayınız 
(Görsel 2.5). 

 

 

6. View seçeneğini Final Result olarak belirleyiniz. 

7. Screen Gain, Screen Balance, Despill Bias ve Alpha Bias ayarlarını değiştirerek 
aralarındaki farkı gözlemleyiniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

İstenilen çözünürlük ve fps değerlerine sahip bir Composition 
oluşturuldu. 

  

Programa Greenbox ya da Bluebox ortamında çekilmiş ve fon 
olarak kullanılacak fotoğraf veya video aktarıldı. 

  

Nesneler, Greenbox ya da Bluebox ortamında hazırlanan fotoğraf 
üstte, fon görüntüsü altta olacak şekilde konumlandırıldı. 

  

Effects & Presets paneli altından Keying > Keylight 1.2 seçildi. 
Fare ile tutularak Greenbox ya da Bluebox ortamında çekilen 
fotoğrafın üzerine sürüklenerek bırakıldı. 

  

Screen Color’ın yanındaki Damlalık aracı seçildi ve görüntü fon 
rengi tanımlandı. 

  

View seçeneği, Final Result olarak seçildi.   

Screen Gain, Screen Balance, Despill Bias ve Alpha Bias ayarları 
değiştirilerek aralarındaki fark gözlemlendi. 

  

 

 

 

! Çalışma Alanı’nda Effects & Presets paneli görünmüyorsa Window menüsü altından veya 

Ctrl+5 ile görünür hâle getirilebilir. 

Görsel 2.5: Keylight efektinin görseldeki etkisi 
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ÖĞRENME BİRİMİ MASKELEME TEKNİKLERİ 
BİLGİ YAPRAĞI 

KONU 3. ROTO BRUSH 

 

3.1. Roto Brush Aracı ve Özellikleri 

Rotoskop (Rotoscoping), hareketli bir nesnenin hareketlerini takip ederek bu nesnedeki bir alanı 
farklı bir arka planda kullanmak üzere bir sahneden ayırma işlemidir.  

Görsel efekt programlarında Roto Brush aracı kullanarak sahnedeki hareketli bir nesneyi arka 
plandan kolaylıkla ayırmak mümkündür. Rotoskop işleminin maskelemeden en büyük farkı, çoğunlukla 
hareketli görüntülerin arka plandan ayrılması için kullanılmasıdır.  

Hareketli bir sahneyi maskelemek, normal şartlarda oldukça zordur. Maskelenecek alan, 
görüntünün her bir karesinde (frame) sürekli değişeceğinden her bir kare (frame) için maskeleme 
alanının da değiştirilmesi ve Anahtar Kareler ile hareketlendirilmesi gerekir. 

 Roto Brush aracı, nesnenin hareketini izlemek için yapay zekâ teknolojisini kullanır. Hareketli 
görüntüde kare kare maskeleme yapmak yerine Roto Brush aracı ile görüntünün maskelenecek alanı 
kullanıcı tarafından seçilir ve ara karelerdeki (frame) seçilmeyen diğer kısımların görsel efekt programı 
tarafından otomatik olarak harekete göre seçilmesi sağlanır. 

Roto Brush aracı, araç panelinde (  )simgesiyle tanımlanır. 

 

 

! Roto Brush işlemi yapılırken ilk seçim işlemini olabildiğince hassas yapmak, kullanıcıya 

uygulamada oldukça kolaylık sağlar. 

 

 

 

 

 

 

 

 

 

Grup çalışması: 

 Sınıf arkadaşlarınızla ortak çalışma grupları oluşturunuz. 

 Rotoskop işleminin uygulanma tekniğinin gelişimini araştırınız. 

 Bu işlemin uygulandığı çalışmaları inceleyiniz. 

 Bu çalışmalardan örnekleri sınıfta izleyiniz. 

 Yaptığınız araştırmaları sunum hâline getirerek sınıf arkadaşlarınıza aktarınız. 

Görsel 3.1: Roto Brush aracı 
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İşlem Basamakları 

1. Rotoskop yapılacak videonun fps değerlerine sahip bir Composition                
oluşturunuz. 

2. “GORSELEFEKTDERSI /331” klasöründeki materyalleri programa aktarınız. 

3. Rotoskop işlemi yapılacak katmana çift tıklayarak Katman (Layer)                  
penceresinde açınız  

4. Roto Brush aracını seçiniz ve maskelenecek alanı boyayarak belirleyiniz. Bu alan,   
eflatun bir renkle çerçevelenir (Görsel 3.2). 

 

 

5. Kenarları doğru olarak seçmek ve düzeltmek için klavyeden Alt tuşuna basınız ve fırça 
aracının yeşilden kırmızıya dönüştüğünü gözleyiniz. Fırça aracı yeşil olduğunda seçili 
alanlara ekleme, kırmızı olduğunda ise seçili alanlardan çıkarma işlemi yapılır (Görsel 
3.3). 

 

 

6. Görüntünün Roto Brush seçim noktalarını seçerek kaydırınız. Böylece seçim alanı, 
çekimin süresi boyunca kaydırılmış olur (Görsel 3.4). 

 

 

ÖĞRENME BİRİMİ MASKELEME TEKNİKLERİ 
UYGULAMA 
YAPRAĞI 1 

KONU ROTO BRUSH ARACI İLE MASKELEME YAPMAK 

Görsel 3.2: Roto Brush aracı ile görüntünün sınırlarının seçilmesi 

Görsel 3.3: Seçim alanında yeni seçim alanı ekleme veya çıkarma işlemi 

 
http://kitap.
eba.gov.tr/K
odSor.php?K
OD=20891 

http://kitap.eba.gov.tr/KodSor.php?KOD=20891
http://kitap.eba.gov.tr/KodSor.php?KOD=20891
http://kitap.eba.gov.tr/KodSor.php?KOD=20891
http://kitap.eba.gov.tr/KodSor.php?KOD=20891
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7. Ön İzleme (Preview) panelini açınız ve çekimi kare kare ilerletmek için sonraki kare 
seçeneğine tıklayınız. Maske seçim kenarlarında düzeltilmesi gereken bir yer olursa 
düzeltmeleri yapmak için Roto Brush aracını kullanınız. Görüntüdeki tüm kareler için aynı 
adımları izleyiniz (Görsel 3.5). 

 

 

8. Kullanılacak bütün kareler için yapılan seçim işlemleri tamamlandığında seçim alanlarını 
kaydetmek için Katman (Layer) penceresinin sağ alt köşesindeki Dondur (Freeze) 
düğmesine tıklayınız (Görsel 3.6). 

 

 

9. Dondurma (Freeze) işlemi bittikten sonra kompozisyon penceresine geri dönünüz. Arka 
plan görüntüsü olarak belirlediğiniz fotoğraf veya video alta, RotoScope yaptığınız 
görüntü üste gelecek şekilde konumlandırınız ve boyutlarını ayarlayınız (Görsel 3.7). 

Görsel 3.4: Seçim alanının süre boyunca kaydırılması 

Görsel 3.5: Seçimin kare kare genişletilmesi 

Görsel 3.6: Dondur (Freeze) seçeneği 
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Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır. 

Kontrol Listesi Evet Hayır 

“GORSELEFEKTDERSI / 331” numaralı klasördeki materyaller 
programa aktarıldı. 

  

Rotoskop yapılacak videonun fps değerlerine sahip bir 
Composition oluşturuldu. 

  

Rotoskop işlemi yapılacak katman çift tıklanarak Katman (Layer) 
penceresinde açıldı. 

  

Roto Brush aracı seçildi ve maskelenecek alan boyanarak 
belirlendi. 

  

Kenarları doğru olarak seçmek ve düzeltmek için klavyeden Alt 
tuşuna basıldı ve fırça aracının yeşilden kırmızıya dönüştüğü 
gözlendi. 

  

Görüntünün Roto Brush seçim noktaları seçilerek kaydırıldı.   

Önizleme (Preview) paneli açıldı ve çekimi kare kare ilerletmek 
için sonraki kare seçeneğine tıklandı. Seçim kenarlarında 
düzeltilmesi gereken bir yer olduğunda, düzeltmeleri yapmak için 
Roto Brush aracı kullanıldı. 

  

Görüntüdeki tüm kareler için aynı adımlar izlendi.   

Kullanılacak bütün kareler için yapılan seçim işlemleri 
tamamlandığında seçim alanlarını kaydetmek için Katman (Layer) 
penceresinin sağ alt köşesindeki Dondur (Freeze) düğmesine 
tıklandı. 

  

Dondurma (Freeze) işlemi bittikten sonra Kompozisyon 
penceresine geri dönüldü. Arka plan görüntüsü olarak belirlenen 
fotoğraf veya video alta, Rotoscope yapılan görüntü üste gelecek 
şekilde konumlandırıldı ve boyutları ayarlandı. 

  

 

 

Görsel 3.7: RotoScope yapılan görüntünün diğer görüntüler ile birleştirilmesi 
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ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
BİLGİ YAPRAĞI 

KONU 1. EFEKTLER 

1.1. Sahne’ye Efekt Ekleme 

Sahne’ye efekt eklemek iki şekilde yapılabilir.  Birinci yöntem ile Effect menüsünden uygulanmak 
istenen efekt seçilir ve uygulanmak istenen materyale uygulanır. Efekt uygulanmak istenen materyalin 
seçili olması gereklidir. Hangi materyal seçili ise efekt, o materyale etki eder. 

 

 

İkinci yöntem olarak ise Window menüsünden Effects & Presets paneli, çalışma ekranına getirilir 
(Görsel 1.1 ). Uygulanmak istenen efekt, bu kısımdan seçilir. Burada dikkat edilmesi gereken nokta; 
uygulanacak efektin, etki etmesi istenen materyale sürükle-bırak yöntemi ile bırakılmasıdır. Eğer 
kullanılacak efektin ismi biliniyorsa arama kısmına yazılır.  

1.2. Effect Controls 

Materyallere uygulanan efektlerin parametrelerinin ayarlandığı paneldir. Bu kısımda; uygulanan 
efektin ne kadar uygulanacağı, ne kadar süre ile uygulanacağı, etkisinin ne kadar olacağı vb. ayarlar 
yapılır. Her efektin kendine özgü parametreleri vardır (Görsel 1.2).  

Görsel 1.1: Efekt menüsü 
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1.3. Adjustment Layer  

Layer > New> Adjustment Layer [edcastmınt leyır (ayarlama katmanı)] komutları ile Sahne’ye 
Adjustment Layer eklenir. Bu katman, boş bir katman olarak görünür. Video veya görsel dosyasına 
uygulanacak efekt, Adjustment Layer’a eklenerek kontrol edilebilir. Bu katmanda yapılan değişiklikler, 
Timeline panelinde Adjustment Layer’ın altında yer alan tüm materyallere etki eder.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Görsel 1.2: Effect Controls paneli 
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İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz. 

2. “GORSELEFEKTDERSI /411” klasöründeki materyalleri programa aktarınız. 

3. Video dosyasını kompozisyon penceresine konumlandırınız ve                                   
Tracker [tırekır (izleyici)] menüsünden Track Camera sekmesini kullanarak                 
video dosyasının görsel yerleştirilebilecek kısımlarını analiz ediniz (Görsel 1.3). 

 

 

4. Kamera analizi sonucunda çıkan noktacıkların üzerine geliniz. Bu noktacıklardan uygun 
görünenlerin üzerinde farenin sol tuşunu basılı tutarak yeterli alan çiziniz. Effect 
Controls panelinden Create Camera düğmesi ile kompozisyona 3D Camera Tracker 
oluşturunuz (Görsel 1.4).  

 

 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 1 

KONU “CAMERA TRACKER” VE “TINT” EFEKTİ 

Görsel 1.3: Kamera Tracker işleminin uygulanması 

Görsel 1.4: Sahne’ye 3D Camera Tracker’ın konumlandırılması 

 
http://kitap.
eba.gov.tr/K
odSor.php?K
OD=20892 

http://kitap.eba.gov.tr/KodSor.php?KOD=20892
http://kitap.eba.gov.tr/KodSor.php?KOD=20892
http://kitap.eba.gov.tr/KodSor.php?KOD=20892
http://kitap.eba.gov.tr/KodSor.php?KOD=20892
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5. 3D Camera Tracker Sahne’ye eklendikten sonra duvar görsel dosyasını kompozisyona 
konumlandırınız, boyut ayarlama ve maskeleme işlemlerini gerçekleştiriniz. Duvar 
görselini 3D biçimine dönüştürünüz. Blending Mode bölümünden Overlay [ovırley 
(kaplama)] özelliğini seçiniz (Görsel 1.5).  

 

 

6. “Duvar” görsel dosyasının üzerine Effects & Presets panelinden Tint efektini uygulayınız. 
Tint efekti, siyah beyaz bir etki oluşturacaktır (Görsel 1.6). Bu sayede duvar görseli, video 
dosyası içerisinde yer alan diğer duvar görüntüsünün içerisinde kırık dökük bir duvar gibi 
bulunmuş olacaktır. 

 

 

7. Effect Controls panelinden Amount to Tint değerini “80” yaparsanız ve Swap Colors 
seçeneğini işaretlerseniz uyguladığınız Tint efekti daha başarılı olacaktır (Görsel 1.7). 

 

Görsel 1.5: Görsel dosyasını konumlandırma 

Görsel 1.7: Efekt Kontrol paneli 

Görsel 1.6: Tint efekti 
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Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneğinden yeni bir 
kompozisyon oluşturuldu. 

  

Kompozisyonda kullanılacak materyal, kompozisyona aktarıldı.   

Camera Tracker sekmesi ile video analiz edildi ve 3D Camera 
Tracker oluşturuldu. 

  

“Duvar” görseli konumlandırılarak üç boyutlu katmana 
dönüştürüldü ve Blending Mode kısmından Overlay seçeneği 
seçildi. 

  

Effects & Presets panelinden Tint efekti uygulandı. Tint 
efektinin parametreleri, Effect Controls panelinden istendiği 
gibi ayarlandı. 

  

Yapılan çalışma, render işlemi ile kaydedildi.   
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İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz. 

2. “GORSELEFEKTDERSI /412” klasöründeki materyalleri programa aktarınız. 

 

 

3. Layer > New > Adjustment Layer komutları ile kompozisyona Adjustment Layer 
ekleyiniz. Bu katman, boş bir katman olarak görünür. Video veya görsel dosyasına 
uygulayacağınız efekti Adjustment Layer katmanına ekleyerek kontrol edebilirsiniz. Bu 
katmanda yaptığınız değişiklikler, Timeline panelinde Adjustment Layer katmanının 
altında yer alan tüm materyallere etki eder (Görsel 1.8).  

4. Effects & Presets panelinden CC Snowfall efektini Adjustment Layer katmanı üzerine 
uygulayınız. Bu efekt, “kar” efektidir. 

5. Uygulanan CC Snowfall efektinin gerekli ayarlarını Effect Controls panelinden yaparak 
kar yağma efektini istenen şekilde uygulayınız (Görsel 1.9). 

 

 

6. Yeni bir kompozisyon penceresi oluşturunuz ve benzer manzara dosyasını, Import 
seçeneğiyle içe aktarınız. Adjustment Layer oluşturunuz. 

7. Effects & Presets panelinden CC Rainfall  efektini, Adjustmant Layer üzerine sürükle-
bırak yöntemi ile uygulayınız. Uygulanan bu efekt ise yağmur efektidir. 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 2 

KONU 
“CC SNOWFALL” VE “CC RAINFALL” EFEKTLERİNİN  

KULLANIMI 

Görsel 1.8: Kompozisyona Adjustment Layer ekleme 

Görsel 1.9: CC Snowfall efektinin parametreleri 
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8.  Uygulanan CC Rainfall efektinin Effect Controls panelinden gerekli ayarlarını yaparak 
yağmur yağma efektini istenen şekilde uygulayınız. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition >New Composition seçeneğinden yeni bir 
kompozisyon oluşturuldu. 

  

Kompozisyonda kullanılacak materyal, kompozisyona aktarıldı.   

Adjustment Layer oluşturuldu.    

Effects & Presets panelinden CC Snowfall efekti uygulandı. CC 
Snowfall efektinin parametreleri, Effect Controls panelinden 
istenen şekilde ayarlandı.   

  

Effects & Presets panelinden CC Rainfall efekti uygulandı. CC 
Rainfall efektinin parametreleri, Effect Controls panelinden 
istenen şekilde ayarlandı.   

  

Yapılan çalışma, render işlemi ile kaydedildi.   
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İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz. 

2. “GORSELEFEKTDERSI /413” klasöründeki materyalleri programa aktarınız. 

3. Yeşil perde videosunu kompozisyon paneline yerleştiriniz ve Effects & Presets kısmında 
yer alan Keylight (kiylayt) efektini kullanarak yeşil olan kısımları siliniz.   

4. Yeşil olan kısımları silmek için, Effect Controls kısmında yer alan Keylight efektinin 
parametrelerini kullanınız. Screen Colour kısmında yer alan Damlalık aracını seçiniz ve 
silinmek istenen yeşil kısma tıklayınız (Görsel 1.10). 

 

 

5. Arka plan olarak belirlenen görseli kompozisyona konumlandırınız.  

6. Effects & Presets kısmında yer alan CC Scatterize (si si sketırayz) efektini, arka kısmı 
silinen videoya sürükle-bırak yöntemi ile uygulayınız (Görsel 1.11).  

7. Effect Controls kısmında yer alan CC Scatterize efektinin parametrelerini kullanınız. 
Scatter kısmının Keyframe [kiyfreym (anahtar kare)] noktasını açınız. Zaman Çubuğu’nu 
2. saniyeye alınız ve Scatter kısmının değerini “0” olarak belirleyiniz. Zaman Çubuğu’nu 
4. saniyeye alınız ve Scatter kısmının değerini “200” yapınız.  

8. En üstte yer alan katmanın Opacity [opesıti (opaklık)] bölümünü açınız ve 3. saniyeye 
Opacity değerini “100” olarak giriniz. Zaman Çubuğu’nu, 4. saniyeye alınız ve Opacity 
değerini “0” olarak giriniz. Yaptığınız animasyonu Prewiew [priviyuv (ön izleme)] 
panelinden izleyiniz. 

 

 

 

 

 

 

 

 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 3 

KONU 
“KEYLIGHT” VE “CC SCATTERIZE” EFEKLERİNİN 

KULLANIMI 

Görsel 1.10: Keylight efektinin uygulanması 
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Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneğinden yeni bir 
kompozisyon oluşturuldu. 

  

Kompozisyonda kullanılacak materyaller kompozisyona 
aktarıldı. 

  

Keylight efekti uygulanarak yeşil olan kısımlar yok edildi.     

CC Scatterize efekti uygulandı.    

Scatter Keyframe noktaları ile animasyon oluşturuldu.   

Yapılan çalışma, render işlemi ile kaydedildi.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Görsel 1.11: CC Scatterize efektinin uygulanması 
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İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz. 

2. “GORSELEFEKTDERSI /414” klasöründeki materyalleri programa aktarınız. 

3. Aktarılan görseli kompozisyon penceresine konumlandırınız. Timeline penceresinde 
nesneyi, Duplicate [dupliket (çiftleme)] komutu ile kopyalayınız. Üstte yer alan komuta 
iki kez tıklayarak ayrı bir katman olarak açınız.  

4. Farklı katmanda açılan nesneyi Roto Brush Tool ile seçiniz (Görsel 1.12).  

 

 

5. Kompozisyon penceresinde yer alan Freeze [friiz (dondur)] düğmesine tıklayarak Roto 
Brush Tool işlemini tamamlayınız.  

6. Timeline’da üst katmanda yer alan görsel dosyasına farenin sağ tuşuyla tıklayarak Layer 
Styles [leyır stayls (katman stilleri)] > Outer Glow [autır glov (dış parıltı)] komutları ile 
Glow efektini uygulayınız (Görsel 1.13).  

 

 

 

 

 

 

 

 

 

 

 

 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 4 

KONU “GLOW” EFEKTİNİN KULLANIMI 

Görsel 1.12: Roto Brush Tool ile nesneyi seçme 
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7. Timeline panelinde, Outer Glow ayarlarından Glow efekti parametrelerini düzenleyiniz 
(Görsel 1.14). 

 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneğinden yeni bir 
kompozisyon oluşturuldu. 

  

Kompozisyonda kullanılacak materyaller kompozisyona 
aktarıldı. 

  

Görsel 1.13: Glow efektinin uygulanması 

Görsel 1.14: Glow efektinin parametreleri 
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Timeline penceresinde nesne, Ctrl+D komutu ile kopyalandı.    

Kopyalanan nesne, Roto Brush Tool ile ayrıştırıldı ve efekt 
uygulanmak için hazırlandı.  

  

Görsele farenin sağ tuşuyla tıklanarak Layer Styles > Outer 
Glow komutları ile Glow efekti uygulandı. Glow efektinin 
parametreleri düzenlendi.  

  

Yapılan çalışma render işlemi ile kaydedildi.   
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İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz. 

2. “GORSELEFEKTDERSI /415” klasöründeki materyali programa aktarınız. 

3. Layer > New > Adjustment Layer komutlarını kullanarak taşıyıcı katman oluşturunuz ve 
Timeline penceresinde en üste konumlandırınız. 

4. Video dosyasını kompozisyon penceresine konumlandırınız. 

5. Adjustmant Layer seçili iken video dosyasındaki herhangi bir kısmı Pen Tool (mürekkepli 
kalem aracı) ile maskeleyiniz (Görsel 1.15). 

 

 

6. Maskeleme işleminden sonra Effects & Presests panelinden Gaussian Blur [gausiyın blur 
(gaus bulanıklığı)] efektini Adjustment Layer üzerine uygulayınız. Bu efekt, istenen 
bölgeyi veya kompozisyonun tamamını bulanıklaştırır.  

7. Effect Controls panelinden Blurriness (bulanıklık) kısmını, istenen bir değere getiriniz. Bu 
kısımdan bulanıklığın seviyesini ayarlayınız.  

8. Adjustment Layer üzerinde Transform bölümünü açınız. Position bölümünün Keyframe 
kısmını aktifleştiriniz. “0” (sıfır) saniyeye Anahtar Kare ekleyiniz. Video dosyası süresince 
belirli aralıklarla Anahtar Kare ekleyerek bulanıklığın videoyu takip etmesini sağlayınız 
(Görsel 1.16).  

 

 

 

 

 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 5 

KONU 
“ADJUSTMENT LAYER” İLE “BLUR” EFEKTİNİN 

KULLANIMI 

Görsel 1.15: Adjustmant Layer’ın maskelenmesi 
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Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneğinden yeni bir 
kompozisyon oluşturuldu. 

  

Kompozisyonda kullanılacak materyal, kompozisyona aktarıldı.   

Layer > New > Adjustment Layer komutları kullanılarak taşıyıcı 
katman oluşturuldu.  

  

Pen Tool ile maskeleme işlemi yapıldı. Gaussian Blur efekti 
uygulandı. 

  

Blurriness kısmından bulanıklık değeri ayarlandı. Anahtar 
Kareler ile animasyon oluşturuldu. 

  

Yapılan çalışma, render işlemi ile kaydedildi.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Görsel 1.16: Blur efektinin Anahtar Kareler ile uygulanması 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 

İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz. 

2. Layer > New > Text komutlarını kullanarak bir Text Layer (yazı katmanı) oluşturunuz. Bu 
katmana herhangi bir yazı yazınız ve Kompozisyon paneline istediğiniz şekilde 
konumlandırınız.  

3. Yazıyı oluşturduktan sonra Timeline paneline geliniz. Text Layer katmanına farenin sağ 
tuşu ile tıklayınız ve çıkan menüden Create Masks from Text sekmesini seçiniz (Görsel 
1.17). 

 

 

4. Bu işlemden sonra Timeline panelinde yeni bir katman oluşur. Bu yeni oluşan katmana 
Effect > Generate [cenıreyt (oluştur)] > Stroke (fırça darbesi) efektini uygulayınız.  

5. Yazı katmanının arkasına herhangi bir arka plan ekleyiniz. 

6. Stroke efekti için Effect Controls panelinden Paint Style bölümünde, Reveal Original 
Image [rıviyıl oricinıl imic (orijinal görseli öne çıkar)] seçeneğine tıklayınız.  

7. All Masks kutucuğunu işaretleyiniz. Brush Size [braş sayz (fırça boyutu)] bölümünü 
yüksek bir değere getiriniz (Görsel 1.18). 

8. End yazan kısmın Keyframe kutucuğunu aktifleştiriniz. Zaman Çizelgesi’ni “0” (sıfır) 
saniyeye getiriniz ve buraya bir Anahtar Kare ekleyiniz. End bölümüne “0” (sıfır) yazınız. 
Zaman Çizelgesi’ni 3. saniyeye getiriniz ve End bölümüne “100” yazınız. Buraya da 
otomatik olarak bir anahtar kare eklenir. 

 

 

 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 6 

KONU “STROKE” EFEKTİNİN KULLANIMI 

Görsel 1.17: “Create Masks from Text” komutunun uygulanması 
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Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneğinden yeni bir 
kompozisyon oluşturuldu. 

  

Kompozisyonda kullanılacak materyal, kompozisyona aktarıldı.   

Layer > New > Text komutları kullanılarak bir Text Layer 
oluşturuldu ve Create Masks from Text sekmesi ile yeni bir 
katman oluşturuldu.  

  

Effect > Generate > Stroke komutları ile Stroke efekti eklendi. 
Effect Controls kısmından gerekli düzenlemeler yapıldı.  

  

End kısmından Anahtar Kareler ile animasyon oluşturuldu.    

Yapılan çalışma, render işlemi ile kaydedildi.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Görsel 1.18: Stroke efektinin uygulanması 
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İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz. 

2. “GORSELEFEKTDERSI /417” klasöründeki videoyu programa aktarınız. 

3. Video dosyasını Kompozisyon penceresine konumlandırınız.  

4. Window > Tracker komutları ile Tracker panelini açınız. Açılan panelden Track Camera 
düğmesini işaretleyiniz ve video dosyasını analiz ediniz (Görsel 1.19). 

 

 

5. Analiz işlemi bittikten sonra ekranda Solving Camera (kamera çözümleme) uyarısı belirir 
ve birkaç saniye sonra bu uyarı kaybolur. 

 

 

6. Video dosyasının istenen kısımlarına farenin sol tuşu ile tıklayınız ve ortaya çıkan kırmızı 
daireyi konumlandırınız. Kırmızı dairenin üzerine farenin sağ tuşuyla Create Text and 
Camera seçeneğine veya Create Solid and Camera seçeneğine tıklayınız (Görsel 1.20). 

7. Text seçildiği zaman istediğiniz yere istediğiniz yazıyı yazabilir ve yazıyı kamera ile 
hareket ettirebilirsiniz.  

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 7 

KONU “KAMERA TRACKING” UYGULAMASI 

Görsel 1.19: Camera Tracker işleminin uygulanması 

Görsel 1.20: Create Text ve Create Solid oluşturma 
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8. Timeline penceresinde oluşturduğunuz Solid katmanlara farenin sağ tuşuyla tıklayarak 
Pre-Compose [prekompoz (ön düzenleme)] seçeneğine tıklayınız ve ana kompozisyona 
bağlı bir kompozisyon oluşturunuz (Görsel 1.21). 

 

 

9. Oluşturduğunuz kompozisyona çift tıklayınız ve kompozisyonu açınız. İstediğiniz görseli 
veya video dosyasını bu kompozisyona yerleştiriniz.  

10. Oluşturduğunuz kompozisyonu Prewiew penceresinden izleyiniz (Görsel 1.22).  

 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneğiyle yeni bir 
kompozisyon oluşturuldu. 

  

Kompozisyonda kullanılacak materyal, kompozisyona aktarıldı.   

Window > Tracker komutları ile Tracker paneli açıldı. Açılan 
panelden Camera Tracker düğmesi işaretlendi. Analiz işlemi 
yapıldı. 

  

Create Text and Camera ve Create Solid and Camera 
seçenekleri kullanılarak istenen kısımlara uygulandı.  

  

Görsel 1.21: Pre-Compose oluşturma 

Görsel 1.22: Camera Tracking uygulaması 
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Solid katmanlara farenin sağ tuşuyla tıklanarak Pre-Compose 
seçildi ve ana kompozisyona bağlı kompozisyon oluşturuldu. 

  

Yapılan çalışma, render işlemi ile kaydedildi.   
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İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz. 

2. “GORSELEFEKTDERSI /418” klasöründeki videoyu programa aktarınız ve kompozisyona 
konumlandırınız.  

3. Curves efektini, Effect > Color Correction [kalır korekşın (renk doğrulama)] > Curves 
[körvıs (kıvrımlar)] komutları ile video dosyasına uygulayınız.  

4. Effect Controls paneline Curves efektinin parametreleri gelir (Görsel 1.23). 

 

 

5. Ortada yer alan çizgi üzerine noktalar ekleyerek efekti kontrol ediniz. Çizginin üst kısmı, 
parlak alanları kontrol eder. Alt kısım, karanlık alanların rengini değiştirmeye yarar. Orta 
kısım ise orta tonları kontrol eder. Bu şekilde istediğiniz kısmın renk yoğunluğunu 
ayarlayınız ve renk tonlarını değiştiriniz (Görsel 1.24). 

 

 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 8 

KONU 
“CURVES” VE “LEAVE COLOR” EFEKTLERİNİN 

KULLANIMI 

Görsel 1.23: Curves efekti ayarları 

Görsel 1.24: Curves ile renk ayarlama 
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6. Yeni bir kompozisyon oluşturunuz. 

7. Curves efekti için içe aktardığınız video dosyasını bu uygulamada da kullanabilirsiniz. 

8. Video dosyasını kompozisyon penceresine konumlandırınız. 

9. Leave Color efektini, Effect > Color Correction > Leave Color komutlarını kullanarak 
video dosyasına uygulayınız (Görsel 1.25).  

10. Effect Controls panelinden Sahne’de kalmasını istediğiniz rengi Damlalık aracı ile seçiniz. 
Amount to Decolor [emaunt to dikalır (renksizleştirme miktarı)] sekmesinde yer alan 
sayı artırıldıkça Sahne’de sadece seçilen renk kalır ve diğer renkler “siyah beyaz” tonlara 
bürünür.  

 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneğinden yeni bir 
kompozisyon oluşturuldu. 

  

Kompozisyonda kullanılacak materyal, kompozisyona aktarıldı.   

Curves efekti, Effect > Color Correction > Curves komutları ile 
uygulandı. Effect Controls panelinden gerekli düzenlemelere 
yapıldı. 

  

Leave Color efekti, Effect > Color Correction > Leave Color 
komutları kullanılarak video dosyasına uygulandı. 

  

İstenen renk Sahne’de bırakıldı ve Leave Color efekti başarılı bir 
şekilde uygulandı.  

  

Yapılan çalışma, render işlemi ile kaydedildi.   

 

 

 

 

 

 

Görsel 1.25: Leave Color efektinin uygulanması 
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ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
BİLGİ YAPRAĞI 

KONU 2. SAHNE’DE KAMERA 

2.1. Sahne’ye Kamera Ekleme  

Sahne’ye eklenen kamera ile 3D objelerin arasında hareket edilebilir, gezilebilir ve açıları 
görülebilir. Eklenen kamera ile “kamera animasyonları” oluşturulur. 

 

 

Sahne’ye iki farklı şekilde kamera eklenir. İlk yöntem, Layer > New > Camera komutlarının 
kullanılmasıdır (Görsel 2.1).  

 

 

İkinci yöntem ise Composition ve Timeline panellerinde iken farenin sağ tuşuna tıklanarak New 
> Camera komutlarının kullanılmasıdır (Görsel 2.2).  

 

 

 

 

 

Görsel 2.1: Yeni kamera oluşturma 

Görsel 2.2: Yeni kamera oluşturma 
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Kamera ekleme komutu uygulandıktan sonra açılan pencere, “kamera ayarları ekranı” 
penceresidir (Görsel 2.3). Bu kısımda yer alan type [tayp (tip)] bölümü, kameranın çeşidinin belirlendiği 
kısımdır. Name kısmı ile kamera isimlendirilir. Preset kısmında ise kameranın Sahne’ye hangi lens ile 
bakacağı belirlenir. Sahne için uygun olan ayarlar yapıldıktan sonra OK düğmesine basılarak kamera 
Sahne’ye eklenir.  

2.2. Kamera Çeşitleri 

Görsel efekt programında bulunan kamera bölümünde iki adet kamera çeşidi mevcuttur. Kamera 
çeşitleri şunlardır: 

2.2.1. One-Node Camera  

Bu tür kamerada odak noktası (point of interest) bulunmaz.  

2.2.2. Two-Node Camera  

Bu tür kamerada odak noktası (point of interest) bulunur (Görsel 2.4). 

 

 

Görsel 2.3: Kamera ayarları 

Görsel 2.4: Kamera çeşitleri arasında bulunan fark 
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2.3. Kamera Araçları  

 

Kamera araçları ile kamera; “x,y,z” doğrultularında hareket ettirilebilir, kendi ekseni etrafında 
döndürebilir ya da istendiği gibi konumlandırılabilir (Görsel 2.5). 

Kamera araçları ile işlem yapabilmek için yukarıda görülen kamera simgesine tıklanmalıdır. 
Kısayolu, klavyede yer alan C tuşudur. Alt kısımlarda yer alan diğer kamera araçlarının kullanılabilmesi 
için kamera simgesi basılı tutulmalıdır. Basılı tutularak açılan pencerede istenen araca geçiş yapılabilir. 
Kısayol ile geçiş yapmak için C tuşuna tek tek basılarak işlem gerçekleştirilir. 

2.3.1. Unified Camera Tool [Yunifayd Kemıra Tul (Birleştirilmiş Kamera Aracı)] 

Kameranın hareket ettirilmesi işlemlerinin tamamı, Unified Camera Tool ile yapılabilir. Farenin 
sol tuşu basılı tutularak Orbit Camera Tool işlemi yapılır. Yine farenin sağ tuşu basılı tutulup fare ileri geri 
hareket ettirilerek zoom in ve zoom out işlemleri gerçekleştirilir. Farenin tekerleği basılı tutularak ve fare 
hareket ettirilerek kameraya pan ve tilt hareketleri yaptırılabilir. Burada unutulmaması gereken nokta; 
ekranda üç boyutlu hareketin, Sahne değil; kameranın açısı ve konumu değiştirilerek sağlanmasıdır. 
Kameranın gördüğü obje veya objelerle ilgili bir işlem, kamera araçlarında söz konusu değildir. 

2.3.2. Orbit Camera Tool (Yörünge Kamera Aracı) 

Orbit Camera Tool komutu ile kamera, kendi ekseni etrafında hareket ettirilir. Kamera, farenin 
sol tuşu basılı tutularak ve fare hareket ettirilerek istenen şekilde konumlandırılır. 

2.3.3. Track XY Camera Tool 

Kameranın x ve y eksenlerinde hareket ettirilmesine olanak sağlayan araçtır. Track xy Camera 
Tool ile pan ve tilt hareketleri yapılır. 

2.3.4. Track Z Camera Tool 

Bu araç ile kamera, z ekseninde hareket ettirilir. Kamera ile kaydırma hareketleri, bu komut 
kullanılarak yapılır.  

 

 

 

 

 

Görsel 2.5: Kamera araçları 
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İşlem Basamakları 

1. Yeni bir kompozisyon penceresi açınız. 

2. “GORSELEFEKTDERSI /421” klasöründeki materyalleri programa aktarınız. 

3. Orman fotoğrafını, yeni oluşturulan kompozisyona “arka plan” olarak                     
ekleyiniz (Görsel 2.6). 

 

 

4. Tüm katmanları üç boyutlu katmana dönüştürünüz ve Motion Blur özelliğini aktif hâle 
getiriniz. 

5. Sahne’ye Layer > New > Camera komutlarını kullanarak 35mm lense sahip Two-Node 
Camera ekleyiniz. 

6. Kamera görünümünü 2 views yapınız. 

 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 1 

KONU KAMERA İLE 3D ANİMASYON 

Görsel 2.6: Uygulama kompozisyonu oluşturma 

Görsel 2.7: Kamerayı konumlandırma 

 
http://kitap.
eba.gov.tr/K
odSor.php?K
OD=20893 

http://kitap.eba.gov.tr/KodSor.php?KOD=20893
http://kitap.eba.gov.tr/KodSor.php?KOD=20893
http://kitap.eba.gov.tr/KodSor.php?KOD=20893
http://kitap.eba.gov.tr/KodSor.php?KOD=20893
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7. Üstte yer alan görsele göre katmanların derinlik ayarlarını yapınız ve pozisyonlarını 
ayarlayınız.  

8. Görsellerin pozisyon ayarlarını yaptıktan sonra kompozisyona, Text Layer kullanarak 
“orman” yazısı ekleyiniz. 

9. “Orman” yazısını ve arka planda yer alan orman görselini, 2 views-horizontal 
penceresini kullanarak aşağıda yer alan görseldeki gibi konumlandırınız. 

 

 

10. Kameranın Position kısmını açınız. Position kısmında Anahtar Kare’yi aktif hâle getiriniz. 

11. Zaman Çizelgesi’ni 4. saniyeye alınız ve kamerayı Track z hareketi ile “orman” yazısına 
doğru ilerletiniz. Track z yaparak ön kısımda yer alan bitkilerin arasından geçiniz, arka 
planda yer alan “orman” yazısına doğru ilerletiniz ve hareketi istenen bir noktada 
sonlandırınız (Görsel 2.9). 

12. Animasyonu Preview penceresinden izleyiniz.  

13. Export (dışa aktarma) kısmından alınan çıktıyı bilgisayara kaydediniz. 

 

 

 

Görsel 2.8: Kamera görünüm penceresini düzenleme 

Görsel 2.9: Anahtar Kareler ile animasyon oluşturma 
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Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneğiyle yeni bir 
kompozisyon oluşturuldu. 

  

Kompozisyonda kullanılacak materyaller, kompozisyona 
aktarıldı. 

  

Materyaller konumlandırıldı ve üç boyutlu nesneye 
dönüştürüldü. Motion Blur seçeneği aktif hâle getirildi. 

  

Layer > New > Camera komutları kullanılarak 35mm lense 
sahip, Two-Node Camera eklendi. 

  

Text layer kullanılarak Sahne’ye yazı eklendi ve istenen konuma 
yerleştirildi. 

  

Track z kamera komutu kullanılarak animasyon oluşturuldu.    

Yapılan çalışma, render işlemi ile kaydedildi.    
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İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz. 

2. “GORSELEFEKTDERSI /422” klasöründeki fotoğrafları programa aktarınız. 

3. Layer > New > Solid komutlarını kullanarak kompozisyona Solid Layer ekleyiniz           
arka plan olarak ayarlayınız. Tüm görselleri ve Solid katmanları 3D’ye çeviriniz.  

4. Görsellerin konumlarını ve derinliklerini ayarlayınız (Görsel 2.10).  

 

 

5. Layer > New > Camera komutlarını kullanarak 50 mm lense sahip Two-Node Camera 
oluşturunuz. 

6. Layer > New > Null Object (boş nesne) komutlarını kullanarak bir Null Object 
oluşturunuz ve Null Object’i 3D’ye çeviriniz.  

 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 2 

KONU KAMERAYI NULL OBJECT’E BAĞLAMA 

Görsel 2.10: Materyalleri kompozisyonda konumlandırma 

Görsel 2.11: Null Object ile kamerayı birbirine Parent yapma 

 
http://kitap.
eba.gov.tr/K
odSor.php?K
OD=20894 

http://kitap.eba.gov.tr/KodSor.php?KOD=20894
http://kitap.eba.gov.tr/KodSor.php?KOD=20894
http://kitap.eba.gov.tr/KodSor.php?KOD=20894
http://kitap.eba.gov.tr/KodSor.php?KOD=20894
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7. Oluşturulan kamerayı, görselde görülen Parents kısmından Null Object’e bağlayınız. 
Bundan sonraki kısımda kamera ile başka herhangi bir işlem yapılmayacağı için kamerayı 
kilitleyiniz (Görsel 2.11). 

 

 

8. Null Object’in transform kısmından tüm bölümlere ait Anahtar Kareler’i aktif hâle 
getiriniz (Görsel 2.12). Timeline bölümünden zaman çizelgesini 3. saniyeye alınız ve ilk 
görsele doğru zoom (yakınlaştırma) yapınız. Yakınlaştırma yaparak ilk görselin arkasına 
geçiniz ve o kısma bir Anahtar Kare ekleyiniz.  

9. Zaman Çizelgesi’ni 4. saniyeye alınız. İkinci görsele doğru pan (kaydırma) hareketi 
yapınız ve o kısma da bir Anahtar Kare ekleyiniz.  

 

 

10. Zaman Çizelgesi’ni 5.saniyeye alınız, üçüncü görsele doğru zoom ve pan yapınız. Son 
Anahtar Kare’yi de buraya ekleyiniz. Oluşturduğunuz animasyonu Preview penceresinde 
izleyiniz (Görsel 2.13). 

Yapılan çalışmayı kaydediniz.  

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneğiyle yeni bir 
kompozisyon oluşturuldu. 

  

Kompozisyonda kullanılacak materyaller, kompozisyona 
aktarıldı. 

  

Görsel 2.12: Null Object’in transform özellikleri 

Görsel 2.13: Anahtar Kareler ile animasyon oluşturma 
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İstenen özelliklerde Solid katman ve kamera oluşturuldu. 
Sahne’ye konumlandırıldı ve üç boyutlu katmana dönüştürüldü.  

  

Layer > New > Null Object komutları kullanılarak bir Null 
Object oluşturuldu ve bu Null Object, 3D’ye dönüştürüldü. 

  

Parents düğmesi ile kamera ve Null Object, birbirine bağlandı.    

Null Object ile istenen animasyon oluşturuldu.    

Yapılan çalışma render işlemi ile kaydedildi.   
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 

İşlem Basamakları 

1. İlk olarak yeni bir kompozisyon oluşturunuz. 

2. Kompozisyon oluşturulduktan sonra Layer > New > Text komutlarını kullanarak Sahne’ye 
bir yazı ekleyiniz (Görsel 2.14). 

 

 

3. Sahne’ye “Görsel Efekt Teknikleri” yazısını ekleyiniz. Yazıyı yazdıktan sonra Text Layer’ı 
üç boyutlu katman olarak ayarlayınız ve Layer > New > Camera komutlarını kullanarak 
“35 mm lens ölçüsüne sahip One-Node Camera”yı Sahne’ye ekleyiniz (Görsel 2.15). 

 

 

4. Kamerayı Sahne’ye ekledikten sonra Timeline panelinde yazının Transform özellikleri 
kısmından Y Rotation [roteyşın (dönüş)] sekmesinin Anahtar Kare bölümünü aktif hâle 
getiriniz ve animasyona başlayınız (Görsel 2.16). 

 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 3 

KONU YAZILAR İLE KAMERA ANİMASYONU UYGULAMASI  

Görsel 2.14: Sahne’ye Yazı katmanı ekleme 

Görsel 2.15: Sahne’ye yeni kamera ekleme 

Görsel 2.16: Y Rotation Keyframe (Anahtar Kare) kullanarak animasyon oluşturma 
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5. Zaman çizelgesini 1. saniyeye alınız. Zaman Çizelgesi’ni 1. saniyeye almanın en kısa ve 
kolay yolu, Timeline penceresinde yer alan ve aşağıda resmi görünen kısma “100” 
yazmaktır. “100” yazıldığı anda görsel efekt programı, Zaman Çizelgesi’ni otomatik 
olarak 1. saniyeye ayarlayacaktır (Görsel 2.17). 

 

 

6. Zaman Çizelgesi 1. saniyede iken Y Rotation kısmında “açı” yazan bölüme “90” yazınız 
ve Enter tuşuna basınız. Bu sayede 1. saniyeye bir Anahtar Kare eklenir. 

7. Zaman Çizelgesi’ni 2. saniyeye alınız. Yine süre kısmına “200” yazılarak zaman çizelgesi, 
2. saniyeye ilerletilmiş olur. 2. saniyede iken Y Rotation kısmına “180” yazınız ve Enter 
tuşuna basınız. Üçüncü Anahtar Kare noktası, buraya eklenmiş olacaktır. 

 

 

8. Zaman Çizelgesi’ne “300” yazarak çizelgeyi 3. saniyeye alınız. Çizelge 3. saniyede iken Y 
Rotation kısmına “270” yazınız ve dördüncü Anahtar Kare noktasını bu kısma ekleyiniz 
(Görsel 2.18). 

9. Zaman Çizelgesi’ni, 4. saniyeye alınız. Y Rotation kısmına “360” yazarak görseli bir tam 
tur döndürmüş olarak işlemi tamamlayınız. Preview kısmında, oluşturulan animasyonu 
izleyiniz ve animasyonu Export seçeneğiyle bilgisayara kaydediniz.  

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneğinden yeni bir 
kompozisyon oluşturuldu. 

  

Sahne’ye istenen özelliklerde Text Layer eklendi ve üç boyutlu 
katmana dönüştürüldü.  

  

Görsel 2.17: Zaman Çizelgesi 

Görsel 2.18: Keyframe noktaları ile animasyon oluşturma 
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Layer > New > Camera komutları kullanılarak istenen 
özelliklerde kamera Sahne’ye eklendi.  

  

Text Layer’ın Transform kısmında Anahtar Kare bölümü aktif 
hâle getirildi ve Y Rotation kısmında istenen değişiklikler 
yapılarak animasyon oluşturuldu.  

  

Yapılan çalışma, render işlemi ile kaydedildi.   
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İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz. 

2. “GORSELEFEKTDERSI/424” numaralı klasörde bulunan görseli kompozisyona aktarınız. 

 

 

3. Resimde görüldüğü gibi “png” biçiminde bir duvar görseli, uygulama için yeterli olacaktır 
(Görsel 2.19). 

4. Duvarı, üç boyutlu katmana dönüştürünüz ve ismini “sol duvar” olarak yazınız (Görsel 
2.20). 

5. Aynı duvarı, kopyala-yapıştır yöntemi ile “ilk duvarın karşısına gelecek şekilde” 
kopyalayınız. 

 

 

Görselde görülen şekilde konumlandırılan duvarları, Effects & Presets panelinde yer alan Motion 
Tile [movşın tayl (hareket döşeme)] efekti ile uzatınız. Motion Tile efektini sürükle bırak yöntemi ile 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 4 

KONU KAMERANIN AÇISINI AYARLAMA 

Görsel 2.19: Materyalleri kompozisyonda konumlandırma 

Görsel 2.20: “Duvar” görselinin açısını değiştirme 
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uygulayınız ve Output Widht [autput vit (çıktı genişliği)] bölümüne “1200” veya daha üstü bir değer 
girerek duvarları, animasyonu oluşturabilecek şekilde uzatınız (Görsel 2.21). 

 

 

6. Kopyala-yapıştır işlemi ile üst duvarı oluşturunuz (Görsel 2.22). 

 

 

7. Üst duvarı kopyalayarak alt duvarı oluşturunuz (Görsel 2.23). 

 

 

 

 

 

 

 

 

Görsel 2.21: Motion Tile efektinin uygulanması 

Görsel 2.22: Duplicate komutu ile Sahne’nin oluşturulması 
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8. Sol duvarı, kopyala-yapıştır yöntemiyle ve derinlik ayarlamasını yaparak tünelin ucuna 
yerleştiriniz. Bu işlem yapıldıktan sonra tünel tamamlanmış olacaktır (Görsel 2.24).  

 

 

9. Sahne’ye “15 mm lense sahip Two-Node Camera” ekleyiniz (Görsel 2.25). 

10. Kameranın position panelini açınız. Bu kısımda Position paneline “0” (sıfır) saniyede iken 
Anahtar Kare ekleyiniz. Zaman Çizelgesi’ni, 6. saniyeye alınız. Kameranın konumunu 
ileriye doğru taşıyarak derinlik etkisini “görülebilecek şekilde” değiştiriniz ve yeni bir 
Anahtar Kare ekleyiniz. Oluşturulan animasyonu Preview penceresinden izleyiniz. 

 

 

 

 

 

 

 

 

Görsel 2.23: Duplicate komutu ile Sahne’nin oluşturulması 

Görsel 2.24: Oluşturulan kompozisyonun tamamlanması 
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11. Çalışmayı Export seçeneğiyle bilgisayara kaydediniz.  

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneğinden yeni bir 
kompozisyon oluşturuldu. 

  

Kompozisyonda kullanılacak materyal, kompozisyona aktarıldı.   

Effects & Presets panelinde yer alan Motion Tile efekti 
uygulanarak kompozisyonda istenen etki oluşturuldu.  

  

Duvar görseli, Duplicate komutu ile kopyalandı ve 
kompozisyonda istenen şekildekonumlandırıldı.  

  

“15 mm lense sahip Two-Node Camera”, kompozisyona 
eklendi.  

  

Kameranın Position Keyframe kısımları aktif hâle getirildi ve 
istenen animasyon oluşturuldu.  

  

Yapılan çalışma render işlemi ile kaydedildi.   

 

 

 

 

 

 

 

 

 

 

 

 

Görsel 2.25: Sahne’ye kamera yerleştirme 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 

İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz. 

2. Açılan kompozisyona Layer > New > Solid komutlarını kullanarak istenen renkte bir Solid 
Layer ekleyiniz.  

3. Solid Layer ekleme işlemi bittikten sonra Ellipse Tool’u kullanarak kompozisyona “daire” 
çizimi yapınız (Görsel 2.26). Çizilen daireyi, kopyala-yapıştır yöntemi ile iki defa daha 
kopyalayıp toplamda üç adet Shape Layer [şeyp leyır (şekil katmanı)] oluşturunuz. 

 

 

4.  Oluşturulan şekil katmanlarını üç boyutlu katmana dönüştürünüz. Çünkü kameranın 
Sahne’de çalışabilmesi için kompozisyonda üç boyutlu katmanlara ihtiyaç 
bulunmaktadır. 

 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 5 

KONU KAMERANIN “SHAPE LAYER” İLE KULLANIMI  

Görsel 2.26: Kompozisyona Shape Layer ekleme 

Görsel 2.27: Sahne’ye kamera ekleme 
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5. Çemberleri yukarıdaki görselde olduğu gibi konumlandırınız ve renklendiriniz (Görsel 
2.27).  

6. Layer > New > Camera komutlarını kullanarak Sahne’ye “50 mm lense sahip Two-Node 
Camera” ekleyiniz.  

7. Views sekmesinden görünüşü 2 views-horizontal formatına dönüştürünüz. 

8. Çemberlere derinlik veriniz. İlk çemberin derinlik değerini “0”, ikinci çemberin derinlik 
değerini “4000”, üçüncü çemberin derinlik değerini ise “6000” olarak ayarlayınız (Görsel 
2.28). 

 

 

9.  Kamera katmanını seçerek alt seçeneklerde bulunan Camera Options kısmını açınız. 
Depth of Field (alan derinliği) kısmını off konumundan on konumuna çeviriniz ve bu 
kısmı aktifleştiriniz. Depth of field, Camera Options kısmında yer alan Aperture [aperçır 
(açıklık, diyafram)] seçeneği ile değiştirilebilir. Aperture seçeneğinin standart değeri, 
“100”dür. Alan derinliği verilmek istendiğinde bu değerin artırılması gerekir. Alan 
derinliğinde daha arkada yer alan nesne, bulanık olarak görünür ve o nesneye 
yaklaşıldıkça bulanıklık, yerini netliğe bırakır (Görsel 2.29). 

 

 

Görsel 2.28: Şekil katmanlarının (Shape Layer) konumlandırılması  

Görsel 2.29: Sahne’de alan derinliği oluşturma 
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10. Kameranın Position sekmesinde Anahtar Kare kısmını aktifleştiriniz. Zaman Çizelgesi’ni 
1. saniyeye alınız. Kameranın konumunu, en önde yer alan nesne netleşene kadar 
ilerletiniz.  

11. Zaman Çizelgesi’ni 2. saniyeye alınız ve kameranın konumunu, Track z komutunu 
kullanarak ve ikinci sırada yer alan nesne net olana kadar ileri doğru alınız. Görsel efekt 
programı, değişiklik yapılan zaman dilimine otomatik olarak yeni bir Anahtar Kare 
oluşturacaktır (Görsel 2.30). 

12. Zaman Çizelgesi’ni 3. saniyeye alınız ve kameranın konumunu, Track z komutunu 
kullanarak ve en arkada yer alan nesne netleşene kadar ileri doğru alınız. Bu işlemlerden 
sonra animasyonu Preview penceresinde izleyiniz.  

 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneğinden yeni bir 
kompozisyon oluşturuldu. 

  

Sahne’ye Solid Layer eklendi ve Ellipse Tool kullanılarak istenen 
daireler oluşturuldu. 

  

Daireler ve arka plan, üç boyutlu katmana dönüştürüldü.    

Sahne, Views sekmesinden 2 views-horizontal biçimine 
dönüştürüldü. 

  

Depth of Field seçeneği ile Sahne’ye alan derinliği verildi.    

Kamera araçları kullanılarak istenen animasyon oluşturuldu.    

Yapılan çalışma, render işlemi ile kaydedildi.   

 

 

 

 

 

 

Görsel 2.30: Animasyonun oluşturulması 
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ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
BİLGİ YAPRAĞI 

KONU 3. SAHNE’DE IŞIK 

3.1. Sahne’ye Işık Ekleme 

Kompozisyona eklenen ışık kaynakları ile kompozisyon aydınlatılır, ışık animasyonları ve ışık 
geçişleri yapılır. Sahne’de konumlandırılarak ya da farklı renkte ve farklı türde ışık kaynakları kullanılarak 
ışığa dramatik etki kazandırılır. Işık, Sahne’ye iki farklı yöntem ile eklenir (Görsel 3.1). 

 

 

Işık kaynağı Sahne’ye ilk olarak Layer > New > Light komutları kullanılarak yerleştirilir. Bu 
komutlar uygulandıktan sonra karşımıza Light Options [layt opşıns (ışık seçenekleri)] penceresi gelecektir 
(Görsel 3.2). 

 

 

Işık ayarları kısmında yer alan Light Type [layt tayp (ışık tipi)] seçeneği ile ışık kaynağının türü 
belirlenir. Intensity (yoğunluk), ışık kaynağının parlaklığının değiştirildiği kısımdır. Burada yer alan sayısal 
değer artırıldıkça ışık kaynağının gücü de artırılmış olacaktır. 

Cone Angle [kon engıl (koni açısı)] seçeneği, ışık kaynağının aydınlatması gereken alanın çapını 
gösteren kısımdır. Değer ne kadar büyük olursa ışık kaynağının aydınlattığı alan o derece büyük olacaktır. 

Görsel 3.1: Sahne’ye ışık ekleme 

Görsel 3.2: Işık ayarları 



 

 

241 

 

Cone Feather [kon fedır (koni yumuşaklığı)] ise ışık konisinin aydınlattığı alanın yumuşaklığını ve sertliğini 
ifade eder. Işık ile sert geçişler veya yumuşak geçişler bu kısımdan ayarlanır. 

Casts Shadows [kests şadovs (gölge atma)] seçeneği, Sahne’ye yerleştirilen ışık kaynağının gölge 
oluşturup oluşturmayacağının belirlendiği kısımdır. Eğer Casts Shadows işaretli ise Sahne’ye yerleştirilen 
ışık kaynağı, kompozisyonda gölge oluşturacaktır. En alt kısımda yer alan OK düğmesine basılarak 
Sahne’ye istenen türde, parlaklıkta ve açıda ışık kaynağı yerleştirilir.  

Sahne’ye ışık yerleştirmek için kullanılan bir diğer yöntem ise Composition ve Timeline 
panellerinde iken farenin sağ tuşuna tıklanarak New > Lights komutunun kullanılmasıdır (Görsel 3.3). 

 

3.2. Işık Tipleri 

Görsel efekt programında dört adet ışık tipi yer almaktadır.  Bu ışık tipleri; paralel, spot, point ve 
ambient (embiyınt) ışık kaynaklarıdır.  

3.2.1. Paralel Işık 

Sahne’den çok uzakta oluşan ışık kaynağıdır. “Güneş” gibi düşünülebilir. Tüm katmanlara aynı 
yoğunlukta ışık verir. Kompozisyonda hareket ettirilerek etkisi incelenir.  

3.2.2. Spot Işık 

Belirli bir alanı aydınlatan ışık kaynağına verilen isimdir.  Spot ışık ile konunun istenen kısımları, 
istendiği kadar aydınlatılır.  

3.2.3. Point Işık 

Noktasal bir ışık kaynağıdır. Çevresinden başlayarak ve etkisini yavaş yavaş yitirerek etrafını 
aydınlatır.  

3.2.4. Ambient Işık 

Ortamın genelini aydınlatmak için kullanılan çok güçlü bir ışıktır. Tüm katmanlara etki etme 
özelliğine sahiptir. 

 

Görsel 3.3: Sahne’ye ışık ekleme 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Çalışmada kullanacağınız resim, video, ses ve çoklu katmanlı içerik taşıyan dosyaları telif 
haklarına dikkat ederek temin ediniz. 

 

İşlem Basamakları 

1. Yeni bir kompozisyon penceresi açınız. 

2. Herhangi bir görsel dosyasını Import seçeneğiyle kompozisyona aktarınız. 

3. Light Settings bölümünde açılan bir ışık kaynağını Layer > New > Light komutlarını 
kullanarak Sahne’ye ekleyiniz (Görsel 3.4). 

 

 

4. Eklenen ışık kaynağının tipi, Spot Light olmalıdır. Intensity; yani parlaklık değerini de 
“100” olarak belirleyiniz (Görsel 3.5).  

 

 

5. Işık kaynağının Sahne’deki etkisini görebilmek için diğer katmanların 3D özelliğinin açık 
olması gerektiği, unutulmaması gereken en önemli noktadır.  

6. Işık kaynağının Transform kısmını açınız. Point of Interest (ilgi noktası) bölümünün 
Anahtar Kare kutucuğunu aktif hâle getiriniz. Zaman Çizelgesi’ni “0” (sıfır) saniyeye 
alınız. Işık kaynağının Point of Interest noktasını Sahne’nin dışına taşıyınız. 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 1 

KONU SPOT IŞIK İLE ÇALIŞMA YAPMA 

Görsel 3.4: Sahne’ye ışık ekleme 

Görsel 3.5: Spot ışığını konumlandırma 
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7. Zaman Çizelgesi’ni 3. saniyeye alınız ve ışık kaynağının Point of Interest noktasını, 
görselin üzerinden geçecek şekilde Sahne’nin diğer kısmına alınız. Görsel efekt programı, 
buraya Anahtar Kare ekleyecektir (Görsel 3.6).  

 

 

8. Oluşturulan animasyonu Preview penceresinde izleyiniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneği ile yeni bir 
kompozisyon oluşturuldu. 

  

Kompozisyonda kullanılacak materyal, kompozisyona aktarıldı.   

Layer > New > Light komutları kullanılarak Sahne’ye spot ışık 
eklendi. 

  

Işık kaynağının Point of Interest seçeneği ile ışığın odak noktası 
hareket ettirildi ve animasyon oluşturuldu.  

  

Yapılan çalışma render işlemi ile kaydedildi.   

 

 

 

 

 

 

 

 

 

 

 

 

 

Görsel 3.6: Point of Interest kısmına Anahtar Kare ekleme 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 

İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz.  

2. Oluşturduğunuz kompozisyona Layer > New > Solid komutları ile koyu renklerde bir 
Solid Layer ekleyiniz.  

3. Text Layer kullanarak Solid Layer katmanının ortasına gelecek şekilde “görsel efekt” 
yazınız.  

4. Oluşturduğunuz katmanları 3D olacak şekilde ayarlayınız. 

5. Sahne’ye ışık ekleyiniz. Eklediğiniz ışığın tipini Point Işık olarak belirleyiniz ve Light 
Settings kısmında yer alan Casts Shadows kutucuğunu işaretleyiniz. Bu kutucuğu 
işaretleyerek yazının gölgesinin Sahne’ye düşmesine izin vermiş olursunuz. Sahne’deki 
ışığın Intensity değeri “100” olarak kalabilir. 

6. Arka planı, derinlik vererek geriye alınız. Yazıyı ise ön kısma doğru hizalayınız. Point ışık 
kaynağını bir “güneş” gibi üst kısma yerleştiriniz. Işık kaynağının gücünü artırdığınızda 
Sahne’yi noktasal bir şekilde aydınlattığını gözlemleyiniz.  

7. Işık kaynağını yazının ön tarafına aldığınız zaman ışığın etkisi ile arka plana doğru 
gölgelerin oluştuğunu gözlemleyiniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneği ile yeni bir 
kompozisyon oluşturuldu. 

  

Solid Layer ve Text Layer katmanları Sahne’ye eklendi ve üç 
boyutlu katmana dönüştürüldü. 

  

Light Settings kısmında yer alan Cast Shadows kutucuğu 
işaretlendi.  

  

Yapılan çalışma render işlemi ile kaydedildi.   

 

 

 

 

 

 

 

 

 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 2 

KONU POINT IŞIK İLE ÇALIŞMA YAPMA 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 

İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz. 

2. Oluşturulan kompozisyonda kullanmak üzere bir “görsel” dosyası yükleyiniz.  

3. Görsel dosyasını 3D şekline dönüştürünüz ve kompozisyona konumlandırınız. Görseli 
Duplicate komutu ile beş kez daha kopyalayınız. Sahne’ye Layer  >New > Light 
komutlarını kullanarak “sarı” renkli ve intensity değeri “100” olan bir spot ışık ekleyiniz.  

4. Sahne’ye “50 mm lense sahip bir kamera” ekleyiniz.  

 

 

5. Görselleri, derinlik verilerek animasyon oluşturulabilecek şekilde konumlandırınız ve 
kamera açısını ayarlayınız (Görsel 3.7). 

6. Kamera ve ışık katmanlarının Transform bölümünden Position Anahtar Kareleri’ni aktif 
hâle getiriniz. “0” saniyeye Anahtar Kare ekleyiniz.  

7. Zaman Çizelgesi’nde zamanı 1. saniyeye getiriniz ve kamerayı kompozisyonda ileri doğru 
alınız. Işık kaynağını önde olan görsel aydınlık olacak şekilde konumlandırınız (Görsel 
3.8). 

 

 

 

 

 

 

 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 3 

KONU 
IŞIK KAYNAĞININ KOMPOZİSYONDA HAREKETİNİN 

SAĞLANMASI 

Görsel 3.7: Sahne’de yer alan görsellerin konumlandırılması 
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8. Zaman Çizelgesi’nde 2. saniyeye ilerleyiniz ve kamerayı önde yer alan görsellerin 
arasından geçirerek arka kısımda yer alan görsellere doğru ilerletiniz (Görsel 3.9). 

9. Işığın konumunu ve aydınlattığı kısmın açısını değiştiriniz.  

 

 

10. Işığın ve kameranın konumunu daha iyi görebilmek için Views panelinden 2 views-
horizontal seçeneğini kullanabilirsiniz. 

11. Zaman Çizelgesi’ni 3. saniyeye alınız ve kamerayı en arkada yer alan görsele doğru 
hareketlendiriniz. Işığın açısını, en arkada yer alan görsel “tamamen görünür” olacak 
şekilde konumlandırınız (Görsel 3.10).  

 

 

 

 

 

 

 

 

 

Görsel 3.8: Sahne’de ışığın hareketinin sağlanması 

Görsel 3.9: Sahne’de ışığın hareketinin sağlanması 
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12. Yaptığınız animasyonu Prewiew panelinden izleyiniz. 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneği ile yeni bir 
kompozisyon oluşturuldu. 

  

Kompozisyonda kullanılacak materyal, kompozisyona aktarıldı.   

Kullanılacak materyal, Duplicate komutu ile kopyalandı. 
Materyaller, kompozisyonda istenen kısımlara konumlandırıldı.  

  

Sahne’ye, istenen özelliklerde spot ışık kaynağı ve kamera 
eklendi. 

  

Kamera ve ışık kaynağı, Sahne içerisinde Anahtar Kareler 
eklenerek hareket ettirildi ve animasyon oluşturuldu. 

  

Yapılan çalışma render işlemi ile kaydedildi.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Görsel 3.10: Kameraya ve ışık kaynağına Anahtar Kare ekleme  
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 

İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz.  

2. Layer > New > Solid komutlarını kullanarak beyaz renkli bir Solid Layer ekleyiniz. 
Eklediğiniz Solid Layer’ı, 3D formata dönüştürünüz ve derinliğini “800” olarak ayarlayınız 
(Görsel 3.11). 

3. Derinlik verilen Solid Layer’ı, Duplicate komutu ile kopyalayınız. Transform > 
Orientation bölümünde X kısmını “90” derece olarak ayarlayınız ve boyunu, “derinlik” 
yönünde uzatınız. 

 

 

4. Layer > New > Light komutlarını kullanarak Intensity değeri “200” olan Spot Light 
ekleyiniz (Görsel 3.12). 

 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 4 

KONU IŞIK İLE ANİMASYON OLUŞTURMA 

Görsel 3.11: Uygulama kompozisyonunun oluşturulması 

Görsel 3.12: Sahneye spot ışığın eklenmesi 
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5. Işığı görselde görüldüğü gibi konumlandırınız. “Ay ışığının geceye doğuşu” gibi bir 
animasyon oluşturunuz (Görsel 3.13). 

 

 

6. Position ve Intensity değerlerine Anahtar Kare ekleyiniz ve Zaman Çizelgesi’ni “0” 
saniyeye alınız (Görsel 3.14). 

7. Zaman Çizelgesi’ni 1. saniyeye alınız ve ışık kaynağını Sahne’nin ortasına doğru 
ilerletiniz. Intensity değerini “3000” gibi yüksek bir değer olarak belirleyiniz.  

8. Zaman Çizelgesi’ni 3. saniyeye alınız. Işık kaynağını, Sahne’yi terk edecek şekilde 
ayarlayınız. Intensity değerini “50”, Cone Angle değerini ise “5” olarak belirleyiniz ve 
animasyonu izleyiniz (Görsel 3.15). 

Görsel 3.13: Spot ışığın Sahne’de konumlandırılması 

Görsel 3.14: Intensity ve Cone Angle ayarları 

Görsel 3.15: Anahtar Kareler ile animasyon oluşturma 
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Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneğinden yeni bir 
kompozisyon oluşturuldu. 

  

Sahne’ye, uygulamada istenen şekilde Solid Layer ve Spot Light 
eklendi. 

  

Işık kaynağının Position ve Intensity değerleri istenen şekilde 
değiştirilerek Anahtar Kare noktaları eklendi.  

  

Işık, kompozisyon içinde hareket ettirilerek animasyon 
oluşturuldu.  

  

Yapılan çalışma render işlemi ile kaydedildi.   
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 

İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz.  

2. İstenen renkte bir Solid Layer oluşturunuz.  

3. Oluşturduğunuz katmanın ortasına gelecek şekilde bir “yazı” yazınız (Görsel 3.16). 

4. Yazı ve Solid Layer’ı, 3D şekline çeviriniz. 

5. Sahne’ye yeni bir ışık ekleyiniz. Işığın türünü, paralel ışık olarak belirlemelisiniz. Bu ışık 
türü Sahne’ye uzun ve paralel bir ışık verecektir. Sahne’ye bir tane de kamera ekleyerek 
Sahne’nin görüş açılarını kontrol edebilirsiniz. 

 

 

6. Arka planı derinlik verilerek geriye alınız çünkü yazının gölgesinin oluşabilmesi için arada 
belirli bir boşluk olmalıdır. 

7. Light Settings penceresinde Casts Shadows bölümünün işaretli olmalısına dikkat ediniz 
(Görsel 3.17). 

 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 5 

KONU IŞIK KAYNAĞI İLE GÖLGE OLUŞTURULMASI 

Görsel 3.16: Kompozisyonun düzenlenmesi 

Görsel 3.17: Işık ayarları bölümü 
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8. Arka planın ve yazının Material Options ayarlarına girerek Casts Shadows kısmını On 
olarak ayarlayınız. Böyle yapılarak yazı ve arka plan, gölge kabul edebilir duruma getirilir 
(Görsel 3.18). 

 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneği ile yeni bir 
kompozisyon oluşturuldu. 

  

Solid Layer eklendi ve üç boyutlu katmana dönüştürüldü.    

Text Layer kullanılarak Sahne’ye “yazı” eklendi.    

Sahne’ye ışık kaynağı yerleştirildi ve Sahne’de konumlandırıldı.   

Casts Shadows bölümü işaretlendi.    

Arka planın ve yazının Material Options ayarlarına girilerek 
Casts Shadows kısmı aktif hâle getirildi.  

  

Yapılan çalışma render işlemi ile kaydedildi.   

 

 

 

 

 

 

 

 

 

 

 

 

Görsel 3.18: Yazı ve ışık ile gölge oluşturma 
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Uygulama Faaliyeti Öncesi Hazırlıklar 

 Uygulama faaliyetine başlamadan önce iş sağlığı ve güvenliği tedbirlerini alınız. 

 

İşlem Basamakları 

1. Yeni bir kompozisyon oluşturunuz.  

2. Koyu renklerde bir Solid Layer oluşturunuz.  

3. Üç adet Text Layer oluşturunuz ve bu katmanlara sırası ile “1000”, “2000”, “3000” 
değerlerini giriniz. Oluşturduğunuz tüm katmanları 3D’ye dönüştürünüz. Text Layer 
katmanlarına derinlik veriniz. 

4. “1000” yazısını “1000” piksel uzaklığa, 2000 yazısını “2000” piksel uzaklığa, “3000” 
yazısını da “3000” piksel uzaklığa konumlandırınız (Görsel 3.19).  

 

 

5. Sahne’ye “100” Intensity değerine sahip bir spot ışık ekleyiniz.  

6. Işığın Position ayarlarını açınız ve Anahtar Kareleri’ni aktif hâle getiriniz. Zaman 
Çizelgesi’ni, “0” (sıfır) saniyeye getiriniz ve ışığın bulunduğu kısma bir Anahtar Kare 
ekleyiniz.  

7. Işığın konumunu değiştiriniz ve Zaman Çizelgesi’ni, alt kısımda yer alan sayılar 
görünmeyecek biçimde 1. saniyeye alınız (“3000” sayısı, kompozisyonda 
görünmemelidir.) (Görsel 3.20). 

 

 

 

 

 

ÖĞRENME BİRİMİ GÖRÜNTÜ EFEKTLERİNİN OLUŞTURULMASI 
UYGULAMA 
YAPRAĞI 6 

KONU IŞIĞIN KONTROLÜNÜN SAĞLANMASI 

Görsel 3.19: Çalışma kompozisyonunun oluşturulması 
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8. Zaman Çizelgesi’ni 2. saniyeye alınız ve ışığın konumunu, sadece “1000” yazısı 
görünecek şekilde değiştiriniz. Anahtar Kare ekledikten sonra Zaman Çizelgesi’ni 3. 
saniyeye alınız ve ışığı, hiçbir noktayı aydınlatmayacağı bir yere taşıyınız (Görsel 3.21). 

 

 

Uygulamaya İlişkin Değerlendirmeler 

Yapacağınız çalışmanın değerlendirilmesinde aşağıdaki kontrol listesi kullanılacaktır.  

Kontrol Listesi Evet Hayır 

Composition > New Composition seçeneğiyle yeni bir 
kompozisyon oluşturuldu. 

  

Sahne’ye Solid Layer ve Text Layer eklendi ve bu katmanlar, üç 
boyutlu katmana dönüştürüldü. 

  

Görseller, Sahne’de istenen şekilde konumlandırıldı.    

Kompozisyona ışık kaynağı eklendi ve ışık kaynağı ile istenen 
animasyonlar oluşturuldu.  

  

Yapılan çalışma render işlemi ile kaydedildi.   

Görsel 3.20: Işık kaynağının konumunun değiştirilmesi 

Görsel 3.21: Işık kaynağı ile animasyon oluşturma 
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Görsel Kaynakça 

1.Öğrenme Birimi: Görsel Efekt Programında Temel Düzenlemeler 

 Görsel:1.1, 2.1, 2.2, 2.3, 2.4, 2.5, 2.6, 2.7, 2,8, 3.1, 3.2, 3.3, 3.4, 3.5, 3.6, 3.7, 3.8, 4.1, 4.2, 
4.3, 4.4, 4.5, 4.6, 4.7, 5.1, 5.2, 5.3 komisyon tarafından hazırlanmıştır. 

2.Öğrenme Birimi: Hareketli Görüntüler 

 Görsel 1.1, 1.2, 1.3, 1.4, 1.5, 1.6, 1.7, 1.9, 1.10, 1.11, 1.12, 1.13, 1.14, 1.15, 1.16, 1.17, 
1.18, 1.19, 1.20, 1.21, 1.22, 1.23, 1.24, 1.25, 1.26, 1.27, 1.35, 1.36, 1.37, 1.38, 1.39, 1.40, 
1.43, 1.47 komisyon tarafından hazırlanmıştır. 

 Görsel 1.8  
https://pixabay.com/tr/vectors/castle-kale-arazi-peyzaj-sahne-146417/ 
https://pixabay.com/tr/vectors/sar%C4%B1%C5%9F%C4%B1n-erkek-
karikat%C3%BCrkarakter1300066/https://pixabay.com/tr/vectors/karikat%C3%BCr-
komik-%C3%A7izgi-karakter-2027047/ 

 Görsel 1.28, 1.29, 1.30, 1.31, 1.32, 1.33  
https://pixabay.com/tr/vectors/otomobil-araba-citroen-fransa-1299695/ 

https://helpx.adobe.com/tr/support/after-effects.html
https://www.udemy.com/course/after-effects-cc-2018-sfrdan-ileri-seviyeye/learn/lecture
https://www.udemy.com/course/after-effects-cc-2018-sfrdan-ileri-seviyeye/learn/lecture
https://www.webdeogren.com/77-ders-adobe-after-effects-gorsel-egitim-seti/
https://www.universalclass.com/articles/computers/adobe/after-effects/adobe-after-effects-getting-started.htm
https://www.universalclass.com/articles/computers/adobe/after-effects/adobe-after-effects-getting-started.htm
http://anyflip.com/elwwt/ilzp/basic/101-150
https://www.creativebloq.com/after-effects/beginners-guide-11410328
https://www.educba.com/after-effects-timeline/
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 Görsel 1.41, 1.42, 1.44, 1.45  
https://pixabay.com/tr/vectors/logo-bant-tasar%C4%B1m-yiyip-plastik-2078018/ 
https://pixabay.com/tr/videos/limon-plaka-mutfak-g%C4%B1da-1720/ 

 Görsel 1.46, 1.47, 1.48, 1.49, 1.50, 1.51, 1.52 
https://pixabay.com/tr/vectors/da%C4%9F-deniz-beach-do%C4%9Fa- 
d%C3%BCztasar%C4%B1m-5428260/ 
https://pixabay.com/tr/illustrations/helikopter-pilot-erkekler-insanlar-1598077/ 

 Görsel 2.3, 2.4, 2.6, 2.8, 2.11, 2.12, 2.13, 2.16, 2.20, 2.24, 2.27 komisyon tarafından 
hazırlanmıştır. 

 Görsel 2.1, 2.2, 2.5, 2.7, 2.9 
https://pixabay.com/tr/vectors/trabant-araba-
ula%C5%9F%C4%B1mbeyazs%C3%BCr%C3%BCc%C3%BC-782799/ 

 Görsel 2.10 
https://pixabay.com/tr/vectors/otomobil-araba-red-frans%C4%B1z-eski-1300467/ 

 Görsel 2.14, 2.15, 2.17, 2.18, 2.19 
https://pixabay.com/tr/illustrations/mimari-%C5%9Fehir-ev-pencere-kolaj-882564/ 
https://pixabay.com/tr/vectors/otomobil-camper-araba-klasik-
%C3%A7i%C3%A7ek1299344/ 
https://pixabay.com/tr/vectors/g%C3%BCne%C5%9F-g%C3%BCne%C5%9Fli-
havasar%C4%B1-tahmin-159392/ 

 Görsel 2.21, 2.22, 2.23, 2.25, 2.26, 2.28 
https://pixabay.com/tr/vectors/da%C4%9F-deniz-beach-do%C4%9Fa-
d%C3%BCztasar%C4%B1m-5428260/ 
https://pixabay.com/tr/illustrations/helikopter-pilot-erkekler-insanlar-1598077/ 

 Görsel 3.1, 3.2, 3.3, 3.4, 3.5, 3.6, 3.9, 3.10, 3.11, 3.12, 3.13, 3.15, 3.16, 3.19, 3.20, 3.21, 
3.22, 3.23, 3.24, 3.25, 3.29 komisyon tarafından hazırlanmıştır. 

 Görsel 3.7, Görsel 3.8 
https://pixabay.com/tr/photos/amaryllis-
%C3%A7i%C3%A7ekk%C4%B1rm%C4%B1z%C4%B1-%C3%A7i%C3%A7ek-4701720/ 
https://pixabay.com/tr/illustrations/kar-taneleri-kar-
karya%C4%9F%C4%B1%C5%9F%C4%B1-k%C4%B1%C5%9F-554635/ 

 Görsel 3.17, Görsel 3.18 
https://pixabay.com/tr/photos/a%C4%9Fa%C3%A7-g%C3%B6l-yans%C4%B1ma-su-
sakin736881/ 

 Görsel 3.26, Görsel 3.27, Görsel 3.28 
https://pixabay.com/tr/photos/sigara-krater-krater-aktif-yanarda%C4%9F-3335597/ 
https://pixabay.com/tr/videos/k%C3%B6z-par%C4%B1lt%C4%B1-yang%C4%B1n-
%C4%B1s%C4%B1-kamp-ate%C5%9Fi-8625/ 

 Görsel 4.1, 4.2, 4.3, 4.4, 4.5, 4.6, 4.7, 4.8, 4.11, 4.12, 4.13, 4.15, 4.16, 4.19, 4.20, 4.21, 
4.22, 4.23, 4.24 ,4.25, 4.26, 4.28, 4.30, 4.31, 4.32, 4.33 komisyon tarafından 
hazırlanmıştır. 

 Görsel 4.9, Görsel 4.10 
https://pixabay.com/tr/videos/road-trip-seyahat-yolculuk-araba-739/ 

 Görsel 4.17, Görsel 4.18,Görsel 4.27 
https://pixabay.com/tr/photos/eylem-yeti%C5%9Fkin-paralimpik-oyunlar%C4%B1-
1867014/ 

 Görsel 4.29 Meryem Kaynar’ a aittir. 



 

 

257 

 

 Görsel 5.1, 5.2, 5.3, 5.4, 5.5, 5.6, 5.7, 5.8, 5.9, 5.10, 5.11, 5.12, 5.13, 5.14, 5.15, 5.16, 
5.17, 5.18, 5.19, 5.20, 5.21, 5.22, 5.23, 5.24, 5.28, 5.29, 5.30, 5.31, 5.32, 5.33, 5.34, 5.35 
komisyon tarafından hazırlanmıştır. 

 Görsel 5.25, 5.26, 5.27  
https://pixabay.com/tr/photos/harita-k%C3%BCre-co%C4%9Frafya-seyyah-retro-
5527326/ 

 Görsel 6.1, 6.2, 6.3, 6.5, 6.6, 6.7, 6.8, 6.9, 6.10, 6.11, 6.12, 6.13, 6.14, 6.15, 6.16, 6.17, 
6.18, 6.22, 6.23, 6.25, 6.27, 6.28, 6.29, 6.30, 6.31, 6.32, 6.33, 6.34, 6.35, 6.36, 6.37, 6.38, 
6.39, 6.40, 6.41, 6.42, 6.43, 6.44, 6.45, 6.46, 6.47, 6.48, 6.49, 6.50, 6.51, 6.52, 6.53, 6.54, 
6.55, 6.56, 6.57, 6.58 komisyon tarafından hazırlanmıştır. 

 Görsel 6.4  
https://pixabay.com/tr/illustrations/tekne-lake-g%C3%B6let-su-beach-4547083/ 

 Görsel 6.19, 6.20, 6.21, 6.24, 6.26  
https://pixabay.com/tr/illustrations/bebek-fil-fil-%C5%9Firin-mavi-%C3%A7ocuk-
3526681/ 

 Görsel 7.1, 7.2, 7.3, 7.4, 7.5, 7.6, 7.7, 7.8, 7.9, 7.10, 7.11, 7.12, 7.14, 7.17, 7.21, 7.26, 
7.27 Komisyon tarafından hazırlanmıştır. 

 Görsel 7.13, 7.15  
https://pixabay.com/tr/videos/kayak-da%C4%9Flar-snowboard-ski-area-50681/ 

 Görsel 7.16, 7.18, 7.19, 7.20  
https://pixabay.com/tr/vectors/camper-kamp-trailer-mobil-ev-149681/ 
https://pixabay.com/tr/vectors/otomobil-araba-citroen-fransa-1299695/ 
https://pixabay.com/tr/illustrations/banka-para-ekonomi-kurtarmak-hesap-2010880/ 

 Görsel 7.22, 7.23, 7.24, 7.25, 7.28 
https://pixabay.com/tr/videos/seyahat-yol-araba-peyzaj-bmw-terk-47901/ 

3.Öğrenme Birimi: Maskeleme Teknikleri  

 Görsel:1.1, 1.2, 1.3, 1.4, 1.5, 1.6, 1.7, 1.8, 1.9, 1.10, 1.11, 1.12, 1.13, 1.14, 1.15, 1.16, 1.7, 
1.8, 1.9, 1.10, 1.11, 1.12, 1.13, 1.14, 1.15, 1.16, 1.17, 1.18, 1.19, 1.20, 1.21, 1.22, 1.23, 
1.24, 1.25, 1.26, 1.27, 1.28, 1.29, 1.30, 2.1, 2.2, 2.3, 2.4, 2.5, 3.1, 3.2, 3.3, 3.4, 3.5, 3.6, 
3.7, komisyon tarafından hazırlanmıştır. 

 Görsel 2.1 
https://shutterstock.com (ID: 231734980) 

 Görsel 2.3 
https://shutterstock.com (ID: 769155154) 

 Görsel 1.25,1.26,1.28,1.29  

https://pngtree.com/freepng/beautiful-earth-elements_3704319.html 

 Görsel 3.2,3.3,3.4,3.5,3.7 

https://helpx.adobe.com/after-effects/how-to/rotoscoping.html 

4.Öğrenme Birimi: Görüntü Efektlerinin Oluşturulması 

 Görsel:1.1, 1.2, 1,6, 1.7, 1.17, 1,18, 1.21, 1.23, 2.1, 2.2, 2.3, 2.4, 2.5, 2.12, 2.17, 2.18, 
2.26, 2.27, 2.28, 2.29, 2.30, 2.31, 2.32, 2.33, 3.1, 3.2, 3.3, 3.11, 3.12, 3.13, 3.14, 3.15, 
3,15, 3.16, 3.17, 3.18, 3.19, 3.20, 3.21 komisyon tarafından hazırlanmıştır. 

 Görsel 1.3, 1.4, 1.5  
https://pixabay.com/tr/videos/beach-duvar-deniz-yaz-ispanya-16137/ 

 Görsel 1.10:  
https://pixabay.com/tr/videos/kelebek-kanat-%C3%A7%C4%B1rpmak-
d%C3%B6ng%C3%BC-renkli-6963/ 
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 Görsel 1.11  
https://pixabay.com/tr/photos/sonbahar-red-sezon-orman-do%C4%9Fa-1072821/ 

 Görsel 1.12, 1.13, 1.14:  
https://pixabay.com/tr/videos/geyik-wapiti-kad%C4%B1n-sis-yabani-56079/ (Erişim 
Tarihi: 10/12/2020) 

 Görsel 1.15, 1.16 : 
 https://pixabay.com/tr/videos/g%C3%BCne%C5%9F-sistemi-g%C3%BCne%C5%9F-
mercury-venus-56967/ (Erişim Tarihi: 10/12/2020) 

 Görsel 1.19, 1.20, 1.22 : 
 https://pixabay.com/tr/videos/cliff-deniz-ocean-dalgalar-sahil-57062/ (Erişim Tarihi: 
10/12/2020) 

 Görsel 1.24, 1.25:  
https://pixabay.com/tr/videos/da%C4%9Flar-do%C4%9Fa-peyzaj-bulutlar-su-48873/ 
(Erişim Tarihi: 10/12/2020) 

 Görsel 2.5, 2.7, 2.8 :  
https://www.photomural.com/into-the-jungle.html#/ (Erişim Tarihi: 10/12/2020) 

 Görsel 2.6:  
https://www.freeiconspng.com/images/ivy-png (Erişim Tarihi: 10/12/2020) 

 Görsel 2.10, 2.11, 2.13:  
https://pixabay.com/tr/photos/ser%C3%A7e-ku%C5%9F-k%C3%BCpe%C5%9Fte-
hayvan-k%C3%BC%C3%A7%C3%BCk-ku%C5%9F-5875379/ 
https://pixabay.com/tr/photos/ard%C4%B1%C3%A7-%C3%A7ilek-bitki-meyve-
a%C4%9Fa%C3%A7-bush-5831917/ 
https://pixabay.com/tr/photos/kar-a%C4%9Fa%C3%A7lar-orman-woodlands-
k%C4%B1ra%C4%9F%C4%B1-3158868/ 

 Görsel 3.4, 3.5, 3.6:  
https://pixabay.com/tr/photos/beach-sandy-beach-cennet-1824855/ 

 Görsel 3.7, 3.8, 3.9, 3.10 :  
https://pixabay.com/tr/photos/%C3%A7i%C3%A7ek-papatya-yapraklar%C4%B1-50157/ 

 Görsel 2.18, 2.19, 2.20, 2.21, 2.22, 2.23, 2.24, 2.25: 
https://www.europanel.com.tr/dekoratif-tugla-loft-brick-duvar-panelleri (Erişim Tarihi: 
10/12/2020) 

 

Kitap ve Öğrenme Birimleri Kapaklarında Kullanılan Görseller 

 https://shutterstock.com (ID: 1117458377) 

 https://shutterstock.com (ID: 1719972697) 

 Kapak İpek ÇAKMAK YILMAZ’dan alındı. 

 https://theplanetd.com/images/african-safari-animals-37.jpg (Erişim Tarihi: 01/12/2020) 

 

APA 6.0’a göre hazırlanmıştır. 

 

 

 


